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Hospira GemStar® Infusion System 
System Operating Manual

For use with the 
Hospira GemStar® Infusion System

List 13086-04
List 13087-04
List 13088-04

PLEASE
Read this entire manual before 

using the Hospira GemStar® Pump

This manual is designed for use by healthcare professionals, caregivers, and patients. 
The Hospira Technical Support Operations hotline is available 24 hours a day (in the 
USA) to provide consultation and technical assistance regarding the Hospira 
GemStar® Pump.

In the USA: Hospira Technical Support Operations
1-800-241-4002

Outside the USA: Contact your local Hospira
sales office

To order additional copies of this manual 
(List 13086,13087,13088) call Hospira Customer Care:

1-877-9HOSPIRA
(1-877-946-7747)
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Chapter 1

Introduction

The GemStar® Pump is a small and lightweight, single-channel infusion device 
designed for use in the home, in the hospital, or anywhere electronic infusion is 
required. The GemStar® Pump can be powered by AC mains adaptor, rechargeable 
battery pack, docking station, or two disposable AA alkaline batteries. When powered 
by batteries, the GemStar® Pump is ideal for ambulatory patients.

The following conventions are used throughout this manual:

CAUTION: A CAUTION contains information that could prevent 
irreversible product damage or hardware failure. Failure to 
observe a caution could result in serious patient or user injury.

Convention Use Example

[ALL CAPS] Pump keys Press [YES/ENTER] to continue.

ALL CAPS Display messages The pump displays: 
ENTER TO CONFIRM.

WARNING: A WARNING message contains special safety 
information and must be observed at all times. Failure 
to observe a warning message could be life 
threatening.

Note: A NOTE contains information or examples to help explain instructions.

Tip: A TIP contains information that makes the pump easier to use.

Note: Examples are provided only to help explain a pump function and may not 
be clinically relevant. Graphics are for illustrative purposes only and may not 
reflect the actual product.
Hospira GemStar® System Operating Manual 1
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GemStar® Pump Layout  

Shown approximate size
2 Hospira GemStar® System Operating Manual 
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1 DISPLAY • Displays the pump’s status.
2 • Silences an alarm.

• This silences an alert for five minutes and an alarm for two minutes.
3 • Stops infusion.

4 • Starts infusion.

5 • Lights continuously when the pump is powered by AC mains.
• Flashes when the pump is powered by external batteries (e.g., battery pack). Not 

lit when using disposable AA batteries.
6 • Powers the pump on or off. To power-off the pump, press and hold until the display 

clears.
7 • Returns to previous steps during programming.

• Exits Help, Change, and Options menus.
8 • Displays the following menu items from the STOP or RUN mode*:

New Container Change Program (or Titrate VTBI)
New Program Piggybacking

• Resets a numeric value to zero.
9 • Displays the following Options Menu items from the STOP or RUN mode*:

1 Review Program 4 Pump Settings 7 Speed Protocol
2 Histories 5 Set Clock 8 Next Dose
3 Keypad Lock 6 Print

• Scrolls through program review and help messages.
• Toggles between AM and PM in time-based entries.
• DOWN arrow toggles between units of measure when entering concentrations.

10 • Toggles between AM and PM in time-based entries.
• UP arrow enters a decimal point in numeric entries.
• Scrolls back by one screen in program review.

11 • Responds “YES” to display questions.
• Accepts entries and goes to the next step.

12 • Responds “NO” to display questions.

13 • Displays information during programming steps and alarm conditions.
• Displays Shift Totals, except during programming steps and alarm conditions.

14 • Clears an AIR-IN-LINE alarm.
• Primes a GemStar® Pump Set.

15 [0] - [9] • Selects menu items and enters numeric values. If two numbers appear before a 
menu item (e.g., 02), press both number keys to select that item.

* Not all menu items are available with all modes. 
Hospira GemStar® System Operating Manual 3
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GemStar® Pump Components

1 Bolus Button Press this button to start a 
bolus delivery if available in the 
current program.

2 Pole Clamp Track Use to connect to an optional 
pole clamp.

3 Cassette Release 
Button

Push down on this button to 
release the cassette.

4 Power Connector Use to connect the AC mains 
adaptor.

5 Data Port 
Connector

Use to connect the GemStar® 
serial cable.

6 Bolus Connector Use to connect a bolus cord.

7 Tubing Channel Place the pump set tubing in 
this channel.

8 Cassette Pocket Load the cassette into this 
pocket.

9 I.V. Tubing Guide Use to hold the I.V. tubing.

10 Battery Pack 
Connector

Use to connect the GemStar® 
Rechargeable Battery Pack.

11 Battery 
Compartment

Install two fresh, disposable 
AA batteries in this 
compartment.

Top View

Bottom/Side View
4 Hospira GemStar® System Operating Manual 
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Therapies
Seven types of therapy are available for infusion of medications and fluids. The 
following table lists possible applications and available features of each therapy.

Therapy Possible Applications

TPN Total Parenteral Nutrition 
fluid delivery • •

Pain 
Management

Infusion of analgesics or 
anesthetics for patient-
controlled pain 
management (PCA), 
epidural infusion and 
parenteral administration 
of general I.V. fluids

• •

Intermittent Interval-based therapies 
such as antibiotics •

Continuous Infusion of mg, mcg, or 
mL/hr with a selectable 
KVO (Keep Vein Open) 
option

• • •

Weight Dosed Critical care, pediatrics • • •
mL/hr Only Simple rate programming • • • •
Variable Time Chronotherapy • •
• = Available

Note: pain management is the only therapy available for List 13088.
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GemStar® Pump Features

Feature Description Reference Page

• Adjustable 
Settings

Adjusts the distal occlusion pressure limits, 
air sensor sensitivity, real-time clock, and 
audible alarm volume.

Chapter 10 Options 
Menu

• Alerts and 
Alarms

Signals audible and visual alarms when 
attention is required.

Chapter 1 Introduction, 
GemStar® Pump Layout

• Audible 
Keypad 
Response

Sounds a single beep when any key is 
pressed. If an invalid key is pressed, the 
pump sounds a flutter tone.

Chapter 1 Introduction, 
GemStar® Pump Layout

• Keypad Lock Restricts access to various options. Four 
lock levels are available. 

Chapter 10 Options 
Menu and Chapter 11 
Clinician Instructions

• New 
Container

Repeats the current program without 
reprogramming the pump.

Chapter 2 Basic 
Operation

• Piggybacking Allows delivery from a secondary container 
during a Continuous or mL/hr Only 
program.

Chapter 6 Continuous - 
Not Applicable to List 
13088 and Chapter 8 
mL/hr Only - Not 
Applicable to List 13088

• Power-on 
Self-test

Performs a self-test each time the pump is 
powered on. 

Chapter 2 Basic 
Operation

• Operation 
Test

Performs user-assisted tests to verify the 
pump is operating properly. 

Chapter 14 Operation 
Test

• Program 
History

Maintains a history event log, with a date 
and time stamp of each event for each 
program. Review the history on the display, 
or download it to a printer or computer.

Chapter 10 Options 
Menu

• Speed 
Protocols

Stores up to nine frequently used programs 
in the pump’s memory for quick access.

Chapter 10 Options 
Menu
6 Hospira GemStar® System Operating Manual 
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Menu System
The GemStar® Pump uses a menu system that provides step-by-step instructions 
through all of the pump’s functions. Refer to the following table for a list of functions 
in each menu. 

Use the keypad to select menu items, respond to display messages, and enter numeric 
values. For example, press [2] to select PAIN MANAGEMENT from the Programming 
Menu. 

Note: Menu items may vary depending on the pump’s configuration.

Tip: A menu item does not have to be on the display to be selected. For example, 
when the Programming Menu first displays, only the first four therapies are shown. 
Instead of pressing the down arrow to see the other menu items, press [7] to go 
directly to Variable Time Programming.
Hospira GemStar® System Operating Manual 7
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® 

To display 
this menu:

Do this: Menu Items Available

Programming 
Menu

Or 

Delivery Mode 
Menu (FOR LIST 
13088 ONLY)

1 Press  to 
display the Change 
menu.

2 Select NEW 
PROGRAM.

1 TPN
2 PAIN MANAGEMENT
3 INTERMITTENT
4 CONTINUOUS
5 WEIGHT DOSED
6 mL/HR ONLY
7 VARIABLE TIME 

1 CONTINUOUS
2 BOLUS
3 CONT + BOLUS

Note: If a program is not currently stored in 
pump memory at power-on, the Programming 
Menu automatically displays after the self-test.

Change Menu Press . 1 NEW CONTAINER
2 NEW PROGRAM
3 CHANGE PROGRAM
4 PIGGYBACKING

Note: If the current therapy is Weight Dosed or 
mL/hr Only and the pump is in RUN mode: 

3 TITRATE VTBI
will replace

3 CHANGE PROGRAM
on the menu display. 

Note: Piggybacking is available only in mL/hr 
Only and Continuous therapies.
Note: Menu items change depending on when 
Change Menu is viewed.

Options Menu Press . 1 REVIEW PROGRAM
2 HISTORIES
3 KEYPAD LOCK
4 PUMP SETTINGS
5 SET CLOCK
6 PRINT
7 SPEED PROTOCOL
8 NEXT DOSE (NOT AVAILABLE FOR LIST 13088)
8 Hospira GemStar System Operating Manual 
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Operating Modes
The GemStar® Pump has four operating modes:

For more information on: Refer to the following pages:
Programming Menu Chapter 2 Basic Operation, page 19.

Change Menu For menu item [1], refer to Starting a New Container  
in Chapter 2 Basic Operation, on page 32. For 
menu items [2], [3], and [4], refer to the appropriate 
therapy chapter.

Options Menu Chapter 10 Options Menu, page 107.

Mode Description

Help Mode The pump enters the HELP mode when  is pressed during 
programming or an alarm condition. The HELP mode displays 
additional information about the current condition.

Programming Mode The pump enters the PROGRAMMING mode after the pump is 
powered on or when  is pressed.

Run Mode After  is pressed, the pump enters the RUN mode, even 
when not infusing.

Stop Mode When programming is complete, the pump enters the STOP 
mode until  is pressed. 

When the programmed therapy is complete, and during certain 
alarm conditions, the pump automatically enters the STOP mode. 

Press  to enter the STOP mode at any time, except during a 
CHECK CASSETTE alarm.
Hospira GemStar® System Operating Manual 9
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Indications for Use
Physicians or certified, licensed healthcare professionals should always oversee 
infusions. Healthcare professionals should always supervise pump users and instruct 
users in pump operation and troubleshooting. Instruction should include how to 
prevent intravenous (I.V.) related complications, including how to prevent accidental 
infusion of air.

The pump is suitable for intravenous, arterial, subcutaneous, short-term epidural 
infusion and parenteral administration of general I.V. fluids, medications, nutritional 
fluids, and blood/blood products.

Intended parenteral administrations include but are not limited to: intravenous (within 
a vein), arterial, subcutaneous (tissue just below the skin), regional (located to specific 
areas of the body) and epidural analgesia, intrathecal analgesia, intraspinal analgesia, 
combined spinal-epidural analgesia, short term epidural infusion, intraspinal (within 
the spinal canal), intrathecal (within the subarachnoid or subdural space), 
intraoperative sites (soft tissue, body cavity or surgical wounds), intraarticular (within 
a joint), intraperitoneal (within the peritoneal cavity), and intracerebroventricular 
infusions. The indications for use include hospital, homecare and ambulatory 
environments. The system has also been qualified for use in fixed and rotary wing 
aircrafts (e.g., helicopters). The pump must be used with sterile, dedicated, GemStar® 
administration sets.

For epidural use, the administration of drugs is restricted to those anesthetic and 
analgesic drugs approved for continuous epidural administration: e.g., Chloroprocaine 
Hydrochloride USP, Lidocaine Hydrochloride USP, and Morphine Sulfate Injection 
USP (Preservative Free).

Note: Epidural administration of anesthetics is recommended in the continuous 
mode only. Epidural administration of analgesics may be delivered by continuous, 
bolus, or continuous with bolus.

WARNING: Delayed respiratory depression following continuous 
epidural administration of preservative-free morphine 
sulfate has been reported.
10 Hospira GemStar® System Operating Manual 
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For epidural administration, the following is recommended:

 Nylon or Teflon® catheter
 Pump sets without Y-sites
 Stickers for the tubing indicating ongoing administration

Contraindications for Use
Persons who do not have the mental and physical capability or the emotional stability 
to properly use the GemStar® Pump should not operate this pump.

DO NOT use the following with the GemStar® Pump: 
 Drugs not compatible with silicone rubber or PVC plastic
 Drugs not stable under infusion conditions

Warnings and Cautions
Pay attention to the following warnings and cautions when operating the GemStar® 

Pump. These warnings and cautions are repeated in the manual when relevant to the 
procedure being discussed. Pay attention to all alert messages.

General Warnings and Cautions
 Federal (USA) law restricts this device to sale by or on the order of a physician or 

other licensed practitioner.
 Manual references to specific values are approximate only, unless indicated 

otherwise. Air-in-line sensitivity values are approximate only.
 When a proximal occlusion alarm activates, DO NOT power-off the pump.
 Closely supervise patients who are likely to be adversely affected by unintended 

operations and failures, including interrupted medication or fluid infusion. Ensure 
provisions for immediate corrective action are available.

Note:  Facilities practicing epidural anesthesia/analgesia must be staffed and 
equipped to manage cardio-pulmonary resuscitation (CPR). Supplies should 
include oxygen, naloxone, and other appropriate resuscitative drugs and 
equipment. Monitor patients continuously (e.g., oximetry) during epidural 
administration. Frequently observe patient for side effects (for up to 24 hours) 
following completion of drug administration by the epidural route.
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Regarding Drugs Used, Pump Sets, and Containers

 USE ONLY GemStar® Pump Sets with the GemStar® Pump. Use of unauthorized 
sets may result in injury to the patient or damage to the pump.

 Some microbore tubing delivery accuracy may be affected when used at extreme 
operating temperatures (<10°C, >35°C), relative humidity (<20%) and delivery 
rates (<4.9 mL/hr, >350 mL/hr). Refer to individual set labels for specific 
instructions and operating conditions.

 Delivery accuracy may be impacted when there is air present in the cassette. 
Follow the instructions in the individual set labels to remove any visible air from 
the cassette.

 Ensure slide clamp or lower CAIR® (roller) clamp is open prior to inserting 
cassette.

 When using pre-filled vials, ensure vial and injector are securely locked in 
lockbox before beginning delivery.

 A cracked vial might not show evidence of leakage until delivery pressure is 
applied.

 When using nonvented syringes, the system may underdeliver. System delivery 
accuracy could be reduced by as much as 5%.

 When using PCA vials (except in a lockbox with a spring assist mechanism), the 
system may underdeliver. System delivery accuracy could be reduced by as much 
as 5%.

 When using viscous fluids, the system may underdeliver. System delivery 
accuracy could be reduced by as much as 5%.

 Variations in filling head (such as container height) may affect delivery accuracy 
by no more than 5%.

 When using the GemStar® Spring Assist Mechanism (SAM) Lockbox, USE 
ONLY GemStar® Pump Sets designated for use with the GemStar® SAM 
Lockbox. Failure to use designated sets could result in unrestricted flow.

 NEVER use drugs that are incompatible with silicone rubber or PVC plastic, 
(unless these items are specially treated and labeled to be compatible with such 
drugs).

 To reduce the loss of potency for drugs known to be absorbed by PVC plastic and 
silicone, begin infusion as soon as practical after priming the pump set. Use of 
high flow rates during infusion will minimize drug absorption.

 DO NOT use medications that are unstable under infusion conditions.
 ALWAYS use connections with Luer Lock™ fittings.
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 To prevent contamination, use aseptic technique with all fluid-path connections. 
Remove the protective coverings as assembly progresses.

 ALWAYS place the flow stop in the closed position when the set is not in the pump.
 Before installing the cassette in the pump, ensure all slide or lower CAIR® (roller) 

clamps are open. Failure to open the slide or lower CAIR® (roller) clamps 
BEFORE installing the cassette may result in restricted flow.

 DO NOT back-prime the pump set using a syringe. Back priming may result in 
restricted flow.

 Ensure the cassette is properly installed. When properly installed, all four cassette 
latches are visibly holding the cassette securely in the cassette pocket.

 Ensure the tubing is behind the tubing guide (at the distal end).
 Arrange tubing, cords, and cables to minimize the risk of patient strangulation or 

entanglement.
 NEVER use vented fluid containers (e.g., glass or rigid plastic) unless suspended 

from a pole. When using a vented drip set, ALWAYS use an air-eliminating filter 
OR set the air sensitivity to either ON or 2 mL.

 Stop infusion if signs or symptoms of infiltration occur.
 GemStar® Pump Sets contain a pressure-activated anti-siphon valve to reduce the 

potential for gravity flow at a typical 36-inch head height.
 Failure to use the pressure-activated anti-siphon valve may result in unrestricted 

flow if the cassette is not properly installed in the pump.
 Always close the slide clamps before removing the cassette from the pump.
 When using the pump for secondary delivery (piggybacking), ensure the fluids 

being infused are chemically and physically compatible.
 When infusing short-half-life drugs (i.e. those dosed with units of mcg/kg/min) at 

very low rates (0.8 mL/hr or less) the rate may be too slow for that drug. Consider 
using a lower drug concentration with these drugs so a pump rate above 0.8 mL/hr 
can be used.

Regarding Air-In-Line and Infusion
 To reduce the risk of infusing air, use an air-eliminating filter when the air 

sensitivity is set to OFF.
 ALWAYS prime the pump set to remove all air from the cassette, tubing, and 

injection site prior to connecting to the patient. 
 ALWAYS disconnect the pump set from the patient prior to priming or purging.
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Regarding Pump Operation
 If the pump does not perform as stated in this manual, remove the pump from 

service IMMEDIATELY.
 If the pump does not display the self-test or if beeps do not sound at power-on, 

check all power connections and install two fresh, disposable AA batteries. If the 
problem continues, contact Hospira Technical Support Operations before using 
the pump.

 Ensure a cassette is installed in the pump before connecting to a printer or 
computer. If the pump is connected to a patient: BEFORE connecting the pump 
to a computer or printer, press [STOP], close the slide clamp, and eject the 
cassette. Leave the pump set connected to the patient. Install another cassette in 
the pump before connecting to a printer or computer.

 Disconnect the pump from the patient BEFORE performing the Operation Test.
 ALWAYS connect to a grounded AC mains power source when using AC mains 

power. If the quality of the grounding source is in doubt, operate the pump only 
with batteries.

 USE ONLY the AC mains adaptors specifically labeled for use with the 
GemStar® Pump.

 USE ONLY the AC mains adaptor specifically labeled for use with the GemStar® 

Pump to charge the battery pack.
 The GemStar® AC mains adaptor is for use with the GemStar® Pump or 

GemStar® Rechargeable Battery Pack only. DO NOT use the GemStar® AC 
mains adaptor with other products.

 During charging, the battery pack is warm. If the rechargeable battery pack 
becomes hot to the touch, IMMEDIATELY unplug the AC mains adaptor and 
contact Hospira Technical Support Operations.

 Use only the Li-Ion Docking Station and Li-Ion Battery Pack with the GemStar® 

Pump.
 With the Li-Ion Battery Pack, the LED indicator flashes yellow/green when an 

error condition has occurred or when the temperature is too high to charge the 
battery pack. In temperatures above 95°F (35°C), cycle AC power to confirm if 
battery is charged or if error condition exists. If LED flashes green/yellow, do not 
rely on external battery. Move device to cooler temperature and recharge prior to 
use. Refer to the battery pack insert for important information and precautions 
regarding activating and charging the Li-Ion Battery Pack.

 When removing the cord (from the docking station, bottom of the battery pack, or 
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bottom of the pump), firmly grasp the connector and pull straight out. DO NOT 
twist or bend the cord or connector. 

 To ensure proper pump operation, ALWAYS replace BOTH disposable batteries 
with fresh, disposable AA batteries when a change is required.

 ALWAYS fully close the battery door when using disposable batteries.
 DO NOT use rechargeable batteries in the battery compartment.
 Ensure two fresh, disposable AA batteries are installed for backup power when 

using other external power sources (e.g., AC mains adaptor, docking station, 
battery pack). The pump will continue to operate on backup power if the external 
power source fails. In the event that the internal batteries are removed while the 
pump is operating, the power loss event may not be logged in the history, the 
programmed therapy may not be retained, and the alarms (audible and visual) may 
not occur.

 ALWAYS avoid sources of high-intensity electromagnetic radiation (e.g., radio 
transmitters, MRI scanners, microwave ovens, X-ray machines, and CAT 
scanners).

 Use of radio-frequency emitting devices, such as cellular telephones, 2-way 
radios, and Electrical Surgical Devices (ESU), in close proximity to this device 
may affect its operation.

 Possible explosion hazard exists if the pump is used in the presence of flammable 
anesthetics. NEVER use the pump in the presence of flammable or explosive 
vapors.

 Non-hazardous, low-level electrical potentials are commonly observed when 
fluids are administered using infusion devices. These potentials are well within 
accepted safety standards, but may create artifacts on voltage-sensing equipment, 
such as ECG, EMG, and EEG machines. These artifacts vary at a rate that is 
associated with the infusion rate. If the monitoring machine is not operating 
correctly or has loose or defective connections to its sensing electrodes, these 
artifacts may be accentuated so as to simulate actual physiological signals. To 
determine if the abnormality in the monitoring equipment is caused by the 
infusion device instead of some other source in the environment, set the infusion 
device so that it is temporarily not delivering fluid (if clinically acceptable). 
Disappearance of the abnormality indicates that it was probably caused by 
electronic noise generated by the infusion device. Proper setup and maintenance 
of the monitoring equipment should eliminate the artifact. Refer to the appropriate 
monitoring system documentation for setup and maintenance instructions.

 The GemStar® Pump has been tested and found to comply with EMC/EMI limits 
in accordance with:
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 IEC/EN 60601-1-2 (2001) when using two AA disposable batteries or when 
connected to the GemStar® AC Adaptor

 IEC/EN 60601-1-2 (2001) (ESD exemption) when using Li-Ion Docking 
Station or Li-Ion Battery Pack

When connected to other power sources or optional system components in 
commercial distribution before November 30, 2004, the GemStar® Pump 
complies with EMC/EMI limits in accordance with IEC/EN 60601-1-2 (1993). 
These limits are designed to provide reasonable protection against harmful 
interference in a typical medical installation. The equipment generates, uses and 
can radiate radio frequency energy and, if not installed and used in accordance 
with the instructions, may cause harmful interference to other devices in the 
vicinity. However, there is no guarantee that interference will not occur in a 
particular installation. If this equipment does cause harmful interference with 
other devices, which can be determined by turning the equipment off and on, the 
user is encouraged to try to correct the interference by one or more of the 
following measures:
 Reorient or relocate the receiving device
 Increase the separation between the equipment
 Connect the equipment to an outlet on a circuit different from that to which 

the other device is connected
 Consult the manufacturer or field service technician for help
 The use of portable and mobile RF equipment may have an impact on this and 

other pieces of medical equipment
 Prior to using the GemStar® Pump and optional system components, refer to 

Appendix A for additional information and precautionary procedures regarding 
electrical potentials (electromagnetic compatibility and electrostatic discharge).

Regarding Handling and Maintenance
 Use proper care during unpacking, installation, and operation of the pump. If the 

pump is inadvertently mishandled, check connections and programmed data to 
ensure there is no damage. Refer to Chapter 14 Operation Test for further 
information.

 Accessory equipment connected to the analog and digital interfaces must be 
certified according to the respective IEC standards, (e.g., IEC 60950 for data 
processing equipment, and ICE 60601-1 for medical equipment). Furthermore, all 
configurations shall comply with the system standard IEC 60601-1-1. Any person 
who connects additional equipment to the signal input or output part configures a 
medical system, and is therefore responsible for ensuring that the system complies 
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with the requirements of IEC 60601-1-1. If in doubt, contact Hospira Technical 
Support Operations.

 ALWAYS avoid dropping or hitting the pump. If the pump is dropped or hit, 
ALWAYS check connections and programmed data.

 NEVER use sharp objects (e.g., fingernails, pens, pencils, or other probes) to 
program or clean the pump.

 Use care not to damage the silicone seals around the sensor bodies in the cassette 
pocket.

 To avoid mechanical or electronic damage, NEVER submerge pump in water or 
other fluids and avoid fluid spills. If the pump becomes wet, dry it immediately 
with a dry, lint-free cloth. Check connections and programmed data.

 DO NOT touch connector ports. Connector ports may be susceptible to 
Electrostatic Discharge (ESD) damage.

 Some cleaning and sanitizing compounds may slowly degrade components made 
from some plastic materials. DO NOT use compounds containing combinations of 
isopropyl alcohol and dimethyl benzyl ammonium chloride (i.e., alcohol wipes).

 DO NOT sterilize by heat, steam, ethylene oxide (ETO), or radiation. Apply 
disinfectants to the outside surface of the pump only. DO NOT use abrasive 
cleaners or materials on the pump. Using abrasive cleaners or cleaning solutions 
not recommended by Hospira may result in product damage. 

 Please comply with local disposal and recycling regulations as appropriate for 
disposable batteries, rechargeable battery packs, medical electronic components, 
and pump sets.

Fixed and Rotary Wing Aircraft
 Do not lay the IV bag flat because air can potentially be introduced into the line 

causing an alarm condition. Recommend the use of extension set tubing be 
applied prior to patient transport.

 The GemStar® pump has only been tested using battery power in fixed and rotary 
wing aircraft.

 Auditory alarms may not be heard in a noisy flight environment. Care providers 
should rely on visual indicators on the pump display to determine if there are any 
alarms or other system malfunctions.
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Chapter 2

Basic Operation

The following elements are required to use the GemStar® Pump:

6 GemStar® Pump
6 Appropriate power source

6 Appropriate GemStar® Pump Set
6 Appropriate fluid container
6 Patient-access device

Overview
To start a therapy:
1 Determine the program settings. Refer to the appropriate therapy chapter for a 

worksheet that may be copied and used to record program settings.
2 Select a power source. Refer to Selecting a Power Source on page 20.
3 Prime the pump set. Refer to GemStar® Pump Set on page 32.
4 Load the cassette into the pump. Refer to Loading the Cassette on page 35.
5 Power-on the pump and go to the Programming Menu. Refer to Powering On 

the Pump on page 27.
6 Select the appropriate optional system components, such as a bolus cord.
7 Select the therapy type and enter a program. Refer to the appropriate therapy 

chapter for detailed instructions.

8 Press [START] to begin delivery.

Note: List 13088 only delivers therapy in the Pain management Mode.
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Selecting a Power Source
The GemStar® Pump may be powered by one or more of the following: 

CAUTION: To ensure proper pump operation, ALWAYS replace BOTH 
batteries with fresh, disposable AA batteries when a change is 
required. 
DO NOT use rechargeable batteries in the battery compartment. 
Ensure two fresh, disposable AA batteries are installed for backup 
power when using other power sources (e.g., AC mains adaptor, 
docking station, battery pack). The pump will continue to operate 
on backup power if the external power source fails. Refer to the 
caution regarding Power Loss on page 14.

Power Source Description Ambulatory Hospital Home

GemStar® 
AC Mains Adaptor 
(USA)

Wall-mount adaptor plugs into a 
110 VAC mains supply. • •

GemStar® 
AC Mains Adaptor 
(Universal)

Wall-mount adaptor plugs into a 
100-240 VAC mains supply. • •

GemStar® 
AC Mains Adaptor 
(Universal)

Tabletop adaptor plugs into a 
100–240 VAC mains supply. • •

GemStar® Docking 
Station

Plugs into a 100–240 VAC Volt 
mains supply while mounted on an 
I.V. pole. The docking station’s 
rechargeable internal batteries 
power the GemStar® Pump during 
periods of transport.

• • •

GemStar® Battery 
Pack

The battery pack’s rechargeable 
internal batteries power the 
GemStar® Pump during periods of 
transport or when use of AC power 
is not desirable. 

• • •

Disposable Batteries Two disposable AA alkaline 
batteries (available from local 
sources)

• • •
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Installing Disposable Batteries
1 Flip open the tab of the battery door on 

the bottom of the pump.

2 With the pump keypad facing up, hold 
onto the tab and turn the battery door to 
the left (counterclockwise) until it is 
released from the battery compartment. 

3 Pull the door free and remove any 
existing batteries. 

4 Install two fresh, disposable AA 
batteries into the battery compartment. 
Ensure the batteries are inserted as 
shown.

5 Return the battery door to the battery 
compartment.

6 Turn the battery door to the right 
(clockwise). Ensure the battery door is 
secured under the slot. 

7 Flip closed the tab of the battery door to 
lock in place.

Note: Turn off the pump before 
removing or installing batteries.
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Connecting the GemStar® AC Mains Adaptor
1 Connect the cord of the AC mains adaptor to the connector port labeled “3 VDC” 

on the bottom of the pump.
2 Plug the AC mains adaptor into a standard wall outlet.

CAUTION: ALWAYS connect to a grounded AC mains power source when 
using the AC mains adaptor. USE ONLY AC mains adaptors 
specifically labeled for use with the GemStar® Pump.
When removing the cord from the bottom of the pump, firmly 
grasp the connector and pull straight out. DO NOT twist or bend 
the cord or connector.
Ensure two fresh, disposable AA batteries are installed for backup 
power when using other power sources (e.g., AC mains adaptor, 
docking station, battery pack). The pump will continue to operate 
on backup power if the external power source fails. Refer to the 
caution regarding Power Loss on page 14.

Note: The green LED  on the pump remains lit when connected to AC mains 
power.
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Using the GemStar® Rechargeable Battery Pack

Use the GemStar® AC Mains Adaptor (List 13026-01 [USA], 13026-03 [Universal] or 13072-01 

[Universal]) to recharge the GemStar® Battery Pack (List 13073-03).

CAUTION: ALWAYS connect to a grounded AC mains outlet when using AC 
mains adaptor.
Use only AC mains adaptors specifically labeled for use with the 
GemStar® Pump to charge the battery pack.
During charging, the battery pack is warm. If the battery pack 
becomes hot to the touch, IMMEDIATELY unplug AC mains 
power and contact Hospira Technical Support Operations
Ensure two fresh, disposable AA batteries are installed for backup 
power when using other power sources (e.g., AC mains adaptor, 
docking station, battery pack). The pump will continue to operate 
on backup power if the external power source fails. Refer to the 
caution regarding Power Loss on page 14
When removing the cord from the bottom of the battery pack, 
firmly grasp the connector and pull straight out. DO NOT twist or 
bend the cord or connector.
Regarding the GemStar® Li-Ion Battery Pack:
• The LED indicator on the GemStar® Li-Ion Battery Pack flashes 

green/yellow when an error condition has occurred or when the 
temperature is too high to charge the battery pack. In 
temperatures above 95°F (35°C), cycle AC power to confirm if 
battery is charged or if error condition exists. If LED flashes 
green/yellow, do not rely on external battery. Move device to 
cooler temperature and recharge prior to use.

• Refer to the GemStar® Li-Ion Battery Pack insert for important 
information and precautions regarding activating and charging 
the Li-Ion Battery Pack.

WARNING: DO NOT touch connector ports. Refer to caution on 
page 16.

Note: A charged battery pack will last approximately 24 hours when the pump 
is infusing at rates less than 125 mL/hr.
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To connect the battery pack:
1 Line up the connectors on the top of the battery 

pack with the holes on the bottom of the pump. 
2 Snap the battery pack into place.

To release the battery pack:
1 Press the release button on the battery pack.
2 Pull the battery pack straight out from the pump.

To charge the battery pack:
1 Plug the pin connector of the AC mains adaptor into the port on the bottom of the 

battery pack.
2 Plug the AC mains adaptor into a standard wall outlet.
3 Leave the battery pack connected to the AC mains adaptor for at least 12 hours to 

charge the battery pack.

Note: When the pump is connected to the battery 
pack, the pump’s green LED flashes and the battery 
pack light is off. 

When the pump is connected to the battery pack at 
power-on, the pump displays USING EXT BATT.

Note: The Li-Ion battery pack (List 13073-03) light is yellow while the battery pack is 
charging and green when the battery pack is charged or not charging.

Li-Ion batteries cannot be charged when the room temperature is greater than 95°F 
(35°C) or less than 41°F (5°C). 

1
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CAUTION: When removing the cord from the battery pack, firmly grasp the 
connector and pull straight out. DO NOT twist or bend the cord or 
connector.

Using the GemStar® Docking Station

CAUTION: Ensure two fresh, disposable AA batteries are installed for backup 
power when using other power sources (e.g., AC mains adaptor, 
docking station, battery pack). The pump will continue to operate 
on backup power if the external power source fails. Refer to the 
caution regarding Power Loss on page 14.

To connect to the Pump
1 Mount the docking station to the I.V. pole and tighten 

the knob.
2 Line up the connectors on the bottom of the pump with 

the connectors on the docking station. 
3 Slide the pump into the docking station until it snaps 

into place.
4 Connect the docking station to AC mains power.

WARNING: DO NOT touch connector ports. Refer to caution on 
page 14.
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To remove the pump:
1 Press the release button on the top of the docking 

station.
2 Slide the pump out.

To charge docking station (List 13075 all codes):
1 Connect the docking station to the AC mains power.
2 Leave the Li-Ion Docking Station connected to AC 

mains power for at least 6 hours when not in use or to recharge the docking 
station.

Note:  The Li-Ion docking station (List 13075-03) light is yellow while the docking 
station is charging. When the docking station is charged or not charging, the light is 
green.
The Li-Ion docking station cannot be charged when the room temperature is greater 
than 104°F (40°C) or less than 41°F (5°C).
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Powering On the Pump
CAUTION: If the pump does not display the self-test or if beeps do not sound at 

power-on, check all power connections and install two fresh, 
disposable AA batteries. If the problem continues, contact Hospira 
Technical Support Operations before using the pump.

1 Press [ON/OFF] to power-on the pump. The pump 
completes a self-test and displays the time and date. No 
response is required.

2 The pump checks for available power sources. Respond to the display message as 
shown in the following table:.

Note: If a cassette is not properly loaded, the pump will sound an alarm after the 
power-on test is complete. 

Note: The self-test takes approximately 30 seconds to complete. If the pump is 
locked, lock symbols appear at the beginning and end of the second line:
UNIT SELF-TEST .

Display Message Power Source(s) User Response

No message displays AC power and 
disposable batteries.

No response required, the pump goes 
to the next step.

LOW BATTERIES

ENTER TO CONFIRM

AC power and weak 
(low voltage) 
disposable batteries; 
or weak disposable 
batteries only.

Press  to confirm.

Power-off the pump and install two 
fresh, disposable AA batteries as a 
backup power source.

NO INTERNAL BATT
NO POWER LOSS
ALARM AVAILABLE
ENTER TO CONFIRM

No disposable 
batteries or dead 
disposable batteries; 
and external power.

Press  to confirm.

Power-off the pump and install two 
fresh, disposable AA batteries as a 
backup power source.

GEMSTAR 7
UNIT SELF-TEST
TIME IS 10:00 AM
FRI, NOV 10, 06
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CAUTION: Ensure two fresh, disposable AA batteries are installed for backup 
power when using other power sources (e.g., AC mains adaptor, 
docking station, battery pack). The pump will continue to operate 
on backup power if the external power source fails. Refer to the 
caution regarding Power Loss on page 14.

USING BATTERIES

ENTER TO CONFIRM

Disposable batteries 
only.

Press  to confirm.

If an external power source is in use, 
ensure the connections are secure.

USING EXT BATT

ENTER TO CONFIRM

External batteries 
(docking station 
battery or battery 
pack) and disposable 
batteries.

Press  to confirm.

If an AC mains adaptor is in use, 
ensure the connections are secure.

Note: To power-off the pump, press and hold  until the display clears. The pump 
cannot be powered off during a CHECK CASSETTE alarm (except during 
PROGRAMMING mode). Refer to Chapter 12 Troubleshooting for information on 
clearing a CHECK CASSETTE alarm.

For more information on: Refer to the following pages:

Setting the clock Set Clock  in Chapter 10 Options Menu, on page 118.

Locking the keypad Keypad Lock  in Chapter 10 Options Menu, on 
page 114.

Display Message Power Source(s) User Response
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Accessing the Programming Menu
After power-on, the pump checks its memory for a stored program. Respond to the 
display message as shown in the following table:

Display Message Condition User Response

The pump displays the 
Programming Menu.

Pump memory 
is clear.

> To enter a new program: Select a therapy 
from the Programming Menu and enter a 
new program. Refer to the appropriate 
therapy chapter for instructions.

1 RESUME PROGRAM
2 CLR PROG&SHIFT
3 CLR PROG,SHIFT 

AND HISTORY

A program is 
currently stored 
in pump 
memory.

> To continue the current program, press [1].

> To reset the current program:

1 Press [1].
2 Press [CHANGE] to display the Change 

Menu and select NEW CONTAINER.

> To enter a new program and clear shift 
totals: Press [2]. The pump clears the 
program and shift totals from memory and 
enters PROGRAMMING mode.

> To enter a new program, clear shift totals, 
and clear history: Press [3]. The pump 
clears the program, shift totals, and history 
from memory and enters PROGRAMMING 
mode.

Tip: To enter a new program when the pump is already powered on:

1 Press [STOP] to place the pump in STOP mode.
2 Press [CHANGE] to display the Change Menu.
3 Select NEW PROGRAM. The pump clears the current program and 

displays the Programming Menu.
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Programming the Pump

Programming Overview
The pump’s menu system provides step-by-step guidance through all of the 
programming steps. Refer to the appropriate therapy chapter for detailed 
programming instructions.
Programming worksheets are available at the end of each therapy chapter. Each 
worksheet lists the minimum and maximum value (program range) allowed for that 
therapy. If a number outside of the program range is entered, the pump displays the 
minimum or maximum value allowed.

1 Select the desired therapy from the Programming Menu.
2 Respond to display messages and enter requested values.

3 Review the program, if required. Press  to begin review. Press [YES/ENTER] 
when done.

4 SAVING PROGRAM displays. The pump stores the program in memory and then 
enters STOP mode.

Note: For Continuous, Intermittent, and Variable time therapies, the pump only 
delivers in increments of 0.1 mL. These therapies are rounded to the nearest 0.1 
mL. For example, at a concentration of 15 mg/mL, a rate of 5 mg rounds to 4.5 mg.

5 mg = 0.333 mL
4.5 mg = 0.3 mL 

When a value is rounded, the pump sounds four quick beeps, displays ROUNDING 
for a few seconds, and then displays the rounded value. Press [YES/ENTER] to 
accept the rounded value and continue to the next step.
Rounding only occurs in Variable, Continuous and Intermittent therapies.

Note: Program entries can be changed any time before the Program Review is 
complete. Press [BACK-UP] to return to previous program displays and make 
changes as desired.

Tip: If you enter an incorrect number during programming, press [CHANGE] 
BEFORE pressing [YES/ENTER] to reset the number to zero. Then enter the 
correct number.
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Programming Tips
The following table explains how to use the keypad during programming:

Key Function

[0] - [9] Press the number keys to select menu items and to enter numeric values.

Note: Some menu items require pressing two number keys to select that item.
For example, when selecting a unit of measure for a weight dosed program, the 
menu may display as:

01 mcg/kg/mg
02 mcg/kg/hr
03 mcg/kg/min
04 mg/kg/min

To select mg/kg/min, press [0][4].

Press  to accept entries or to continue when done viewing a display.

Press  during programming and alarm conditions to display information 

about the current condition.

The DOWN arrow toggles between units of measure when entering 
concentrations. Scrolls through program review and help messages. 

The UP arrow inserts a decimal point in a numeric value.

When entering a numeric value during programming, press  to reset the 
value to zero.

Press  to return to a previous display, to exit the Options Menu, or to exit 

the HELP mode. 
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Starting a New Container 

To repeat the current program with a new container:
1 From the STOP mode, press [CHANGE] to display the Change Menu.
2 Select NEW CONTAINER from the Change Menu. The pump displays NEW 

CONTAINER for several seconds and clears the amount infused from memory.

Note: In Weight Dosed, mL, and Pain Management therapies, the VTBI can be 
titrated without adding volume to initial container amount.

3 If Program Review is desired, press [OPTIONS] then press [1] to begin review.
4 Press [START] to begin delivery.

GemStar® Pump Set
The GemStar® Pump Set is a sterile, single-use, disposable pump set. It is designed 
for one-time use only and should be properly discarded after use.
Fluid path and areas beneath undisturbed protective set 
covers are sterile and nonpyrogenic in the intact unit 
package.
Contact a Hospira representative for more information on selecting the appropriate 
pump set configuration. Additional disposable components, such as air-eliminating 
filters and extension sets, may be added to the line as required. To use a GemStar® 
Pump Set, follow the instructions included with the set.

Note: The NEW CONTAINER function is not available when the pump is in FULL Lock. 
Refer to Chapter 10 Keypad Lock, page 114 for more information.

Note: GemStar® Pump Sets contain a pressure-activated anti-siphon valve to reduce 
the potential for gravity flow at a typical 36-inch head height.
Ensure slide clamp or lower CAIR® clamp is open prior to inserting cassette.
False occlusion alarms and fluid delivery inconsistencies may occur when pumping 
viscous fluids in microbore tubing at rates greater than 500 mL/hr. 
The system may underdeliver, and the system delivery accuracy may be reduced by as 
much as 5% when using the following:
• viscous fluids
• nonvented syringes
• PCA vials (except in a lockbox with a spring assist mechanism)

S T E R I L E 2
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A typical GemStar® Pump Set is shown below:

1 Piercing Pin 6 Tubing

2 Proximal End 7 Slide Clamp

3 Cassette 8 Secure Lock

4 Flow Stop (open  / close ) 9 Pressure-activated Anti-Siphon valve

5 Distal End
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CAUTION: USE ONLY GemStar® Pump Sets with the GemStar® Pump. Use of 
unauthorized sets may result in injury to the patient or damage to 
the pump.
To prevent contamination, use aseptic technique with all fluid-path 
connections. Remove protective coverings as assembly progresses.

Opening the Pump Set
1 Open the GemStar® Pump Set package and 

remove the contents.
2 Remove the protective covers from the fluid 

container administration port and the pump set.

WARNING: ALWAYS prime the pump set to remove air from the 
cassette, tubing, and injection sites prior to connecting to 
the patient. ALWAYS disconnect the pump set from the 
patient prior to priming or purging. Arrange tubing, cords, 
and cables to minimize the risk of patient strangulation or 
entanglement.

Failure to use the pressure-activated anti-siphon valve 
may result in unrestricted flow if the cassette is not 
properly installed in the pump.
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Loading the Cassette
1 Identify the four black cassette latches inside the cassette pocket.

2 Ensure slide clamp or lower 
CAIR® clamp is open prior to 
inserting cassette.

3 Line up the cassette as shown 
(with the flow stop button facing 
the pump).

4 Insert the cassette into the cassette 
pocket by pushing firmly along the 
entire cassette until it is firmly 
seated.
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5 Verify that all four cassette latches 
are securely holding the cassette. 

CAUTION: Ensure the cassette 
is properly installed. When 
properly installed, all four 
cassette latches are visibly 
holding the cassette securely in 
the cassette pocket.

6 Place the tubing in the 
tubing channel.

Releasing the Cassette
1 Close the CAIR® (roller) clamp or 

slide clamp on the distal line.

2 Push down on the cassette release 
(large black button) on the top of 
the pump.

3 Remove the cassette.

Note: Ensure the tubing is behind 
the tubing guide (at the distal 
end).

d
Note: The pump cannot be 
powered off during a CHECK 
CASSETTE alarm (except during 
PROGRAMMING mode). Refer to 
Chapter 12 Troubleshooting for 
information on clearing a CHECK 
CASSETTE alarm.

d
Note: When the cassette is 
released from the pump, the 
cassette flow stop automatically 
closes, preventing free flow.
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Priming a GemStar® Pump Set
Priming Pump Sets WITHOUT a Drip Chamber

1 Push down on the flow stop  to 
close the cassette.

2 Hold the container with the 
administration port toward the 
ceiling and insert the piercing pin.

3 Push down on the flow stop  to 
open (priming position) the 
cassette.

4 Invert the cassette approximately 
45°.

5 While holding the rotated cassette, 
squeeze or roll the container to 
remove air from the container and 
cassette.

6 Return the cassette to the upright 
position. Continue priming until 
fluid fills the tubing.

WARNING: Failure to use the pressure-activated anti-siphon valve 
may result in unrestricted flow if the cassette is not 
properly installed in the pump.
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7 Push down on the flow stop  to 
close the cassette.

8 Ensure slide clamp is open prior to 
inserting cassette.

9 Load the cassette.

CAUTION: Ensure all four 
cassette latches are clearly 
visible after the cassette is 
installed. Refer to Loading the 
Cassette on page 35.

CAUTION: When priming is 
complete, ensure no fluid flows 
at the distal end of the pump set. 
If flow is observed, DO NOT use 
the pump set.

10 Connect the pump set to the 
patient-access device.
Priming using [PURGE] is only 
allowed before [START] is pressed 
or after one of the following 
events occur when using Pain 
Management therapy:
6 Complete Review of New 

Program
6 New Container
6 Air-in-Line Alarm

d
Note: Ensure the tubing is behind 
the tubing guide (at the distal 
end).
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Priming Pump Sets WITHOUT a Drip Chamber Using the PURGE Key

1 Push down on the flow stop  to 
close the cassette.

2 Hold the container with the 
administration port toward the 
ceiling and insert the piercing pin.

3 Ensure slide clamp is open prior to 
inserting cassette.

4 Load the cassette.

CAUTION: Ensure all four 
cassette latches are clearly 
visible after the cassette is 
installed. Refer to Loading the 
Cassette on page 35.

WARNING: Failure to use the pressure-activated anti-siphon valve 
may result in unrestricted flow if the cassette is not 
properly installed in the pump.

Note: The PURGE function is available only if there is a program in the pump.
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5 Program desired therapy.
6 Press [PURGE].

7 The pump displays PRIME THE 
SET? Press [YES/ENTER].

8 While holding the container with 
the administration port toward the 
ceiling, press and hold [PURGE].

Continue using the [PURGE]
key until fluid fills the tubing. 
Ensure all air is removed
from the container, cassette, 
and tubing.

CAUTION: When priming is 
complete, ensure no fluid
flows at the distal end of the
pump set. If flow is observed, 
DO NOT use the pump set.

9 Connect the pump set to the
patient-access device.

d
Note: Ensure the tubing is behind 
the tubing guide (at the distal 
end).

d
Note: Purge rate is 250 mL/hr. 
The pump purges for up to 2 
minutes each time you press and 
hold [PURGE].
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Priming Pump Sets WITH a Drip Chamber

1 Push down on the flow stop  to 
close the cassette.

2 Insert the piercing pin into the 
container. Suspend the container 
on an I.V. Pole. 

3 Squeeze the drip chamber until 
filled halfway.

4 Push down on the flow stop  to 
open (priming position) the 
cassette.

5 Ensure the CAIR® (roller) clamp 
is open prior to inserting cassette.

6 Invert the cassette approximately 
45°.

WARNING: Failure to use the pressure-activated anti-siphon valve 
may result in unrestricted flow if the cassette is not 
properly installed in the pump.

When using a vented chamber, ALWAYS use an 
air-eliminating filter OR set the air sensitivity to 
either ON or 2 mL.
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7 While holding the rotated cassette, 
remove air from the container and 
cassette.

8 Return the cassette to the upright 
position. Continue priming until 
fluid fills the tubing.

9 Push down on the flow stop  to 
close the cassette.

10 Ensure lower CAIR® clamp is 
open prior to inserting cassette.

11 Load the cassette.

CAUTION: Ensure all four 
cassette latches are clearly 
visible after the cassette is 
installed. Refer to Loading the 
Cassette on page 35.
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CAUTION: When priming is 
complete, ensure no fluid flows 
at the distal end of the pump set. 
If flow is observed, DO NOT use 
the pump set.

12 Connect the pump set to the 
patient-access device.

d
Note: Ensure the tubing is behind 
the tubing guide (at the distal 
end).
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Priming Pump Sets WITH a Drip Chamber Using the PURGE Key

1 Push down on the flow stop  to 
close the cassette.

2 Insert the piercing pin into the 
container. Suspend the container 
on an I.V. Pole.

3 Squeeze the drip chamber until 
filled halfway.

4 Push down on the flow stop  to 
open (priming position) the 
cassette.

5 Ensure the lower CAIR® (roller) 
clamp is open prior to inserting 
cassette.

WARNING: Failure to use the pressure-activated anti-siphon valve 
may result in unrestricted flow if the cassette is not 
properly installed in the pump.

When using a vented set, ALWAYS use an air-eliminating 
filter OR set the air sensitivity to either ON or 2 mL.

Note: The Purge function is available only if there is a program in the pump.
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6 Load the cassette.

CAUTION: Ensure all four 
cassette latches are clearly 
visible after the cassette is 
installed. Refer to Loading the 
Cassette on page 35.

7 Program the desired therapy.
8 Press [PURGE]. 

9 The pump displays PRIME THE 
SET? Press [YES/ENTER].

10 Press and hold [PURGE].

Continue using the [PURGE] key 
until fluid fills the tubing. Ensure 
all air is removed from the 
container, cassette, and tubing.
CAUTION: When priming is 
complete, ensure no fluid flows 
at the distal end of the pump set. 
If flow is observed, DO NOT use 
the pump set.

11 Connect the pump set to the 
patient-access device.

Note: Ensure the tubing is behind 
the tubing guide (at the distal 
end).

d
Note: Purge rate is 250 mL/hr. 
The pump purges for up to 2 
minutes each time you press and 
hold [PURGE].
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Priming Pump Sets Using Pre-filled Vials

CAUTION: When using PCA vials (except in a lockbox with a spring assist 
mechanism), the system may underdeliver. System delivery 
accuracy could be reduced by as much as 5%. 

When using pre-filled vials, ensure vial and injector are securely 
locked in lockbox before beginning delivery. 

USE ONLY purge priming with the GemStar® Lockbox with 
Spring Assist Mechanism (SAM).

1 If using a pump set with the 
Y-extension, use the slide clamp to 
close off the KVO (Keep Vein 
Open) side of the tubing.

2 Open the upper and lower slide 
clamps.

WARNING: Failure to use the pressure-activated anti-siphon valve 
may result in unrestricted flow if the cassette is not 
properly installed in the pump. 
A cracked vial might not show evidence of leakage until 
delivery pressure is applied.

When using the GemStar® Spring Assist Mechanism 
(SAM) Lockbox, USE ONLY GemStar® Pump sets 
designated for use with the GemStar® SAM Lockbox. 
Failure to use designated sets could result in unrestricted 
flow.

Note: When using the GemStar® Lockbox with SAM, refer to the SAM pump set 
labeling and SAM lockbox insert for instructions.
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3 Push down on the flow stop  to 
close the cassette.

4 Connect the pump set to a Hospira 
pre-filled vial and injector.

5 Push down on the flow stop  to 
open (priming position) the 
cassette.

6 Hold the pre-filled vial and set 
upright (vertically) on a flat 
surface with the pump set 
extending from the top.

7 Slowly push down on the injector 
until fluid flows at the distal end of 
the tubing, which indicates that all 

air is cleared from the pre-filled 
vial, injector, cassette, and tubing.

8 Push down on the flow stop  to 
close the cassette.

9 If the set includes a KVO 
Y-extension, close the slide clamp 
below the pre-filled vial and open 
the slide clamp on the KVO side. 
Prime the KVO Y-extension.

10 Ensure slide clamp is open on 
KVO side prior to inserting 
cassette.
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11 Load the cassette.

CAUTION: Ensure all four 
cassette latches are 
clearly visible after the 
cassette is installed. 
Refer to Loading the 
Cassette on page 35

.

CAUTION: When priming is 
complete, ensure no fluid flows 
at the distal end of the pump set. 
If flow is observed, DO NOT use 
the pump set.

12 Connect the pump set to the 
patient-access device.

Note: Ensure the tubing is behind 
the tubing guide (at the distal 
end).
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Priming Pump Sets with Extensions

1 Push down on the flow stop  to 
close the cassette.

2 Hold the container with the 
administrative port toward the 
ceiling and insert the piercing pin.

3 Push down on the flow stop  to 
open (priming position) the 
cassette.

4 Invert the cassette approximately 
45°.

5 While holding the rotated cassette, 
squeeze or roll the container to 
remove air from the container and 
cassette.

6 Return the cassette to the upright 
position. Continue priming until 
fluid fills the tubing.

WARNING: Failure to use the pressure-activated anti-siphon valve 
may result in unrestricted flow if the cassette is not 
properly installed in the pump.
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7 Push down on the flow stop  to 
close the cassette.

8 Connect the extension set to the 
pump set.

9 Ensure the slide clamp is open 
prior to inserting cassette.

10 Load the cassette.

CAUTION: Ensure all four 
cassette latches are clearly 
visible after the cassette is 
installed. Refer to Loading the 
Cassette on page 35.

11 Program the desired therapy.
12 Press [PURGE]. 

13 The pump displays PRIME THE 
SET? Press [YES/ENTER].

d
Note: Ensure the tubing is behind 
the tubing guide (at the distal 
end).
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14 Press and hold [PURGE]. 

Continue using the [PURGE] key 
until fluid fills the tubing. Ensure 
all air is removed from the 
container, cassette, and tubing.
CAUTION: When priming is 
complete, ensure no fluid flows 
at the distal end of the pump set. 
If flow is observed, 
DO NOT use the pump set.

15 Connect the pump set to the 
patient-access device.

d
Note: Purge rate is 250 mL/hr. 
The pump purges for up to 2 
minutes each time you press and 
hold [PURGE].
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Chapter 3

Total Parenteral Nutrition (TPN)
- Not Applicable to List 13088

Therapy Features and Specifications
This therapy allows programming of Total Parenteral Nutrition (TPN) protocols.

6 Taper Up and Taper Down may be programmed to gradually increase and 
decrease the infusion rate at the beginning and end of a therapy. If Taper Down is 
selected during programming, the pump allows auto tapering if the continuous 
delivery is stopped before the programmed volume has been infused.

6 Set an optional KVO (Keep Vein Open) during programming.

TPN Programming Tips
The following table explains how to use the keypad during TPN programming:

Tip: The Programming Worksheet at the end of this chapter lists the minimum and 
maximum values allowed for this protocol. Use copies of the programming 
worksheet to record program values before programming the pump.

Key Function Key Function

[0] - [9] Selects menu items and 
enters numeric values.

The DOWN arrow toggles 
between units of measure 
when entering concentrations. 
Scrolls through program review 
and help messages. 

Accepts entries or continues 
when done viewing a display.

The UP arrow inserts a decimal 
point in a numeric value.

Displays information during 
programming and alarm 
conditions.

Returns to a previous display, 
exits the Options Menu, and 
exits the HELP mode. 

Clears a numeric value (resets 
to zero) during programming.
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TPN Programming
1 Select TPN from the Programming Menu.
2 Select the TPN delivery mode.
3 Enter the total VTBI (Volume To Be Infused).

4 Enter the Taper Up and Taper Down times (if applicable).

5 Enter the total time to infuse.
6 Enter the KVO rate. If no KVO is desired, press [YES/ENTER] while the value 

displayed is zero.

7 Enter the container size (VTBI + KVO).

8 Select the air sensitivity, if required.
9 Review the program. Press  to begin review.
10 If using the PURGE key to prime the pump set, press [PURGE] now.

Note: Maximum VTBI is 9600 mL minus any taper amount.

Note: Time is entered in hours:minutes (00:00). For one hour thirty minutes, 
press [1] [3] [0]; not [9] [0].

Note: KVO runs after Taper Down until the total container is 
infused.

Note: If KVO is programmed, increase the container size to accommodate the 
desired KVO volume.

WARNING: ALWAYS disconnect the pump set from the patient before 
priming or purging.
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Changing a TPN Program

To change a program:
1 From the STOP mode, press [CHANGE] and select CHANGE PROGRAM.
2 As each message displays, make the desired changes or press [YES/ENTER] to 

accept the current setting.
3 Review the program. Press  to begin review.
4 Press [START] to begin infusion.

Can be changed before 

 is pressed

Can be changed at any 
time

Cannot be 
changed

• VTBI
• Taper times
• Total TPN time

• KVO rate
• Increase container size 

only
• Air sensitivity

• Delivery mode

Note: You cannot change a program when the pump is in FULL or CONTAINER 
Lock.
Hospira GemStar® System Operating Manual 55



Chapter 3. Total Parenteral Nutrition

d

430-96527-002.book  Page 56  Wednesday, February 7, 2007  12:35 PM
TPN Auto Taper Down
Auto Taper Down is available only if a Taper Down time was entered during 
programming. Auto Taper Down may be activated when the continuous delivery 
portion of a TPN with Taper Down protocol is stopped. Auto Taper Down is not 
available while the pump is in an alarm condition. 
1 Press [STOP] during TPN delivery.

The pump displays DO YOU WANT AUTO TAPERING?
• Press [NO] to return to the STOP mode. Then press [START] to continue 

therapy.
• Press [YES/ENTER] to set Auto Taper Down.

2 Enter the Auto Taper Down time.
The maximum Auto Taper Down time is three hours or two times the remaining 
volume divided by the continuous infusion rate, whichever is less.

3 Press [YES/ENTER] to return to the RUN mode, then press [START] to begin Auto 
Taper Down.

Note: Time is entered in hours:minutes (00:00). For one hour thirty minutes, 
press [1] [3] [0]; not [9] [0].
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GemStar®

TPN Programming Worksheet
GIVE: 

* Maximum VTBI is 9600 mL minus any taper amount.
** Programmable ranges for taper down are 1 minute to 3 hours or 2 times the remaining volume 

divided by the continuous delivery rate, whichever is less.
*** Air Sensitivity may not show in all setting configurations.

Parameters Selections and/or Values to be 
Entered

Programmable 
Ranges

Therapy TPN N/A
Delivery Mode Continuous

Continuous + Taper Down
Continuous + Taper Up
Continuous + Taper Up and Down

N/A

VTBI (Volume To Be 
Infused)

 mL 1 - 9600 mL*
Taper Up No

Yes  hrs:min 1 min - 3 hrs
Taper Down No

Yes  hrs:min 1 min - 3 hrs**
Total Time to Infuse

 hrs:min 1 min - 24 hrs
KVO (Keep Vein Open) No KVO Rate: 0.0

Yes KVO Rate:  1.0 - 5.0 mL/hr
Container Size

(VTBI + KVO)  mL 9999 mL max
Air Sensitivity*** On Alarms at approx. 0.5 mL of air

2 mL Alarms at approx. 2 mL of air
Off No alarm

N/A    
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Chapter 4

Pain Management
- Not Applicable to List 13086

Therapy Features and Specifications
This therapy allows programming of a continuous only, bolus only, or continuous with 
bolus delivery. 

6 In Continuous + Bolus protocols, you can enter zero for either the continuous rate 
or the bolus dose when entering or changing a program. The continuous rate and 
bolus dose cannot be zero at the same time.

6 The default bolus delivery rate is 125 mL/hr.

6 The maximum continuous delivery rate is 25 mL/hr.
6 A loading dose may be set during programming, which can be delivered after 

programming and priming are complete. The default loading dose rate is 125 
mL/hr. Rate, bolus dose, concentration can be programmed in increments of 0.01.

6 Priming using [PURGE] is only allowed before [START] is pressed or after one of 
the following events occur:
6 Complete Review of New Program
6 New Container
6 Air-in-Line Alarm

6 VTBI can be titrated.

CAUTION: When using PCA vials (except in a lockbox with a spring assist 
mechanism), the system may underdeliver. System delivery 
accuracy could be reduced by as much as 5%.

d Note: The delivery rate is administered in increments of .01.
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Pain Management Programming Tips

The following table explains how to use the keypad during pain management 
programming:

Note: New Container is allowed only when at least 1/2 of the container volume has 
been infused or 1 hour has elapsed since starting the infusion.
The use of a lockbox is recommended with pain management protocols. Refer to 
Chapter 15 Optional System Components, page 165, for instructions on using a 
lockbox with the GemStar® Pump.

Tip: The Programming Worksheet at the end of this chapter lists the minimum and 
maximum values allowed for this therapy. Use copies of the programming 
worksheet to record program values before programming the pump.

Key Function Key Function

[0] - [9] Selects menu items and 
enters numeric values.

The DOWN arrow toggles 
between units of measure 
when entering concentrations. 
Scrolls through program review 
and help messages. 

Accepts entries or continues 
when done viewing a display.

The UP arrow inserts a decimal 
point in a numeric value.

Displays information during 
programming and alarm 
conditions.

Returns to a previous display, 
exits the Options Menu, and 
exits the HELP mode. 

Clears a numeric value (resets 
to zero) during programming.
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Pain Management Programming
1 Select PAIN MANAGEMENT from the Programming Menu.
2 Select the delivery mode.

3 Select the unit of measure and concentration as required.
4 Set the continuous delivery rate.
5 Program a loading dose as required.
6 Program a bolus dose with lockout time and dose limit as required.

Regarding a 1-Hour or 4-Hour Dose Limit: The hour dose limit is the 
maximum volume (continuous plus bolus or bolus only amount) that can be 
delivered over the selected period. When the programmed dose limit is reached, 
the continuous delivery stops and a new bolus is not allowed. As the oldest 
delivery amounts age out of the 1-hour or 4-hour dose limit record, the pump 
accepts bolus requests or resumes continuous delivery (if programmed).

7 If programmed in units of mcg or mg, the line displaying the units flashes. Enter 
the container size in proper unit measure.

8 Select the air sensitivity, if required.
9 Review the program. Press  to begin review.
10 If using the PURGE key to prime the pump set, press [PURGE] now.

Note: If Continuous + Bolus is selected, the continuous delivery rate or bolus dose 
can be set to zero without reprogramming the pump. Press [STOP] and press 
[CHANGE], then select CHANGE PROGRAM.

Note: If a 1-hour or 4-hour dose limit is programmed, a bolus in progress will stop 
when the amount infused reaches the dose limit.
Loading doses are included in a 1-hour or 4-hour dose limit. A dose limit in effect 
could prevent the delivery of a loading dose.

Note: To enter the total in mL when programming a concentration, press  to 
move to the mL line. Enter the mL value when mL flashes on the display. 

WARNING: ALWAYS disconnect the pump set from the patient before 
priming or purging.
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Bolus Delivery
Set bolus doses and delivery limits during programming. The default bolus dose 
delivery rate in a Pain Management therapy is 125 mL/hr.

A bolus cord is available for patient bolus requests. Refer to Connecting the Bolus 
Cord  in Chapter 15 Optional System Components, on page 168, for more 
information.

Delivering a Bolus Dose
From the RUN mode, press either the bolus button [+] on the top of the pump or the 
button on the end of the bolus cord to begin bolus dose delivery. The pump flashes 
BOLUS DELIVERY on the display and the amount infused accrues as the delivery 
progresses. 

When the bolus dose is complete, the pump does the following:

6 Records the bolus request and delivery amount to the event and bolus history logs
6 Adds the delivered boluses to the total bolus amount in the program amounts
6 Resets the bolus lockout time (if applicable) and ignores other bolus requests until 

the lockout time has elapsed
6 Continues programmed infusion

If the bolus delivery does not start, it could be locked out by one of the following 
conditions:

6 Bolus lockout period
6 Loading dose delivery in progress
6 Bolus dose delivery in progress
6 Bolus per-hour limit
6 1-hour or 4-hour dose limit

Note:  ALL bolus requests are recorded to the event and bolus history logs.
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Bolus Dose Interruptions
Bolus deliveries may be interrupted by:
6 Pressing [STOP]
6 An alarm condition

To continue bolus delivery after an interruption:
1 Press [START]. The pump displays COMPLETE BOLUS NOW? 
2 Respond as follows:

To do this: Press this key: Bolus lockout time is set to:

Deliver the remaining 
bolus amount

The time of delivery completion

Clear the undelivered 
bolus amount

The time the bolus was 
interrupted
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Loading Dose Delivery
You can set a loading dose during programming, if desired. A loading dose can be 
delivered after programming and priming are complete.

Delivering a Loading Dose
1 After priming and programming, press [START].
2 The pump displays DELIVER THE LOADING DOSE NOW? Press [YES/ENTER] 

to begin loading dose.
When the loading dose is complete, the pump does the following:
6 Automatically begins programmed infusion
6 Records the dose amount to the history log
6 Resets the bolus lockout time (if applicable) and ignores other bolus requests until 

the lockout time has elapsed

Loading Dose Interruptions
Loading dose deliveries can be interrupted by:

6 Pressing [STOP]
6 An alarm condition
To continue a loading dose:

1 Resolve the interruption.
2 Press [START]. The pump displays COMPLETE THE LOADING DOSE? 

Note: Loading dose amounts are included in a 1-hour or 4-hour dose limit.
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3 Respond as follows:

Changing a Pain Management Program

To change a program:
1 From the STOP mode, press [CHANGE] and select CHANGE PROGRAM. 
2 As each message displays, make the desired changes or press [YES/ENTER] to 

accept the current setting.
3 Review the program. Press  to begin review.
4 Press [START] to begin delivery.

To do this: Press this key:

Deliver the remaining loading dose amount

Clear the remaining loading dose amount

Can be changed at any time Cannot be changed

• Delivery rate
• Bolus
• Bolus lockout

• Container size
• Air sensitivity
• Dose limit amount

• Delivery mode
• Unit of measure
• Concentration
• Dose limit type

Note:  You cannot change a program when the pump is in FULL or CONTAINER 
Lock. With a RATE CHANGE Lock, the continuous delivery rate and bolus amount 
can be changed within the set ranges. 
Although the delivery mode cannot be changed, if Continuous + Bolus is 
programmed, the continuous rate or bolus amount can be changed to zero. The 
minimum values set with a RATE CHANGE Lock could restrict this function.
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GemStar®

Pain Management Programming Worksheet
GIVE:

Parameters Selections and/or Values to be 
Entered

Programmable Ranges

Therapy Pain Management N/A
Delivery Mode Continuous

Bolus Only
Continuous + Bolus

N/A

Unit of 
Measure*

Concentration:  mg/mL

Concentration:  mcg/mL
mL

0.01 - 100 mg/mL

1 - 1000 mcg/mL

Continuous 
Rate*

0.1 - 2500 mg/hr
1 - 25000 mcg/hr
0.1 - 25.0 mL/hr

Loading Dose No

Yes Amount: 

0.1 - 2500 mg
1 - 25000 mcg
0.1 - 25.0 mL

Bolus Dose* 0 - 2500 mg
0 - 25000 mcg
0 - 25.0 mL

Bolus Lockout
minutes 1 - 999 min

Optional Dose 
Limit

4-hour limit Amount: 

1-hour limit Amount: 

# boluses/hour Number: 
No dose limit

4X rate - 400 mL, 40000 mg, 
400000 mcg*

Rate - 100 mL, 10000
mg, 100000 mcg*

1 - 12

*For continuous plus bolus delivery.
Note: For Bolus Only, the 1-hour or 4-hour dose limit minimum is 1 bolus dose.
Container Size 0.1 - 99999 mg

1 - 9999000 mcg
0.1 - 9999 mL
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* The delivery rate is programmable and is delivered in increments of .01.
** Air Sensitivity may not show in all setting configurations.

Air Sensitivity** On Alarms at approx. 0.5 mL of air
2 mL Alarms at approx. 2 mL of air
Off No alarm

N/A

d Note: Titrating VTBI does not change initial container volume.

Parameters Selections and/or Values to be 
Entered

Programmable Ranges
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Chapter 5

Intermittent
- Not Applicable to List 13088

Therapy Features and Specifications
This therapy allows programming of multiple doses at regular intervals.
6 Optional KVO (Keep Vein Open) can be set during programming.
6 The pump can be disconnected from the patient between dose deliveries. A call 

back alarm can be set to alert the patient or caregiver to reconnect the pump before 
the next scheduled delivery begins. The pump must remain powered on for the 
call back alarm to function. At the set time before each dose, the pump produces 
an audible and visual alarm and flashes START on the display. 

Intermittent Programming Tips
The following table explains how to use the keypad during intermittent programming:

Tip: The Programming Worksheet at the end of this chapter lists the 
minimum and maximum values allowed for this protocol. Use copies of the 
programming worksheet to record program values before programming the 
pump.

Key Function Key Function

[0] - [9] Selects menu items and 
enters numeric values.

The DOWN arrow toggles 
between units of measure 
when entering concentrations. 
Scrolls through program review 
and help messages. 

Accepts entries or continues 
when done viewing a display.

The UP arrow inserts a decimal 
point in a numeric value.

Displays information during 
programming and alarm 
conditions.

Returns to a previous display, 
exits the Options Menu, and 
exits the HELP mode. 

Clears a numeric value (resets 
to zero) during programming.
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Intermittent Programming
1 Select INTERMITTENT from the Programming Menu.
2 Enter the dose amount in mL.
3 Enter the infusion time for each dose in hours:minutes (00:00).

For example, press [4] [0] if each dose is to deliver for 40 minutes.
4 Enter the frequency of dose deliveries.

For example, press [4] [0] [0] to start a dose every four hours.
5 Enter the total number of doses in the container.

To determine the number of doses in the container, divide the volume in the 
container by the dose amount.

6 Enter the KVO rate in mL.
KVO delivers before a delayed start time, between doses, and after the last dose 
until the total container is infused.
If no KVO is desired, press [YES/ENTER] while the value displayed is zero.

7 Enter the container size.
The pump automatically calculates the minimum container size required to deliver 
the number of programmed doses and KVO between doses. 

8 Select the air sensitivity, if required.

9 The pump displays SET CALL BACK ALARM FOR NEXT DOSE?
• Press [NO] if you do not want to set the call back alarm.
• Press [YES/ENTER] to set the call back alarm.
Enter the time before the next dose that the alarm should sound. For example, 
press [1] [0] to set the alarm to sound 10 minutes before the start of the next 
scheduled delivery.

Note: If KVO is desired before a delayed start, increase the container size to 
include the desired KVO volume.

Note: DO NOT press [YES/ENTER] after selecting the air sensitivity. If 
[YES/ENTER] is accidentally pressed and a call back alarm is not desired, press 
[BACK-UP] to return to the beginning of step 9 and press [NO].
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10 The pump displays the current time. 
• If the displayed time is correct, press [YES/ENTER]. 
• To set the clock, press [OPTIONS].

11 The pump displays the current time and START NOW?
• Press [YES/ENTER] to begin delivery when the pump enters the RUN mode.
• Press [NO] to set a delayed start time. The pump displays SET START TIME. 

Enter the desired start time and press [YES/ENTER] when done.

12 Review the program. Press  to begin review.
13 If using the PURGE key to prime the pump set, press [PURGE] now.

Note: When programming the call back alarm, be sure to allow enough time for the 
patient or caregiver to reconnect the pump to the patient and to press [START] 
BEFORE the scheduled dose start time.

Note: When entering the time in 12-hour format, press  or  to toggle between AM and 
PM.

WARNING: ALWAYS disconnect the pump set from the patient before 
priming or purging.

Note: The call back alarm works only when the pump is powered on AND in the 
STOP mode. DO NOT power-off the pump while it is disconnected from the patient 
if you have set the call back alarm.
When the alarm sounds, press [SILENCE] to silence the alarm for three minutes. 
Then reconnect the pump to the patient.

Tip: To use a delayed start without specifying a start time:

1 Press [YES/ENTER].
2 Complete the program review.
3 Power-off the pump.
4 When the pump is powered on again, complete the program review, then 

press [START] to begin delivery.
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Intermittent Delivery Interruptions

Missed Start Time
6 If the programmed start time is missed, it can be changed through the Options 

Menu. Refer to Next Dose (Not available for List 13088)  in Chapter 10 Options 
Menu, on page 121.

6 If the pump remains in the STOP mode and the first dose is missed, press 
[START] to begin delivery immediately and all remaining doses will be shifted.

6 If the pump is programmed with a delayed start time and is then powered off 
before [START] is pressed, the pump will skip to the NEXT occurrence of the 
programmed start time.
For example, the current time is 10:00 PM. The user sets the delayed start time for 
10:30 PM and then powers off the pump. The user does not power on the pump 
until 10:40 PM, which is 10 minutes AFTER the scheduled start time. The pump 
does not begin delivery until 10:30 PM the FOLLOWING day.

Dose Interruptions
To understand how interruptions are resolved, compare the normal Intermittent 
delivery diagram below for a 1-hour dose every four hours, to the interruption 
diagrams shown in the examples:

Dose Delivered - 
6 If an Intermittent dose is interrupted and the pump is placed in the RUN mode 

during the on or off cycle of the current dose, the dose continues delivery from the 

d Note: The clock cannot be changed while an Intermittent Program is in 
progress.

12 1 2 3 4 5 6 7 8 9 10 11 12
72 Hospira GemStar® System Operating Manual



Chapter 5. Intermittent

430-96527-002.book  Page 73  Wednesday, February 7, 2007  12:35 PM
point where it was interrupted and all remaining doses are shifted.
For example, in the following diagram, an intermittent dose was started at 2:00. 
The dose was interrupted during the current dose cycle and was started again 
before the end of the current dose cycle.

Dose Delivered -  Dose Interrupted - 
6 If an Intermittent dose is interrupted and the pump is placed in the RUN mode 

after the off cycle of the current dose, the next dose begins delivery. All remaining 
doses are shifted if necessary.
For example, in the following diagram, an intermittent dose was started at 2:00. It 
was interrupted during the current delivery cycle at 2:30, but was not started again 
until after the current delivery cycle at 6:45:

Dose Delivered -  Dose Interrupted - 
6 When the dose is complete, the start time for the Next Dose displays. To change 

the start time refer to Chapter 10 Options Menu, page 107.
6 Any missed Intermittent doses, except the first dose, are added to the end of the 

delivery schedule.

12 1 2 3 4 5 6 7 8 9 10 11 12

12 1 2 3 4 5 6 7 8 9 10 11 12
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Changing an Intermittent Program

To change a program:
1 From the STOP mode, press [CHANGE] and select CHANGE PROGRAM.
2 As each message displays, make the desired changes or press [YES/ENTER] to 

accept the current setting.
3 Review the program. Press  to begin review.
4 Press [START] to begin delivery.

Can be changed at 
any time

Can be changed if no 
dose is in progress

Cannot be changed 

after  is pressed

• Dose parameters
• KVO rate
• Container size
• Air sensitivity
• Call back alarm

• Next dose start time • Current time

Note: You cannot change a program when the pump is in FULL or CONTAINER 
Lock. 
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GemStar®

Intermittent Programming Worksheet
GIVE:

* The pump automatically calculates the minimum container size required to deliver the number of 
programmed doses and KVO between doses. If KVO is desired before a delayed start, increase the 
container size to include the desired KVO volume.

** Air sensitivity may not show in all setting configurations.

Parameters Selections and/or Values to be Entered Programmable 
Ranges

Therapy Intermittent N/A
Dose Amount 

0.1 - 9600 mL
Infusion Time 
Per Dose

 hrs:min 1 min - 24 hrs
Dose 
Frequency

hrs:min

(Infusion time per
dose + 1 min) to 96 hrs

Number of 
Doses Per 
Container 1 - 999

KVO
(Keep Vein 
Open)

No KVO Rate: 0.0

Yes KVO Rate: 0.1 -5.0 mL/hr

Container 
Size* 0.1 - 9999 mL
Air 
Sensitivity**

On Alarms at approx. 0.5 mL of air
2 mL Alarms at approx. 2 mL of air
Off No alarm

N/A

Call Back 
Alarm

No
Yes

Alarm: hrs:min before start
1 min to time between 
doses

Start Time Start immediately after programming

Start time: 
Specify AM or PM if not 24-hour clock.

12:00 AM - 11:59 PM or 
00:00 - 23:59
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Chapter 6

Continuous
- Not Applicable to List 13088

Therapy Features and Specifications
This therapy allows programming of a continuous delivery.
6 Optional KVO (Keep Vein Open) can be set during programming.
6 The rate can be titrated while the pump is infusing.
6 An optional secondary container can be “piggybacked” on the primary container 

during regular delivery using a GemStar® Piggyback Pump Set. Refer to 
Piggybacking in this chapter for more information.

Continuous Programming Tips

The following table explains how to use the keypad during continuous programming:

Tip: The Programming Worksheet at the end of this chapter lists the minimum 
and maximum values allowed for this protocol. Use copies of the programming 
worksheet to record program values before programming the pump.

Key Function Key Function

[0] - [9] Selects menu items and 
enters numeric values.

The DOWN arrow toggles 
between units of measure 
when entering concentrations. 
Scrolls through program review 
and help messages. 

Accepts entries or continues 
when done viewing a display.

The UP arrow inserts a decimal 
point in a numeric value.

Displays information during 
programming and alarm 
conditions.

Returns to a previous display, 
exits the Options Menu, and 
exits the HELP mode. 

Clears a numeric value (resets 
to zero) during programming.
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Continuous Programming
1 Select CONTINUOUS from the Programming Menu.
2 Select the unit of measure and concentration as required.
3 Enter the rate.
4 Enter the VTBI (Volume to be Infused).
5 Enter the KVO rate, if desired.

KVO runs after the programmed VTBI until the total container is infused. If no 
KVO is desired, press [YES/ENTER] while the value displayed is zero.

6 Enter the container size (VTBI + KVO).
VTBI is the default value on the CONTAINER display.

7 Select the air sensitivity, if required.
8 Review the program. Press  to begin review.
9 If using the PURGE key to prime the pump set, press [PURGE] now.

Note: If KVO is programmed, increase the container size to include the KVO 
delivery.
To enter the total in mL when programming a concentration, press  to move to 
the mL line. Enter the mL size when mL flashes on the display.

WARNING: ALWAYS disconnect the pump set from the patient before 
priming or purging.
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Rate Titration
To titrate the rate while the pump is infusing:
1 In the RUN mode, press the number keys for the new rate. Press [YES/ENTER].

For example: if the current rate is 50 mL/hr, press [1][0] [0] [YES/ENTER] to 
change the rate to 100 mL/hr.

2 NEW RATE displays with the new value. 
• Press [YES/ENTER] within 10 seconds to accept the change and begin 

delivery at the new rate.
• Press [NO] to continue delivery at the previously programmed rate.

Piggybacking
Piggybacking with the GemStar® Pump requires a GemStar® Primary Piggyback 
Pump Set with a proximal Y-site backcheck valve and a secondary piggyback set with 
an extension hook. The secondary container must be higher than the primary 
container. Refer to the instructions included with the piggyback pump set for more 
information.

The piggyback rate and piggyback VTBI display until the secondary container has 
been delivered. Then the primary infusion continues.

Note: You have approximately five seconds after pressing a key to press another 
numeric key, the decimal key, or [YES/ENTER]. If no key is pressed within five 
seconds, the rate does not change and the delivery continues as previously 
programmed.

WARNING: When using the pump for secondary delivery (piggybacking), 
ensure the fluids being infused are chemically and physically 
compatible.

Note: The piggyback infusion amount is NOT added to the primary programmed 
infusion amount.
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Preparing for Secondary Delivery (Piggybacking)
1 Ensure a primary piggyback pump set with a 

proximal Y-site backcheck valve is in place.
2 Use the extension hook from the secondary set 

to suspend the primary container from the I.V. 
pole.

3 Prepare the secondary set according to the 
instructions included with the set. 

4 Attach a needle or blunt cannula (if appropriate) 
and prime the secondary set.

5 Suspend the secondary container from the I.V. 
pole.
 

6 Connect the secondary set to the proximal 
Y-site (or proximal luer port).

Note: When using a secondary container of 
500 mL or greater, ensure the bottom of the 
secondary container is at least 7 inches (17.8 
cm) above the fluid level in the primary 
container. Use additional extension hooks if 
necessary.
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Programming a Secondary Delivery (Piggybacking)

1 Press [CHANGE] and select PIGGYBACKING from the Change Menu.
2 Enter the dose amount for the secondary container.
3 Enter the infusion time for the secondary container.
4 Open the slide clamp or lower CAIR® (roller) clamp on the tubing of the 

secondary container. 
5 Press [YES/ENTER] to begin piggyback delivery.

Changing a Piggyback Delivery
1 Press [CHANGE] and select PIGGYBACKING from the Change Menu.
2 Press [CHANGE] to reset the dose amount to zero.
3 Enter the new piggyback dose amount and press [YES/ENTER].
4 Set the infusion time for the secondary container.
5 Press [YES/ENTER] to begin piggyback delivery.

Note: To distinguish the piggyback delivery from the 
primary delivery, PIGGYBACK displays and the piggyback 
VTBI counts down to completion. For example, a 
piggyback rate of 250 mL/hr with a remaining VTBI of 
218.5 mL will display as 219 mL.

PIGGYBACK
RATE 250 mL/hr
VTBI 219 mL

Tip: Prepare and set up containers BEFORE programming the pump for piggyback 
delivery.

Note: Primary flow stops until the secondary VTBI is delivered; then primary flow 
continues. Any remaining secondary fluid will be delivered at the primary rate. The 
maximum piggyback rate is 300 mL/hr. For secondary rates above 300 mL/hr, flow 
may occur from the primary container.

Note: You must know the amount that has already been delivered. When the piggyback 
dose amount is changed, the pump begins a new VTBI countdown.
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Canceling a Piggyback Delivery
1 Press [CHANGE] and select PIGGYBACKING from the Change Menu.
2 Press [CHANGE] to reset the dose amount to zero.
3 Press [YES/ENTER] to cancel piggyback delivery. 

Alarms Affecting Piggyback Delivery
The following delivery-related Operational Alarms occur during a Piggyback 
Delivery:
6 Check Cassette
6 Air in Line
6 Distal Occlusion
6 Proximal Occlusion
If an alarm occurs during the programming sequence, piggyback dose programming is 
completed.

Changing a Continuous Program

To change a program:
1 From the STOP mode, press [CHANGE] and select CHANGE PROGRAM.
2 As each message displays, make the desired changes or press [YES/ENTER] to 

accept the current setting.
3 Review the program. Press  to begin review.
4 Press [START] to begin delivery.

Can be changed at any time Cannot be changed

• Delivery rate
• VTBI
• KVO rate

• Container size
• Air sensitivity
• Piggybacking

• Unit of measure
• Concentration

Note:  You cannot change a program when the pump is in FULL or CONTAINER Lock. 
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GemStar®

Continuous Programming Worksheet
GIVE:

*Air Sensitivity may not show in all setting configurations.

Parameter Selections and/or Values to be 
Entered

Programmable Ranges

Therapy Continuous N/A

Unit of Measure Concentration:  mg/mL

Concentration:  mcg/mL
mL

0.1 - 1000 mg/mL

1 - 1000 mcg/mL

Rate 0.1 - 9999 mg/hr
1 - 999900 mcg/hr
0.1 - 1000 mL/hr

VTBI
(Volume To Be 
Infused)

0.1 - 99999 mg
1 - 9999000 mcg
0.1 - 9999 mL

KVO
(Keep Vein 
Open)

No KVO Rate: 0.0

Yes KVO Rate: 0.1 - 5.0 mL/hr

Container Size 
(VTBI + KVO)

0.1 - 99999 mg
1 - 9999000 mcg
0.1 - 9999 mL

Air Sensitivity* On Alarms at approx. 0.5 mL of air
2 mL Alarms at approx. 2 mL of air
Off No alarm

N/A

Piggyback Dose 
Amount 1 - 7200 mL
Piggyback 
Infusion Time

 hrs:min

1 min or 
dose amount / 300 mL/hr to 24 
hrs or dose amount / 0.1 mL/hr
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Chapter 7

Weight Dosed
- Not Applicable to List 13088

Therapy Features and Specifications
This therapy allows programming of delivery rate as a function of body weight.
6 The air sensitivity in a Weight Dosed program is automatically set to ON. This 

setting can be changed through the Options Menu after programming is complete. 
Refer to Air Sensitivity  in Chapter 10 Options Menu, on page 117.

6 The pump automatically delivers KVO (Keep Vein Open) after the programmed 
VTBI (Volume To Be Infused) has completed.

6 The rate can be titrated while the pump is infusing.

6 VTBI can be titrated.

CAUTION: When infusing short-half-life drugs (i.e., those dosed with units of 
mcg/kg/min) at very low rates (0.8 mL/hr or less) the rate may be too 
slow for that drug. Consider using a lower drug concentration with 
these drugs so a pump rate above 0.8 mL/hr can be used.

Tip: The Programming Worksheet at the end of this chapter lists the minimum and 
maximum values allowed for this protocol. Use copies of the programming worksheet 
to record program values before programming the pump.

WARNING: When using a vented drip set, ALWAYS use an air-
eliminating filter or set the air sensitivity to either ON or 
2 mL.
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Weight Dosed Programming Tips
The following table explains how to use the keypad during weight dosed programming:

Weight Dosed Programming
1 Select WEIGHT DOSED from the Programming Menu.
2 Select the unit of measure.

3 Enter the patient weight, if required.
4 Enter the concentration:

• Enter the value for the unit of measure when it flashes on the display.
• Press [YES/ENTER] to confirm. 

5 Enter the rate.

6 Enter the VTBI.
7 Review the program. Press  to begin review.

Key Function Key Function

[0] - [9] Selects menu items and 
enters numeric values.

The DOWN arrow toggles 
between units of measure 
when entering concentrations. 
Scrolls through program review 
and help messages. 

Accepts entries or continues 
when done viewing a display.

The UP arrow inserts a decimal 
point in a numeric value.

Displays information during 
programming and alarm 
conditions.

Returns to a previous display, 
exits the Options Menu, and 
exits the HELP mode. 

Clears a numeric value (resets 
to zero) during programming.

Note: If two numbers appear before a menu time (e.g., 02), press both number 
keys to select that item.

Tip: Press  to toggle between units of measure.

Note: The pump automatically displays the mL/hr equivalent even when another 
unit of measure is selected.
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8 If using the PURGE key to prime the pump set, press [PURGE] now. 

Auto KVO
When the programmed VTBI has completed delivery, Auto KVO delivery begins 
automatically and the empty container alarm sounds. 

Rate Titration
To titrate the rate while the pump is infusing:
1 In the RUN mode, press the number keys for the new rate. Press [YES/ENTER].

For example: if the current rate is 7.5 mcg/kg/min, press [1][0] [YES/ENTER] to 
change the rate to 10 mcg/kg/min.

2 NEW RATE displays with the new value. 
• Press [YES/ENTER] within 10 seconds to accept the change and begin 

delivery at the new rate.
• Press [NO] to continue delivery at the previously programmed rate.

WARNING: ALWAYS disconnect the pump set from the patient before 
priming or purging.

Note: Auto KVO delivers even while the empty container alarm sounds. Press 
[SILENCE] to quiet the alarm for 2 minutes.

If the weight dosed rate is: Auto KVO delivers at:

Greater than or equal to 1 mL/hr 1 mL/hr

Less than 1 mL/hr The weight dosed rate

Note: You have approximately five seconds after pressing a key to press another 
numeric key, the decimal key, or [YES/ENTER]. If no key is pressed within five 
seconds, the rate does not change and the delivery continues as previously 
programmed.
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VTBI Titration
To titrate the VTBI while the pump is infusing:
1 Press [CHANGE] and select TITRATE VTBI.
2 Press the number keys for the new VTBI. Press [YES/ENTER].

For example: if the current VTBI is 0 mL, press [1][0] to change the VTBI to 10 
mL.

3 NEW VTBI displays with the new rate.
• Press [YES/ENTER] within 10 seconds to accept the change and begin 

delivery with the new VTBI.
• Press [NO] to continue delivery at the previously programmed VTBI.

Changing a Weight Dosed Program

To change a program:
1 From the STOP mode, press [CHANGE] and select CHANGE PROGRAM.
2 As each message displays, make the desired changes or press [YES/ENTER] to 

accept the current setting.
3 Review the program. Press  to begin review.
4 Press [START] to begin delivery.

Note: You have approximately five seconds after pressing a key to press another 
numeric key, the decimal key, or [YES/ENTER]. If no key is pressed within five 
seconds, the VTBI does not change and the delivery continues as previously 
programmed.

Note: Titrating VTBI does not change initial container volume.

Can be changed at any time Cannot be changed

• Delivery rate
• VTBI
• Patient weight

• Unit of measure
• Concentration (amount of drug)

Note: You cannot change a program when the pump is in FULL or CONTAINER Lock.
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GemStar® Weight Dosed Programming Worksheet
GIVE:  

Note: Numbers increment by hundredths—for example, 0.1 increments to 0.11, then to 0.12.
** If two numbers appear before a menu item (e.g., 02), press both number keys to select that item.

CAUTION: When infusing short-half-life drugs (i.e., those dosed with units of mcg/kg/min) at very low 
rates (0.8 mL/hr or less) the rate may be too slow for that drug. Consider using a lower drug 
concentration so a pump rate above 0.8 mL/hr can be used.

Parameter Selections and/or Values to be Entered Programmable 
Ranges

Therapy Weight Dosed N/A
Unit of Measure** mcg/kg/min

mcg/kg/hr
mcg/min
mg/kg/min
mg/kg/hr
mg/min
mL/hr
mg/hr

mcg/hr
grams/hr
ng/kg/min
U/kg/hr
U/min
U/hr
mUn/min
mEq/hr

N/A

Patient Weight (When programming in kg/min or kg/hr)

2.0 - 200.0 kg
Concentration 
(2 entries are 
required. Use  
to toggle)

(For all units of measure EXCEPT mL/hr)
mg U mEq
in in in
mL mL mL

0.1 - 9999000 mg
0.1 - 99999999 U
0.1 - 9999 mEq
0.1 - 9999 mL

Rate
(see below *)

VTBI
(Volume To Be 
Infused) 0.1 - 9999 mL

* Programmable Ranges for Rate (not all units of measure are available in all pump configurations):
0.001 - 833 mg/kg/min 0.1 - 1000 mL/hr 0.001 - 99999999 U/min
0.001 - 500000 mg/kg/hr 0.001 - 999999 mg/hr 0.001 - 99999999 U/hr
0.001 - 16666 mg/min 0.001 - 9999999 mcg/hr 0.001 - 999999999 mUn/min
0.001 - 166666 mcg/kg/min 0.001 - 999 grams/hr 0.001 - 999 mEq/hr
0.001 - 9999999 mcg/kg/hr 0.009 - 999 ng/kg/hr
0.002 - 166666 mcg/min 0.001 - 99999999 U/kg/hr
Hospira GemStar® System Operators Manual 89



Chapter 7. Weight Dosed

d

430-96527-002.book  Page 90  Wednesday, February 7, 2007  12:35 PM
Programming a Precedex® (dexmedetomidine 
hydrochloride injection) Delivery
If configured and used by your facility, you can program a Precedex® delivery 
while programming a Weight Dosed therapy. 

Note: Titrate rate, loading dose, and titrate VTBI are available in Precedex® therapy.

To program a Precedex® delivery:
1 Select WEIGHT DOSED from the Programming menu.
2 Select MCG/KG/HR as the unit of measure.
3 The pump displays IS THIS A PRECEDEX THERAPY? Press [YES/ENTER].
4 Enter patient weight in kg, and then press [YES/ENTER].
5 Enter the concentration:

6 Enter the unit of measure for the value flashing on the display.
6 Use the  key to toggle between the values, and then press [YES/ENTER].

6 Enter the rate, and then press [YES/ENTER].

7 Enter the VTBI in mL, and then press [YES/ENTER].
8 The pump displays PROGRAM A LOADING DOSE? Press [YES/ENTER] to 

program a loading dose or [NO] to review the program.
9 If programming a loading dose, specify a dose, time, and rate using the  key 

to toggle between the parameters, and then press [YES/ENTER].
10 Review the program using the  key; when finished, press [YES/ENTER].

11 If using the PURGE key to prime the pump set, press [PURGE] now. 
12 Press [START] to begin the Precedex® delivery.

Note: Rate is entered in mcg/kg/hr, and then displays in mL/hr.

WARNING: ALWAYS disconnect the pump set from the patient before 
priming or purging.
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GemStar® Precedex® (dexmedetomidine hydrochloride 
injection) Programming Worksheet

GIVE:  

Parameter Selections and/or Values to be Entered Programmable 
Ranges

Therapy Weight Dosed N/A
Unit of Measure mcg/kg/hr N/A
Precedex® 
Therapy?

[YES/ENTER] N/A

Patient Weight
kg

2.0 - 200.0 kg

Concentration 
(Add values are 
required. Use  
to toggle between 
fields)

mcg
in
mL

1.0- 1000

0.1 - 1000

Rate
mcg/kg/hr

(mL/hr is automatically calculated)
0.1 - 1000*

VTBI
(Volume To Be 
Infused) mL 0.1 - 9999 mL

Loading Dose
(2 entries are 
required. Use  
to toggle between 
mg and mL entry 
points.)

No
Yes

Dose mcg/kg

Time**

0 - 1.0** 

* Package Insert recommends 0.2 to 0.7 mcg/kg/hr. The delivery rate is programmable and is delivered 
in increments of .01.
** Package Insert recommends 1 mcg/kg over10 min . Cannot enter less than 10 min.

Note: Numbers increment by hundredths—for example, 0.1 increments to 0.11, 
then to 0.12.
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Chapter 8

mL/hr Only
- Not Applicable to List 13088

Therapy Features and Specifications
This therapy allows quick programming of delivery rate in milliliters (mL) only.
6 The air sensitivity is automatically set to ON. This setting can be changed through 

the Options Menu after programming is complete. Refer to Air Sensitivity  in 
Chapter 10 Options Menu, on page 117.

6 The pump automatically delivers KVO (Keep Vein Open) after the programmed 
VTBI (Volume To Be Infused) is complete.

6 The rate can be titrated while the pump is infusing.
6 An optional secondary container can be “piggybacked” onto the primary container 

during regular delivery using a GemStar® Piggyback Pump Set. Refer to 
Piggybacking in this chapter for more information.

6 A program review is not required and is available only through the Options Menu.
6 VTBI can be titrated.
Tip: The Programming Worksheet at the end of this chapter lists the minimum and 
maximum values allowed for this protocol. Use copies of the programming worksheet 
to record program values before programming the pump.

WARNING: When using a vented set, ALWAYS use an air-eliminating 
filter or set the air sensitivity to either ON or 2 mL.
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mL/hr Programming Tips
The following table explains how to use the keypad during mL/hr programming:

mL/hr Only Programming
1 Select mL/hr Only from the Programming Menu.
2 Enter the rate.
3 Enter the VTBI.
4 If using the PURGE key to prime the pump set, press [PURGE] now.

Key Function Key Function

[0] - [9] Selects menu items and 
enters numeric values.

The DOWN arrow toggles 
between units of measure 
when entering concentrations. 
Scrolls through program review 
and help messages. 

Accepts entries or continues 
when done viewing a display.

The UP arrow inserts a decimal 
point in a numeric value.

Displays information during 
programming and alarm 
conditions.

Returns to a previous display, 
exits the Options Menu, and 
exits the HELP mode. 

Clears a numeric value (resets 
to zero) during programming.

WARNING: ALWAYS disconnect the pump set from the patient before 
priming or purging.

Note: A program review is not required for mL/hr Only programs.
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Auto KVO
When the programmed VTBI has completed delivery, Auto KVO delivery begins 
automatically and the empty container alarm sounds.  

Rate Titration
To titrate the rate while the pump is infusing:
1 In the RUN mode, press the number keys for the new rate. Press [YES/ENTER].

For example: if the current rate is 100 mL/hr, press [5] [0] [YES/ENTER] to change 
the rate to 50 mL/hr.

2 NEW RATE displays with the new value. 
• Press [YES/ENTER] within 10 seconds to accept the change and begin 

delivery at the new rate.
• Press [NO] to continue delivery at the previously programmed rate.

Note: Auto KVO delivers even while the empty container alarm sounds. Press 
[SILENCE] to quiet the alarm for 2 minutes.

If the weight dosed rate is: Auto KVO delivers at:

Greater than or equal to 1 mL/hr 1 mL/hr

Less than 1 mL/hr The programmed rate

Note: You have approximately five seconds after pressing a key to press another 
numeric key, the decimal key, or [YES/ENTER]. If no key is pressed within five 
seconds, the rate does not change and the delivery continues as previously 
programmed.
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VTBI Titration
To titrate the VTBI while the pump is infusing:
1 Press [CHANGE] and select TITRATE VTBI.
2 Press the number keys for the new VTBI. Press [YES/ENTER].

For example: if the current VTBI is 0 mL, press [1][0] to change the VTBI to 10 
mL.

3 NEW VTBI displays with the new rate.
• Press [YES/ENTER] within 10 seconds to accept the change and begin 

delivery with the new VTBI.
• Press [NO] to continue delivery at the previously programmed VTBI.

Piggybacking
Piggybacking with the GemStar® Pump requires a GemStar® Primary Piggyback 
Pump Set with a proximal Y-site backcheck valve and a secondary piggyback set with 
an extension hook. The secondary container must be higher than the primary 
container. Refer to the instructions included with the piggyback pump set for more 
information.

The piggyback rate and piggyback VTBI display until the secondary container has 
been delivered. Then the primary infusion continues.

Note: You have approximately five seconds after pressing a key to press 
another numeric key, the decimal key, or [YES/ENTER]. If no key is 
pressed within five seconds, the VTBI does not change and the delivery 
continues as previously programmed.

Note: Titrating VTBI does not change initial container volume.

WARNING: When using the pump for secondary delivery 
(piggybacking), ensure the fluids being infused are 
chemically and physically compatible.

Note: The piggyback infusion amount is NOT added to the primary programmed 
infusion amount.
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Preparing for Secondary Delivery (Piggybacking)
1 Ensure a primary piggyback pump set with a 

proximal Y-site backcheck valve is in place.
2 Use the extension hook from the secondary set 

to suspend the primary container from the I.V. 
pole.

3 Prepare the secondary set according to the 
instructions included with the set.

4 Attach a needle or blunt cannula (if appropriate) 
and prime the secondary pump set.

5 Suspend the secondary container from the I.V. 
pole.

 

6 Connect the secondary set to the proximal 
Y-site (or proximal luer port).

7 Program a secondary delivery.

Note: When using a secondary container of 
500 mL or greater, ensure the bottom of the 
secondary container is at least 7 inches (17.8 
cm) above the fluid level in the primary 
container. Use additional extension hooks if 
necessary.
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Programming a Secondary Delivery (Piggybacking)

1 Press [CHANGE] and select PIGGYBACKING from the Change Menu.
2 Enter the dose amount for the secondary container.
3 Enter the infusion time for the secondary container.
4 Open the slide clamp or lower CAIR® (roller) clamp on the tubing of the 

secondary set.
5 Press [YES/ENTER] to begin piggyback delivery.

Changing a Piggyback Delivery
1 Press [CHANGE] and select PIGGYBACKING from the Change Menu.
2 Press [CHANGE] to reset the dose amount to zero.
3 Enter the new piggyback dose amount and press [YES/ENTER].
4 Set the infusion time for the secondary container.
5 Press [YES/ENTER] to begin piggyback delivery.

Note: To distinguish the piggyback delivery from the primary 
delivery, PIGGYBACK displays and the piggyback VTBI 
counts down to completion. For example, a piggyback rate 
of 250 mL/hr with a remaining VTBI of 218.5 mL will 
display as 218.5 mL.

PIGGYBACK
RATE 250.0 mL/hr
VTBI 218.5 mL

Tip: Prepare and set up containers BEFORE programming the pump for piggyback 
delivery.

Note: Primary flow stops until the secondary VTBI is delivered; then primary flow 
continues. Any remaining secondary fluid will be delivered at the primary rate. The 
maximum piggyback rate is 300 mL/hr. For secondary rates above 300 mL/hr, flow 
may occur from the primary container.

Note: You must know the amount that has already been delivered. When the piggyback 
dose amount is changed, the pump begins a new VTBI countdown.
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Canceling a Piggyback Delivery
1 Press [CHANGE] and select PIGGYBACKING from the Change Menu.
2 Press [CHANGE] to reset the dose amount to zero.
3 Press [YES/ENTER] to cancel piggyback delivery.

Changing a mL/hr Only Program

To change a program:
1 From the STOP mode, press [CHANGE] and select CHANGE PROGRAM.
2 As each message displays, make the desired changes or press [YES/ENTER] to 

accept the current setting.

3 Press [START] to begin delivery.

Can be changed at any time

• Delivery rate
• Container size

• Piggybacking
• VTBI

Note:  You cannot change a program when the pump is in FULL or CONTAINER Lock.

Note: A program review is not required and is available only through the Change or 
Options Menu.
Hospira GemStar® System Operating Manual 99



Chapter 8. mL/hr

430-96527-002.book  Page 100  Wednesday, February 7, 2007  12:35 PM
GemStar®

mL/hr Only Programming Worksheet
GIVE: 

Parameter Selections and/or Values 
to be Entered

Programmable Ranges

Therapy mL/hr Only N/A

Rate

0.1 - 1000 mL/hr

VTBI

(Volume To Be Infused) 0.1 - 9999 mL

Piggyback Dose 
Amount

1 - 7200 mL

Piggyback Infusion 
Time

hrs:min

1 min or 
dose amount / 300 mL/hr to 24 
hrs or dose amount / 0.1 mL/hr
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Chapter 9

Variable Time
- Not Applicable to List 13088

Therapy Features and Specifications
This therapy allows programming of multiple doses at specified times.

6 Optional KVO (Keep Vein Open) can be set during programming.
6 The default bolus delivery rate is 400 mL/hr.

Variable Time Programming Tips
The following table explains how to use the keypad during variable time 
programming:

Tip: The Programming Worksheet at the end of this chapter lists the minimum and 
maximum values allowed for this protocol. Use copies of the programming worksheet 
to record program values before programming the pump.

Key Function Key Function

[0] - [9] Selects menu items and 
enters numeric values.

The DOWN arrow toggles 
between units of measure 
when entering concentrations. 
Scrolls through program review 
and help messages. 

Accepts entries or continues 
when done viewing a display.

The UP arrow inserts a decimal 
point in a numeric value.

Displays information during 
programming and alarm 
conditions.

Returns to a previous display, 
exits the Options Menu, and 
exits the HELP mode. 

Clears a numeric value (resets 
to zero) during programming.
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Variable Time Programming
1 Select VARIABLE TIME from the Programming Menu.
2 Select the phase type.
3 Select the unit of delivery.
4 Change the displayed time if necessary.
5 Enter the optional base rate with start and stop time.
6 If programming in Rates or Doses, go to step 7. If programming in Percentages, 

set the daily amount. Then go to step 8.

7 Enter the phase information for each phase. Up to 24 phases can be programmed.

8 Enter the optional bolus dose and its lockout.
9 Enter the optional KVO.

10 Enter the container size. 
The pump calculates the minimum container size required to deliver the phases, 
base rate, and KVO for one day or in a 24-hour period. If delivering the protocol 
for more than one day, multiply this amount by the number of days of 
therapy.

11 Select the air sensitivity, if required.

Note: If programming in percentages, the total daily amount of all phases pro-
grammed must equal 100%.

Note: When entering time in 12-hour format, press  or  to toggle 
between AM and PM.

Note: Increase the container size to include bolus deliveries.
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12 Review the program. Press  to begin review.
13 If using the PURGE key to prime the pump set, press [PURGE] now.

Variable Time Delivery Interruptions

WARNING: ALWAYS disconnect the pump set from the patient before 
priming or purging.

Note: With variable time programming, the pump keeps track of where it is in the 
program each minute of the entire 24-hour period. For example, if Phase 1 is missed, 
and the pump is placed in RUN mode in the middle of Phase 2, it starts delivery 
according to the program parameters from the middle of Phase 2. 

If a phase is interrupted and the 
pump is placed in the RUN mode:

Then:

Before the end of the phase. The phase runs to its scheduled 
stop time.

After the end of the phase, but before 
the beginning of the next start time. 

The next phase begins delivery at 
the scheduled start time. 

All applicable Base Rate or KVO 
delivery infuses while waiting for the 
start of the next phase.

In the middle of a phase and the phase 
start was missed because of a program 
interruption or a missed program start.

The pump immediately begins 
delivery of the current phase at its 
current time-based point.
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Changing a Variable Time Program

To change a program:
1 From the STOP mode, press [CHANGE] and select CHANGE PROGRAM.
2 As each program parameter displays, make the desired changes or press 

[YES/ENTER] to accept the current setting.
3 Review the program. Press  to begin review.
4 Press [START] to begin delivery.

Can be changed at 
any time

Can ONLY be changed 

before  is pressed

Cannot be changed

• KVO rate
• Container size
• Air sensitivity
• Bolus 

• Current time
• Base rate
• Daily amount
• Phase parameters

• Unit of measure
• Concentration
• Phase type

Note: You cannot change a program when the pump is in FULL or CONTAINER Lock.

Note: The clock cannot be changed while a Variable Time Program is in progress.
If [START] has already been pressed in a Pain Management program, when the SET 
CLOCK function is selected from Stop Mode, the following message shall display from 
2 - 5 seconds during which no keys shall be valid except [YES/ENTER] as a quick 
escape, before returning to the Stop Mode display:

Note: The container size cannot be made smaller than the daily total of phases, base 
rate, and KVO combined; or the current amount delivered, whichever is greater.
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GemStar® Variable Time Programming Worksheet
GIVE:

Parameter Selections and/or Values to be Entered Programmable 
Ranges

Select Phase Type Percentages 
Rates
Doses

0.1 - 100%*
0.1 - 400 mL/hr
0.1 - 9600 mL

Unit of Measure Concentration: mg/mL 

Concentration: mcg/mL 
mL

0.1 - 1000 mg/mL

1 - 1000 mcg/mL

Current Time Confirm or correct current time. 12:00 AM - 11:59 PM
or 00:00 - 23:59

Base Rate No
Yes Start time: 

Stop time: 

Rate: 

12:00 AM - 11:59 PM

or 00:00 - 23:59

0.1 - 400 mL/hr
Total Daily Amount for All Phases:  (required only when programming in percentages)

———- SEE ATTACHED WORKSHEET———-
Bolus Dose 0.1 mL - 25.0 mL

0.1 mg - 2500 mg

1 mcg - 25000 mcg
Bolus Lockout

 minutes 5 - 999 min

KVO
(Keep Vein Open)

No KVO Rate: 0.0

Yes KVO Rate: 0.0 - 5.0 mL/hr

Container Size
(Total Daily Amount X 
Number of Days of 
Therapy)

0.1 - 99999 mg

1 - 9999000 mcg

0.1 - 9999 mL

Air Sensitivity** On Alarms at approx. 0.5 mL of air
2 mL Alarms at approx. 2 mL of air
Off No alarm

N/A

* Sum of all phases must equal 100% when programmed in percentages.
** Air Sensitivity may not show in all setting configurations.
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Phase Start Time Stop Time Percentage Rate Dose

1

2

3

4

5

6

7

8

9

10

11

12

13

14

15

16

17

18

19

20

21

22

23

24

TOTAL Note: The sum of all phases must equal 100% 
when programmed in percentages.
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Chapter 10

Options Menu

Overview
1 Press [OPTIONS] from RUN or STOP mode.
2 Select the number key for the desired function.
3 Follow the display messages for the selected 

function. Refer to the appropriate description in this 
chapter for more information.

Tips for Using the Options Menu
The following keys are helpful when using the Options Menu: 

Note: Menu selections may vary depending on the 
configuration of the pump. For example, NEXT DOSE is 
only available when an Intermittent therapy is 
programmed.
When the pump exits OPTIONS, the pump returns to the 
mode it was in when [OPTIONS] was pressed.

Key Function Key Function

[0] - [8] Selects menu items and 
enters numeric values.

The DOWN arrow toggles 
between units of measure 
when entering concentrations. 
Scrolls through program review 
and help messages. 

Accepts entries or continues 
when done viewing a display.

The UP arrow inserts a decimal 
point in a numeric value.

Returns to a previous display, 
exits the Options Menu, and 
exits the HELP mode. 

1 REVIEW PROGRAM
2 HISTORIES
3 KEYPAD LOCK
4 PUMP SETTINGS
5 SET CLOCK
6 PRINT
7 SPEED PROTOCOL
8 NEXT DOSE
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Tip: A menu item does not have to be on the display to be selected. For example, only 
items 1 through 4 are shown when the Options Menu is first displayed. To select the 
Print Menu without scrolling the display, press [6].

Select this item 
from the Options 
Menu:

To do this function: Comments:

REVIEW 
PROGRAM

Display the current program 
settings.

N/A

HISTORIES Display the history for the latest 
400 events, shift or volume totals, 
bolus history (if available), or 
current configuration settings. 
Clear the history. Display the 
Operation Test.

CAUTION: Ensure two fresh, 
disposable AA batteries are 
installed for backup power 
when using other power 
sources (e.g., AC mains 
adaptor, docking station, 
battery pack). The pump will 
continue to operate on backup 
power if the external power 
source fails. Refer to the 
caution regarding Power Loss 
on page 14.

KEYPAD LOCK Lock and unlock the keypad to 
prevent unauthorized changes to 
the program.

The lock levels allow the clinician to 
restrict access to various levels of 
pump operation.

PUMP SETTINGS Change the air sensor, occlusion 
sensor, and sound level settings.

N/A

SET CLOCK Set the clock. The clock can be displayed in 12-hour 
or 24-hour format.

PRINT Print the history event log, bolus 
history (if available), current 
program settings, and speed 
protocols.

Files may be downloaded to a printer 
or personal computer.

SPEED 
PROTOCOLS

Assign, review/recall, and delete 
the stored protocols.

Allows up to 9 speed protocols to be 
saved in pump memory. 

NEXT DOSE 

Note: This option is 
not available for List 
13088.

Change the start time of the next 
dose when an interruption has 
caused a missed dose in an 
intermittent program.

NEXT DOSE appears on the menu 
only when the pump is in an 
intermittent program and changing the 
next dose is allowed.
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Review Program
1 Press [OPTIONS] and select REVIEW PROGRAM. The 

pump displays PROGRAM REVIEW.
2 Press  to begin review.
3 Press [YES/ENTER] or [BACK-UP] when done to exit 

OPTIONS. 

Histories 
1 Press [OPTIONS] and select HISTORIES.
2 Select the number key for the desired function.
3 Complete the appropriate steps for the selected 

function.

1 REVIEW PROGRAM
2 HISTORIES

3 KEYPAD LOCK

4 PUMP SETTINGS
5 SET CLOCK

6 PRINT

7 SPEED PROTOCOL

8 NEXT DOSE

1 REVIEW PROGRAM

2 HISTORIES
3 KEYPAD LOCK
4 PUMP SETTINGS

5 SET CLOCK

6 PRINT
7 SPEED PROTOCOL

8 NEXT DOSE
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Select this item 
from the Histories 
Menu:

To do this 
function:

Display includes:

HISTORY Display history 
event log of the 
latest 400 
events.

• Current date and time
• Date and time the program was cleared, a new 

container was selected, or a speed protocol was 
recalled

• History event log of the latest 400 events

CAUTION:Ensure two fresh, disposable AA 
batteries are installed for backup power 
when using other power sources (e.g., AC 
mains adaptor, docking station, battery 
pack). The pump will continue to operate on 
backup power if the external power source 
fails. Refer to the caution regarding Power 
Loss on page 14.

SHIFT TOTALS Display or clear 
shift totals.

• Time and date when shift was cleared
• Volume infused in the shift
• Any relevant program-specific information

VOLUME TOTALS Display volume 
totals.

• Amount infused
• VTBI
• Any relevant program-specific information

CONFIGURATION Display pump 
configuration.

• Dependent upon pump configuration

CLEAR HISTORY Clear history 
event log and 
bolus history.

• CLEARING HISTORY displays for 3 to 4 seconds

BOLUS HISTORY Display bolus 
history in hourly 
increments for 
the last 48 
hours. 

• Current date and time
• Number of boluses delivered
• Number of bolus demands
• Amount delivered through bolus delivery

OPERATION TEST Perform 
user-assisted 
Operation Test.

• Messages that guide the user through each section 
of the test

Note: Some menu items may not be available depending on the configuration of the 
pump.
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History
To display the history event log:
1 Press [OPTIONS] and select HISTORIES.
2 Select HISTORY from the Histories Menu.
3 Press  or  to scroll the display. 
4 Press [BACK-UP] when done to exit OPTIONS. 

Shift Totals
To display the shift totals:
1 Press [OPTIONS] and select 

HISTORIES.
2 Select SHIFT TOTALS from the Histories Menu.
3 The shift totals display. Press  or  to scroll 

the display.

To clear the shift totals:
1 Follow the steps for displaying shift totals.
2 At the end of the shift totals, the pump displays 

CLEAR TOTALS? YES OR NO:

• Press [YES/ENTER] to clear 
the shift totals.

• Press [NO] to exit OPTIONS 
without clearing the shift totals.

Tip: Press and HOLD  or  to scroll through the history displays faster.

Tip: Press [HELP] to display shift totals when the pump is not in PROGRAMMING 
mode or an alarm condition.

VERSION N.NNN
S/N XXXXXXXX

TIME IS 09:00 AM
FRI, NOV 10, 06

NEW CONTAINER
08:15AM NOV 10

HISTORY CLEARED
11:00PM NOV 9
EVENT LOG

PM11:18 SET ON
AIR SENSITIVITY
PM11:18 SET CONT

SIZE 100 mL
PM11:18 SET RATE

1.0 mL/hr
PM11:18 SHIFT

CLEARED
END OF EVENT LOG

Sample History Event Log

END OF
SHIFT TOTALS
CLEAR TOTALS?
YES OR NO 
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Volume Totals
To display the volume totals:
1 Press [OPTIONS] and select HISTORIES.
2 Select VOLUME TOTALS from the Histories Menu.
3 Press [BACK-UP] when done to exit OPTIONS.

To clear the volume totals:
1 Follow the steps for displaying volume totals.
2 At the end of the volume totals, the pump displays 

CLEAR TOTALS? YES OR NO:

• Press [YES/ENTER] to clear 
the volume totals.

• Press [NO] to exit OPTIONS 
without clearing the volume totals.

Configuration
To display the pump configuration:

1 Press [OPTIONS] and select HISTORIES.
2 Select CONFIGURATION from the Histories Menu.
3 Press [BACK-UP] when done to exit OPTIONS.

Clear History
To clear the history event log and bolus history:
1 Press [OPTIONS] and select HISTORIES. 
2 Select CLEAR HISTORY from the Histories Menu.
3 The pump display CLEARING HISTORY for 3–4 seconds before exiting 

OPTIONS.

Tip: Press [BACK-UP] to exit OPTIONS immediately.

END OF
VOLUME TOTALS
CLEAR TOTALS?
YES OR NO 
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Bolus History
To display the bolus history:
1 Press [OPTIONS] and select HISTORIES.
2 Select BOLUS HISTORY from the 

Histories Menu.
3 Press [BACK-UP] when done to exit OPTIONS.

 

Operation Test
The Operation Test checks several pump functions to ensure the GemStar® Pump is 
working properly. Refer to Chapter 14 Operation Test on page 155 for instructions.

Note: Bolus History is only available if the current 
program has a bolus programmed, or had a bolus 
programmed at one time. The Bolus History is 
maintained in hourly increments for the latest 48 hours.
The Bolus History is cleared when a new program is 
entered, a Speed Protocol is recalled, or the History is 
cleared.

TIME IS 09:15 AM
FRI, NOV 10, 06

BOL DEL 30
BOL DEM 37

BOL AMT 30.0 mL
06:10A TO 09:14A

Sample Bolus History
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Keypad Lock 
1 Press [OPTIONS] and select KEYPAD LOCK from 

the Options Menu.
2 Select the desired lock level.

The following lock levels, listed from lowest to highest 
restrictions, are available:

The GemStar® Pump allows two lock levels at the same time. Therapy Lock can be 
used with either Full Lock, Container Lock, or Rate Change Lock. 

When two lock levels are applied, if a function is available under one lock level but 
not the other, the more stringent restrictions apply. The table on the following page 
lists the functions available for each lock level. 

When the pump is locked under a particular level, a small lock symbol ( ) appears 
next to the applied lock level as shown above. When the pump is in RUN or STOP 
mode, the lock symbol appears in the lower left corner of the display and the lock 
level abbreviation appears in the lower right corner.

Clinicians: refer to Chapter 11 Clinician Instructions on page 129 for detailed 
instructions.

Lock Level Abbreviation

Therapy Lock T

Rate Change 
Lock

R

Container Lock C

Full Lock F

Note: Therapy lock is not available for List 13088.

1 REVIEW PROGRAM
2 HISTORIES

3 KEYPAD LOCK
4 PUMP SETTINGS
5 SET CLOCK

6 PRINT

7 SPEED PROTOCOL

8 NEXT DOSE

1 THERAPY LOCK
2 RATE CHANGE

3 CONTAINER
4 FULL LOCK

  T
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GemStar® Keypad Lock Level Functions
U = Unlock
T = Therapy Lock
R = Rate Change Lock

C = Container Lock
F = Full Lock
• = Function is Available

Function U T R C F Comments
Lock/Unlock Keypad • • • • • Rate Change Lock is available only if the 

current program is Pain Management.
Power Pump On or Off • • • • •
Start or Stop Infusion • • • • •
Access Display, Help, Print, and 
Program Review Functions

• • • • •

Deliver a Bolus • • • • • If programmed.

Silence an Alarm • • • • •
Select a New Container • • • •
Purge • • • •
Change a Program • • • Under Rate Change Lock, only the delivery 

rate or bolus dose volume can be changed 
and must be within the preset values.

Review/Recall Speed Protocol • • Under Therapy Lock, the recalled protocol 
must be the same type that was 
programmed when the pump was locked.

Assign or Delete Speed Protocol • •
Set Air Sensitivity, Distal 
Occlusion Level, Sound Level, 
and Clock

• •

Clear Shift Totals • • • •
Program and Deliver a Loading 
Dose (Outside of Programming 
Mode)

• •

Enter a New Program • • Under Therapy Lock, the new program 
must be of the same type that was 
programmed when the pump was locked.

Piggybacking • •
VTBI Titration • •
Rate Titration • •
Operation Test •
Clear History •
Select Another Therapy •
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Change Pump Settings
1 Press [OPTIONS] and select PUMP SETTINGS.
2 Press the number key for the desired pump setting.
3 Follow the display messages. Refer to the 

instructions of the desired pump setting for more 
information.

Select this item from 
the Pump Settings 
Menu:

To do this 
function:

Comments:

AIR SENSOR Change the air 
sensor sensitivity.

 

The pump alarms when it detects an air 
bubble of approximately 0.5 mL when ON; 
or at approximately 2 mL when 2 mL is 
selected. The air alarm does not sound if 
OFF is selected.

Note: The air sensor is not accessible for 
configuration if pre-configured by your 
facility to ON or 2mL.
The air alarm can also be set during 
programming if the current therapy allows 
it.

OCCL SENSOR Change the distal 
occlusion sensor 
sensitivity. 

Default Setting: High

The pump alarms when distal pressure is 
greater than the selected occlusion 
sensor limit.

SOUND LEVEL Adjust the audible 
alarm level.

Default Setting: Maximum
The alarm cannot be turned off 
completely. The alarm automatically 
reverts to the maximum volume if the user 
does not respond within one minute.

Note: The current setting flashes on the display.

1 REVIEW PROGRAM
2 HISTORIES

3 KEYPAD LOCK

4 PUMP SETTINGS
5 SET CLOCK

6 PRINT

7 SPEED PROTOCOL
8 NEXT DOSE
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Air Sensitivity

1 Press [OPTIONS] and select AIR SENSITIVITY. The current air sensitivity 
flashes on the display.

2 Select the desired Air Sensitivity level.

3 After selecting the desired Air Sensitivity, the 
pump displays: CHANGE AIR ALARM FROM 
XXXX TO XXXX: 
• Press [NO] to keep the current air sensitivity. 

The current air alarm status displays and the 
pump exits OPTIONS.

• Press [YES/ENTER] to accept the new setting. The new air alarm status displays 
and the pump exits OPTIONS.

Occlusion Sensor
1 Press [OPTIONS] and select PUMP SETTINGS.
2 Select DISTAL OCCLUSION from

the Pump Settings Menu.
3 Select the desired setting.
4 The pump displays MAKE XXXXX DEFAULT?

• Press [NO] to temporarily change the distal 
occlusion setting. The new setting will be in effect 
until a new program is entered or the pump has been off for more than 24 
hours.

• Press [YES/ENTER] to permanently change the distal occlusion setting. The 
new setting will remain in effect until the setting is changed again through the 
Options Menu.

WARNING: To reduce the risk of infusing air, use an air-eliminating 
filter when the air sensitivity is set to OFF.

Note: If OFF is selected, the pump displays: 
AIR ELIMINATING FILTER IS 
RECOMMENDED. ENTER TO CONFIRM. You 
must press [YES/ENTER] to confirm.

AIR SENSITIVITY
1 ON
2 2 mL
3 OFF

CHANGE AIR ALARM
FROM: XXXX
TO: XXXX
YES OR NO

DISTAL OCCLUSION
1 HIGH
2 MEDIUM
3 LOW
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Sound Level
1 Press [OPTIONS] and select PUMP SETTINGS.
2 Select SOUND LEVEL from the Pump Settings Menu.
3 When the pump displays the Sound Level function, it 

sounds intermittent beeps at the current sound level. 
The blocks on the top line of the display indicate the 
current sound level.

• Press  to increase the sound level. 
• Press  to decrease the sound level.
• Press [CHANGE] to restore the sound level to the default setting.

4 Press [YES/ENTER] when done.

Set Clock 
1 Press [OPTIONS] and select SET CLOCK.
2 Select 12-Hour or 24-Hour format (24-Hour format is 

shown in example).
3 Use the arrow keys to set the weekday and month.
4 Use the number keys to enter the current day, year, 

and time.

5 Press [YES/ENTER] to confirm.

Note: The alarm cannot be turned off completely. The alarm automatically reverts 
to the maximum volume if the user does not respond within one minute.

Note: When entering the time in 12-Hour format, 
press  or  to toggle between AM and PM.

Note: The clock cannot be changed while an intermittent 
or variable time program is in progress.

Tip: To view the clock from the RUN or STOP mode, 
press [YES/ENTER], then immediately press and 
HOLD [1]. The clock displays until [1] is released.

- nnnnnnnn +
USE TO ADJUST
THE SOUND LEVEL
ENTER WHEN DONE

1 REVIEW PROGRAM
2 HISTORIES

3 KEYPAD LOCK

4 PUMP SETTINGS
5 SET CLOCK
6 PRINT

7 SPEED PROTOCOL
8 NEXT DOSE

SET CLOCK TYPE
1 SELECT 12 HOUR
2 SELECT 24 HOUR

TIME IS 20:35
MON, JUL 26, 06

ENTER TO CONFIRM
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Print

1 Press [OPTIONS] and select PRINT.
2 Press the number key for the desired print function.
3 When printing is complete, the pump exits OPTIONS.

WARNING: Ensure a cassette is installed in the pump before 
connecting to a printer or computer. 

If the pump is connected to a patient: BEFORE 
connecting the pump to a computer or printer, press 
[STOP], close the slide clamp, and eject the cassette. 
Leave the pump set connected to the patient. Install 
another cassette in the pump before connecting to a 
printer or computer.

Note: Ensure the printer is connected to the pump BEFORE selecting a print 
function. Refer to Connecting to the Seiko Printer on page 125 for more 
information.

Select this item from 
the Print Menu:

To do this function:

PRINT HISTORY Print the current program, shift and volume totals, and history 
event log (400 events).

PRINT PROGRAM Print the current program.
PRINT PROTOCOL Print a specified speed protocol or a complete list of all speed 

protocols.
PRINT BOLUS Hx Print the current program, shift and volume totals, and the 

bolus history (Hx) for the latest 48 hours.
STOP PRINT Cancel printing. This function is only available if the pump is 

printing. 

1 REVIEW PROGRAM

2 HISTORIES
3 KEYPAD LOCK

4 PUMP SETTINGS

5 SET CLOCK
6 PRINT
7 SPEED PROTOCOL

8 NEXT DOSE
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Speed Protocol 
1 Press [OPTIONS] and select SPEED PROTOCOL.
2 Press the number key for the desired protocol 

function.
3 Follow the display messages. Refer to the 

instructions for Speed Protocol functions for more 
information.

Assign
1 Press [OPTIONS] and select SPEED PROTOCOL.
2 Select ASSIGN from the Speed Protocol menu.
3 Select [1]–[9] to assign to the new protocol.

If the selected speed protocol is already assigned, the pump displays REPLACE 
PROTOCOL ASSIGNMENT?

• Press [YES/ENTER] to replace the protocol. The pump displays the new speed 
protocol and exits OPTIONS.

• Press [NO] to keep the existing protocol and exit OPTIONS.

Note: Up to nine speed protocols are stored at one 
time. The speed protocols stay in memory, even when 
the pump is powered down, until they are deleted.

Select this item from
the Speed Protocol Menu:

To do this function:

ASSIGN Store a program in pump memory for later use.
REVIEW/RECALL Review assigned protocols from the RUN or 

STOP mode. Recall an assigned protocol from 
the STOP mode.

DELETE Delete protocols from pump memory.

1 REVIEW PROGRAM

2 HISTORIES
3 KEYPAD LOCK

4 PUMP SETTINGS

5 SET CLOCK
6 PRINT

7 SPEED PROTOCOL
8 NEXT DOSE
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Review/Recall
1 Press [OPTIONS] and select SPEED PROTOCOL.
2 Select REVIEW/RECALL from the Speed Protocol menu.
3 Select the desired protocol to review/recall.
4 Review the program. Press  to begin review.
5 Press [YES/ENTER]:

• If in the STOP mode, press [1] to recall the protocol; or press [2] to review 
another protocol.

• If in the RUN mode, the pump exits OPTIONS.

Delete
1 Press [OPTIONS] and select SPEED PROTOCOL.
2 Select DELETE from the Speed Protocol Menu.
3 Select the desired protocol to delete.
4 Press [YES/ENTER] to confirm deletion or [NO] to exit OPTIONS without 

deleting.

Next Dose (Not available for List 13088)
This function is only available when the current therapy is 
Intermittent and the pump is not delivering a dose.

To set the time for the next dose:
1 Press [OPTIONS] and select NEXT DOSE.
2 Use the number keys to enter the start time for the 

next dose. Press [YES/ENTER] to accept the change 
and exit OPTIONS.

Tip: When entering the time in 12-hour format, press  or  to toggle between 
AM and PM.

1 REVIEW PROGRAM

2 HISTORIES
3 KEYPAD LOCK

4 PUMP SETTINGS

5 SET CLOCK

6 PRINT
7 SPEED PROTOCOL

8 NEXT DOSE
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Connecting to the Data Port
Use the Data Port to connect the GemStar® Pump to a Seiko® DPU 414 or 
compatible serial printer to print the Operation Test results or the files available from 
the Print Menu. Using communication software included with most computer 
operating systems (or available from local sources), these files can also be transferred 
to a computer.

Equipment Needed

WARNING: Ensure a cassette is installed in the pump before 
connecting to a printer or computer. 

If the pump is connected to a patient: BEFORE 
connecting the pump to a computer or printer, press 
[STOP], close the slide clamp, and eject the cassette. 
Leave the pump set connected to the patient. Install 
another cassette in the pump before connecting to a 
printer or computer.

Connect to Printer Connect to Computer

GemStar® Pump • •
Hospira Serial Printer Cable List 
13078-01 • •
Seiko DPU 414 or Compatible 
Serial Printer •
Serial DB9 Female-to-Female 
Gender Changer* •
Null Modem* •
Computer* •
*Available from local sources.
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Configuration Settings
Refer to the printer or computer documentation for information on configuration 
settings. Configure the printer or computer as follows to use the Data Port:

To configure the switch settings on the Seiko DPU 414:
1 Press and hold the ONLINE button while sliding the POWER switch to ON.
2 When the list of the current settings start printing, release the ONLINE button.
3 Set the switches according to the following table. 

Press the ONLINE button to continue setting switches. 
• Press ONLINE to set switch ON.
• Press FEED to set switch OFF. 

4 Continue setting switches until “Dip SW setting complete!!” is printed.

Baud Rate = 2400

Data Bits = 8 

Stop Bits = 1

Parity = None

Carriage Return (+Line Feed) = CR+LF

Flow Control = None

Note: When using the Seiko DPU 414 printer, the switch settings MUST be configured 
to work with the GemStar® Pump.
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Switch Settings for Seiko DPU-414 Printer

Switch Function Setting Button to Press

SW1-1 Input Method: Serial Off FEED

SW1-2 Printing Speed: High On ONLINE

SW1-3 Auto Loading: On On ONLINE

SW1-4 CR function: CR and LF On ONLINE

SW1-5 DIP SW setting 
command:

Enabled On ONLINE

SW1-6 Printing density: 100% Off FEED

SW1-7 Printing density: 100% On ONLINE

SW1-8 Printing density: 100% On ONLINE

SW2-1 Print Mode: 40 columns On ONLINE

SW2-2 User defined char: On On ONLINE

SW2-3 Ordinary 
Characters:

On On ONLINE

SW2-4 Zero Font: No slash On ONLINE

SW2-5 Character Set: American On ONLINE

SW2-6 Character Set: American On ONLINE

SW2-7 Character Set: American On ONLINE

SW2-8 Character Set: American Off FEED

SW3-1 Data bit length: 8 bits On ONLINE

SW3-2 Parity: No parity On ONLINE

SW3-3 Parity condition: Odd On ONLINE

SW3-4 Flow control: H/S busy On ONLINE

SW3-5 Baud rate: 2400 bps On ONLINE

SW3-6 Baud rate: 2400 bps Off FEED

SW3-7 Baud rate: 2400 bps Off FEED

SW3-8 Baud rate: 2400 bps On ONLINE
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Connecting to the Seiko Printer

CAUTION:DO NOT connect the GemStar® AC mains adaptor to a printer.

1 Install a cassette into the pump.
2 Connect the GemStar® serial cable to the printer and to the data port on the 

bottom of the pump.
3 Ensure the printer is ONLINE and ready to receive data. Refer to printer 

documentation for more information.
4 Ensure paper is loaded in the printer.
5 Select the desired print function from the pump menu.

WARNING: Ensure a cassette is installed in the pump before 
connecting to a printer or computer. 

If the pump is connected to a patient: BEFORE connecting 
the pump to a computer or printer, press [STOP], close the 
slide clamp, and eject the cassette. Leave the pump set 
connected to the patient. Install another cassette in the 
pump before connecting to a printer or computer.

Refer to the printer documentation or contact the printer 
manufacturer for more information regarding Electrostatic 
Discharge (ESD) susceptibility of printer connector ports.

Note: For maximum battery life, operate the pump on AC mains when connected to a 
printer or computer.
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Connecting to a Computer
 

1 Ensure slide clamp or lower CAIR® clamp is open prior to inserting cassette.
2 Install a cassette into the pump.
3 Connect the GemStar® serial cable to the null modem.
4 Connect the null modem to the serial gender changer.
5 Connect the serial gender changer to the serial port of the computer.
6 Connect the GemStar® serial cable to the data port on the bottom of the pump.
7 Configure the communication 

software on the computer. Refer 
to Configuration Settings on 
page 123.

WARNING: Ensure a cassette is installed in the pump before 
connecting to a printer or computer.

If the pump is connected to a patient: BEFORE connecting 
the pump to a computer or printer, press [STOP], close the 
slide clamp, and eject the cassette. Leave the pump set 
connected to the patient. Install another cassette in the 
pump before connecting to a computer or printer. 

Refer to the computer documentation or contact the 
computer manufacturer for more information regarding 
Electrostatic Discharge (ESD) susceptibility of computer 
connector ports.

Note: For maximum battery life, operate the pump on AC mains when connected to a 
printer or computer.

f Tip: After the data transfer is complete, use any text editor to view or print the file.
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Transferring Data Using a Computer
The GemStar® Pump can be connected to a Windows®-compatible computer. The 
following instructions apply to computers using Microsoft® Windows® 95, 
Windows® 98, or Windows NT® 4.0 or higher.

Creating a New Connection

To create a new connection:
1 Follow steps 1–4 in Using an Existing Connection on the following page.
2 If a message appears asking if a modem is necessary for a connection, click NO.
3 Enter a name for the new connection (e.g., GemStar® Print Files) and choose an 

icon.
4 Click OK.
5 From the Connect drop-down menu, select the appropriate COM port.
6 Click OK.
7 Verify that the following settings are correct:

8 Click OK.
9 Select the Properties icon.
10 Select the Settings tab.
11 Select the ASCII setup button.
12 Ensure ‘Append line feeds to incoming line ends’ is checked.
13 Click OK in the ASCII setup window.
14 Click OK in the Properties window.

Note: The following procedure is only needed to create a “New Connection” the first 
time the pump is connected to the computer.

Baud Rate = 2400
Data Bits = 8 
Stop Bits = 1

Parity = None
Flow Control = None
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15 From the menu, select File > Save.
16 Exit HyperTerminal.

Using an Existing Connection

To transfer data from the GemStar® Pump to a computer:
1 From the Windows® desktop, select the Start Menu.
2 Select Programs.
3 Select Accessories.
4 Select HyperTerminal.
5 Double click on the icon with the name entered in step 3, Creating a New 

Connection on page 127.
6 From the menu, select Call > Connect.
7 From the menu, select Transfer > Capture Text.
8 Type the path and file name where the printout should be saved.

Ensure the file extension is “.txt”.
The default path is: c:\windows\accessories\hyperterminal.

9 Click Start.
10 Select the desired print function from the pump. Refer to the table of printing 

functions on page 119.
11 Wait for the transmission to complete.
12 From the menu, select Transfer > Capture Text > Stop.
13 Exit HyperTerminal.
14 Use any text editor to view or print the file.

Note: If the file name already exists, the new printout will be added to the end of 
the existing file. For example, use a patient’s name or ID number as the file 
name. Then select that file for all of that patient’s printouts.
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Chapter 11

Clinician Instructions
The instructions in this section apply to special features available to clinicians. 
Remove this section from the manual to prevent unauthorized access to these 
features. 

The GemStar® Pump provides quick access to commonly used functions. Instead of 
accessing these functions by navigating through the menu system, you can enter the 
key combinations shown in this table:

Function Quick Access Key Combination

Unlock Keypad Place the pump in STOP mode and then enter the lock 
sequence to unlock a Full Container or Rate Lock. You 
cannot use quick access keys to unlock a Therapy Lock.

Displays Shift Totals Place the pump in STOP mode and then press [HELP] to 
display Shift Totals.

Display Clock Place the pump in STOP mode, press [YES], and then press 
and hold [1]. The clock displays until you release [1].

Program a Loading 
Dose

From the Pain Management STOP mode, press 
[YES/ENTER], and then press [0] to program a Loading 
Dose.
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Clinician Locking Sequence Instructions

Locking the Pump

To lock the pump from the RUN or STOP mode:
1 Press [OPTIONS] to display the Options Menu.
2 Select KEYPAD LOCK from the Options Menu.

3 Select the desired lock level. For THERAPY, CONTAINER, and FULL Lock, go to 
step 5.

4 For RATE CHANGE Lock, set the minimum and maximum programmable ranges 
for the continuous delivery rate and bolus dose in a Pain Management program.

• MIN flashes on the display. Enter the minimum value. 
• MAX flashes on the display. Enter the maximum value.

5 Press [YES/ENTER] when done.
6 Repeat steps 4 and 5 for a bolus dose if available in the current program.
7 Enter the lock sequence number. Asterisks display as the numbers are entered. 

• For THERAPY Lock, enter [0][0][0][3][1].
• For UNLOCKED, FULL, CONTAINER, and RATE CHANGE lock levels, enter 

[1][3][0][0][0].

Note: If a lock level is already applied to the pump, the Lock Sequence Number 
must be entered before a second lock level can be applied. Refer to Adding a 
Second Lock Level on page 131 for more information. 

Tip: Press  to toggle between the MIN and MAX values.

Note: Default lock sequence numbers are shown.
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Adding a Second Lock Level
1 Press [OPTIONS] to display the Options Menu.
2 Select KEYPAD LOCK from the Options Menu.
3 Enter the Lock Sequence Number.
4 For RATE CHANGE Lock, set the minimum and maximum programmable ranges 

for the continuous delivery rate and bolus dose in a Pain Management program.

• MIN flashes on the display. Enter the minimum value. 
• MAX flashes on the display. Enter the maximum value.

5 Press [YES/ENTER] when done.
6 Repeat steps 4 and 5 for a bolus dose if available in the current program.

7 Enter the lock sequence number. Asterisks display as the numbers are entered. 
• For THERAPY Lock, enter [0][0][0][3][1].
• For UNLOCKED, FULL, CONTAINER, and RATE CHANGE lock levels, enter 

[1][3][0][0][0].

Tip: Press  to toggle between the MIN and MAX values.

Note: When two lock levels are applied, if a function is available under one lock 
level but not the other, the more stringent restrictions apply.

Note: Default lock sequence numbers are shown.
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Unlocking the Pump
1 Press [OPTIONS] to display the Options Menu.
2 Select KEYPAD LOCK from the Options Menu.
3 Select the lock level to be unlocked.
4 Enter the lock sequence number for that level.

5 The pump displays the current lock levels. Press [YES/ENTER] to return to the 
mode the pump was in when [OPTIONS] was pressed.

Program and Deliver a Clinician Activated Loading Dose
This feature is available only when the keypad is UNLOCKED or when 
THERAPY is the only lock level. The default loading dose rate is 125 
mL/hr.

1 From the STOP mode, press [YES/ENTER] [0].
2 The pump displays: PROGRAM A LOADING DOSE?

Press [YES/ENTER].
3 Enter the loading dose. Press [YES/ENTER].
4 The pump displays: DELIVER THE LOADING DOSE NOW?

To deliver the loading dose immediately, press [YES/ENTER].
Primary infusion DOES NOT begin automatically when the clinician activated 
loading dose is complete. Press [START] to continue primary infusion.

To deliver the loading dose later, press [NO]. 

Note: If the pump is locked under two levels, each level must be unlocked 
separately. Unlocking one level has no effect on the other level. For example, if 
both THERAPY and RATE CHANGE lock levels are applied, the clinician must 
unlock both the RATE CHANGE and THERAPY locks.

Note: Loading dose amounts are included in a 1-hour or 4-hour dose limit.
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The pump returns to the STOP mode. The next time [START] is pressed, the pump 
again displays: DELIVER LOADING DOSE NOW? 
• Press [YES/ENTER] to deliver the loading dose. Primary infusion continues 

automatically when the loading dose is complete.
• Press [NO] to cancel the loading dose and continue primary infusion.

Shift Totals and History

Shift Totals
1 Press [OPTIONS] and select HISTORIES.
2 Select SHIFT TOTALS from the Histories Menu.
3 The shift totals display. Press

 and  to scroll the display. When done, the 
pump displays CLEAR TOTALS? YES OR NO.
• Press [YES/ENTER] to clear the shift totals.
• Press [NO] to exit OPTIONS without clearing 

the shift totals.

Clear History Event Log and Bolus History
1 Press [OPTIONS] and select HISTORIES.
2 Select CLEAR HISTORY.
3 CLEARING HISTORY displays and the pump exits OPTIONS.

Tip: Press [HELP] to display shift totals when the pump is not in PROGRAMMING 
mode or an alarm condition.

END OF
SHIFT TOTALS
CLEAR TOTALS?
YES OR NO 
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Key Combinations Not on Screens
The table below lists special key combinations to access information or activate an 
activity which is not listed on the screen.

.

Screen and/or 
Situation

Press Results

If a loading dose has 
been programmed 
but not delivered, 
displays the 
DELIVER LOADING 
DOSE NOW? screen

[YES/ENTER] + [0] Displays the PROGRAM A LOADING DOSE? 
screen

CURRENT DATE 
AND TIME 
displaying

[YES/ENTER] + [1] Displays the real time clock as long as [1] is held 
down
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Chapter 12

Troubleshooting

This section contains information on audible and visual alarms that may occur with 
the GemStar® Pump.

CAUTION: If the pump does not perform as stated in this manual, stop using it 
IMMEDIATELY.

For consultation and technical support contact either an authorized Hospira 
representative or the Hospira Technical Support Operations hotline (available 24 
hours a day).

To return the pump for service, first contact Hospira Customer Support between 7:00 
AM and 4:00 PM Pacific time. Have the pump serial number available.

In the USA Hospira Technical Support Operations
1-800-241-4002

Hospira, Inc.
Technical Support Operations
755 Jarvis Drive
Morgan Hill, CA 95037

Outside the USA: Contact your local Hospira sales 
office.

Tip: Press [HELP] for additional information during programming and alarm 
conditions.
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Alarm Messages

Alarm Display 
Message

Is the 
pump 
infusing?

Alarm Cause/
Condition

Remedy

Y = Yes
N = No

A = Audible alarm
V = Visual alarm

AIR IN LINE

• Pump 
automatically 
enters STOP 
mode.

N A/V The specified volume 
of air has been 
detected in the line 
distal to the cassette 
while infusing.

1 Press [SILENCE] to quiet 
the alarm for 1 minute.

2 Press [STOP] to clear the 
alarm.

3 Disconnect the patient 
from the pump set.

4 Press and hold [PURGE].
Note: Purge rate is 250 mL/hr. 
The pump purges for up to 2 
minutes each time you press 
and hold [PURGE]. Purge 
volume may be limited in a 
Pain Management program.

5 Reconnect the pump set to 
the patient-access device.

6 Press [START] to begin 
infusion.
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CHANGE BATTERIES N A/V The pump has 
entered the STOP 
mode due to battery 
voltage below 
acceptable levels.

1 Replace both disposable 
batteries with fresh AA 
batteries and press  to 
restart the pump; or connect 
the pump to the AC mains 
adaptor and the pump will 
automatically restart. 
Replace both batteries as 
soon as possible.

CAUTION: Ensure two 
fresh, disposable AA 
batteries are installed for 
backup power when 
using other power 
sources (e.g., AC mains 
adaptor, docking station, 
battery pack). The pump 
will continue to operate 
on backup power if the 
external power source 
fails. Refer to the caution 
regarding Power Loss on 
page 14.

2 After power-on, resume the 
current program. Refer to 
Accessing the Programming 
Menu in Chapter 2 Basic 
Operation for more 
information.

Alarm Display 
Message

Is the 
pump 
infusing?

Alarm Cause/
Condition

Remedy

Y = Yes
N = No

A = Audible alarm
V = Visual alarm
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CHECK CASSETTE-X N A/V The cassette is 
improperly installed 
or not installed.

X indicates where to 
look for the cause of 
the alarm:

D = Distal

P = Proximal

1 Press [SILENCE] to quiet 
the alarm for 1 minute.

2 Press [STOP] to place the 
pump in the STOP mode.

3 Ensure slide clamp or lower 
CAIR® clamp is open prior 
to inserting cassette.

4 Reinstall the cassette.
CAUTION: Ensure all 
four cassette latches 
are clearly visible after 
the cassette is installed. 
Note: Ensure the tubing is 
behind the tubing guide (at the 
distal end). Refer to Loading 
the Cassette on page 35.

5 Press [START] to begin 
infusion.
Note: The pump cannot be 
powered off during a CHECK 
CASSETTE alarm (except 
during 
PROGRAMMING mode).

CALL
1.800.XXX.XXXX

CODE: NN/MMM/TTT
[SERVICE ALARM]

N A/V The pump has 
detected a condition 
that may require 
service.

1 Write down the telephone 
number and code.

2 Power-off the pump. If the 
pump does not power-off, 
disconnect external power 
and remove the batteries.

3 Call the telephone number 
shown on the display 
message.

Alarm Display 
Message

Is the 
pump 
infusing?

Alarm Cause/
Condition

Remedy

Y = Yes
N = No

A = Audible alarm
V = Visual alarm
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DIST. OCCLUSION N A/V The pump has 
detected sustained 
distal pressure over 
the user-selected 
limit. 

To avoid a bolus 
infusion after an 
occlusion, complete 
the following steps:

1 Press [STOP].
2 Close the distal 

clamp.
3 Press the 

cassette release 
button to remove 
the cassette from 
the pump.

4 Open the flow 
stop.

5 Wait 10 seconds.
6 Close the flow 

stop.
7 Load the 

cassette into the 
pump.

8 Open the distal 
clamp.

9 Review the 
program.

10 Press [START] 
to start the 
pump.

1 Press [SILENCE] to quiet 
the alarm for 1 minute.

2 Press [STOP] to place the 
pump in the stop mode.

3 Check for sources of distal 
occlusion: 
• Kinked tubing below the 

pump 
• Clamped patient-

access device 
• Clogged I.V. filter 
• Other obstructions

4 If the problem continues, 
remove and reinstall the 
cassette.
CAUTION: Ensure all 
four cassette latches 
are clearly visible after 
the cassette is installed. 
Note: Ensure the tubing is 
behind the tubing guide (at the 
distal end). Refer to Loading 
the Cassette on page 35.

5 Press [START] to begin 
infusion.

Alarm Display 
Message

Is the 
pump 
infusing?

Alarm Cause/
Condition

Remedy

Y = Yes
N = No

A = Audible alarm
V = Visual alarm
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LOW BATTERIES A/V The pump has 
detected battery 
voltage below 
acceptable levels and 
the batteries are the 
primary power 
source.

Note: The pump 
allows the user to 
clear the LOW BAT-
TERIES alarm. If 
the condition has not 
been corrected after 
15 minutes, the alarm 
continues.

If the pump is infusing 
and a LOW BAT-
TERIES alarm 
occurs, the pump con-
tinues for approxi-
mately 30 minutes* 
before it can no longer 
deliver due to insuffi-
cient power.

*If an external power 
source is used, the 
rate is changed, or the 
pump is powered-on 
after a LOW BAT-
TERIES alarm and 
those same batteries 
are still in the pump, 
this interval may be 
different.

1 Press [SILENCE] to quiet 
the alarm for 15 minutes.

2 Press [STOP] to place the 
pump in the STOP mode.

3 Connect the pump to AC 
mains adaptor, rechargeable 
battery pack, or press the 
On/Off key to turn off the 
pump and replace both 
disposable batteries with 
fresh AA batteries.

CAUTION:In the event 
that the internal batteries 
are removed while the 
pump is operating, the 
power loss event may not 
be logged in the history, 
the programmed therapy 
may not be retained, and 
the alarms (audible and 
visual) may not occur. 
Refer to the caution 
regarding Power Loss on 
page 14.

4 Power on the pump and 
resume the current program. 
Refer to Accessing the 
Program Menu in Section 2 
for more information.

5 Press [START] to begin 
infusion.
Note: In case of low battery 
alarm during printing, replace 
the batteries and reprint
or
Plug in AC main and reprint.

Alarm Display 
Message

Is the 
pump 
infusing?

Alarm Cause/
Condition

Remedy

Y = Yes
N = No

A = Audible alarm
V = Visual alarm
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POWER LOSS N A/V The pump has 
detected a power 
failure due to one of 
the following:

• Batteries have 
been removed 
while the pump 
was on battery 
source.

• External power 
has failed or has 
been 
disconnected and 
no batteries are 
installed.

• Pump has been 
powered on with 
insufficient power 
source.

1 Connect the pump to AC 
mains adaptor, rechargeable 
battery pack, or replace 
both disposable batteries 
with fresh AA batteries.

2 Power-on the pump and 
resume the current program. 
Refer to Accessing the 
Program Menu in Section 2 
for more information. Review 
the program if required.

3 Press [START] to begin 
infusion.

CAUTION: Ensure two 
fresh, disposable AA 
batteries are installed 
for backup power when 
using other power 
sources (e.g., AC mains 
adaptor, docking 
station, battery pack). 
The pump will continue 
to operate on backup 
power if the external 
power source fails. Refer 
to the caution regarding 
Power Loss on page 14.

Alarm Display 
Message

Is the 
pump 
infusing?

Alarm Cause/
Condition

Remedy

Y = Yes
N = No

A = Audible alarm
V = Visual alarm
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PROX. OCCLUSION N A/V The pump has 
detected sustained 
negative pressure on 
its proximal side.

1 Press [SILENCE] to quiet 
the alarm for 1 minute.

2 Press [STOP] to place the 
pump in the stop mode.
WARNING: When a 
Proximal Occlusion alarm 
activates, DO NOT 
power-off the pump.

3 Check for sources of 
proximal occlusion: 
• Kinked tubing above pump
• Blockage in the container 

and in the spike
• Closed clamps above 

pump
• Empty container
• High torque syringe
• Other obstructions 

4 Remove obstructions.
5 Press [START] to begin 

delivery.
6 If the problem continues, 

ensure slide clamp or lower 
CAIR® clamp is open. 
Power-off the pump. 
Reinstall the cassette. Turn 
on the pump. 
Note: Ensure the tubing is 
behind the tubing guides (at the 
distal end).
CAUTION: Ensure all 
four cassette latches 
are clearly visible after 
the cassette is installed. 
Refer to Loading the Cassette 
on page 35

Alarm Display 
Message

Is the 
pump 
infusing?

Alarm Cause/
Condition

Remedy

Y = Yes
N = No

A = Audible alarm
V = Visual alarm
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USING BATTERIES Y V This is a normal 
response when:

• The pump has 
been powered on 
with only 
disposable 
batteries as a 
power source; or

• The pump has 
switched to 
internal power 
(disposable 
batteries) due to a 
loss of external 
power or a 
reduction in 
external power 
below acceptable 
levels.

When powering on the pump:

• Press [YES/ENTER] to 
confirm disposable batteries 
are the only power source.

When switching from AC mains 
power:

• Press [SILENCE] to clear the 
alarm.

CAUTION:Ensure two 
fresh, disposable AA 
batteries are installed for 
backup power when 
using other power 
sources (e.g., AC mains 
adaptor, docking station, 
battery pack). The pump 
will continue to operate 
on backup power if the 
external power source 
fails. Refer to the caution 
regarding Power Loss on 
page 14.

Alarm Display 
Message

Is the 
pump 
infusing?

Alarm Cause/
Condition

Remedy

Y = Yes
N = No

A = Audible alarm
V = Visual alarm
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USING EXT BATT Y V This is a normal 
response when:

• The pump has 
been powered on 
with external 
batteries as a 
power source; or

• The pump has 
switched to 
external battery 
power due to a 
loss of AC mains 
power; or

• The pump has 
switched to 
external battery 
power while 
running on 
internal batteries.

When powering on the pump:

• Press [YES/ENTER] to 
confirm external battery 
power source.

When switching from AC mains 
power:

• Press [SILENCE] to clear the 
alarm.

CAUTION:Ensure two 
fresh, disposable AA 
batteries are installed for 
backup power when 
using other power 
sources (e.g., AC mains 
adaptor, docking station, 
battery pack). The pump 
will continue to operate 
on backup power if the 
external power source 
fails. Refer to the caution 
regarding Power Loss on 
page 14

Alarm Display 
Message

Is the 
pump 
infusing?

Alarm Cause/
Condition

Remedy

Y = Yes
N = No

A = Audible alarm
V = Visual alarm
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Alert Messages

Alert Display Message Is the 
pump 
infusing?

Alarm Cause/Condition Remedy

Y = Yes
N = No

A = Audible alarm
V = Visual alarm

ALMOST EMPTY Y A/V Delivery will complete in 
30 minutes or less.

For bolus only program, 
delivery will complete 
during the next bolus 
delivery.

• Press [STOP] to clear 
the alarm and put the 
pump in STOP Mode.

• Press [SILENCE] to 
quiet the alarm.

• No additional alarms 
sound
Note: This alert is 
available only with 
Pain Management ther-
apy.

CHECK PRINTER Y A/V • The printer has not 
responded to 
commands from the 
pump.

• The printer is not 
properly connected to 
the pump.

1 Press [SILENCE] to 
quiet the alarm for 2 
minutes.

2 Ensure the printer is 
properly connected to 
the pump by checking 
the following:
• Printer is 
• powered on and in 

ONLINE mode.
• Cable is plugged in 

to both the pump 
and the printer.

• Cable part number 
and printer settings 
are correct.

3 If the problem 
continues, select 
STOP PRINT from 
the Print Menu to 
cancel all print jobs.
Hospira GemStar® System Operating Manual 145



Chapter 12. Troubleshooting

430-96527-002.book  Page 146  Wednesday, February 7, 2007  12:35 PM
EMPTY CONTAINER N A/V The pump has delivered 
the programmed 
container size or the 
pump has delivered the 
programmed VTBI; AND 
Auto KVO is delivering 
(if available in current 
program).

1 Press [SILENCE] to 
quiet the alarm for 2 
minutes.

2 Press [STOP] to place 
the pump in the 
STOP mode and 
clear the alarm.

3 Use the New 
Container function to 
repeat the current 
program. Refer to 
Starting a New 
Container in Chapter 2 
Basic Operation.
Note: Titration is 
allowed at this time.

END OF INFUSION

• The pump delivers 
KVO if selected.

N A/V The pump has delivered 
the entire programmed 
protocol.

If no KVO is selected:

1 Press [SILENCE] to 
quiet the alarm for 2 
minutes.

2 Press [STOP] to place 
the pump in the 
STOP mode and 
clear the alarm.

If KVO is selected:

1 The pump sounds 5 
beeps approximately 
every 15 minutes.

2 Press [STOP] to place 
the pump in STOP 
mode and clear the 
alarm.

Alert Display Message Is the 
pump 
infusing?

Alarm Cause/Condition Remedy

Y = Yes
N = No

A = Audible alarm
V = Visual alarm
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FLASHING DISPLAY

• Line four of the 
display flashes.

N A/V A Non-programming 
Callback has occurred 
because the pump has 
been waiting for more 
than three minutes for a 
keypress on a non-
programming input or a 
confirmation display.

Follow the instructions on 
the display to clear the 
alarm.

NO INTERNAL BATT
NO POWER LOSS

ALARM AVAILABLE
ENTER TO CONFIRM

N A/V No disposable batteries 
or dead disposable 
batteries; AND external 
power.

1 Press [YES/ENTER] to 
confirm.

2 Power-off the pump 
and install two fresh, 
disposable AA 
batteries as a backup 
power source.

CAUTION:Ensure 
two fresh, 
disposable AA 
batteries are 
installed for backup 
power when using 
other power sources 
(e.g., AC mains 
adaptor, docking 
station, battery 
pack). The pump 
will continue to 
operate on backup 
power if the 
external power 
source fails. Refer 
to the caution 
regarding Power 
Loss on page 14.

Alert Display Message Is the 
pump 
infusing?

Alarm Cause/Condition Remedy

Y = Yes
N = No

A = Audible alarm
V = Visual alarm
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PROGRAMMING 
INCOMPLETE

N A/V Programming has not 
been completed and no 
keys have been pressed 
within three minutes.

1 Press any key to clear 
the alarm.

2 Complete the program 
entries.

START

• START flashes on 
the display. Other 
parts of the display 
are not affected.

N A/V A Stop Mode Callback 
has occurred because the 
programmed pump has 
remained in the STOP 
mode for more than three 
minutes.

1 Press [SILENCE] to 
quiet the alarm for 3 
minutes.

2 Follow the instructions 
on the display to clear 
the alarm.

Alert Display Message Is the 
pump 
infusing?

Alarm Cause/Condition Remedy

Y = Yes
N = No

A = Audible alarm
V = Visual alarm
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Other Display Messages

Other Display 
Message

Cause/Condition Remedy

KEYPAD LOCKED User has attempted to 
perform a function that has 
been locked out.

Unlock the keypad to access the 
desired function.

NOT ALLOWED
DURING INFUSION
PRESS STOP TO
HALT DELIVERY

User has attempted to 
perform a function that is 
not available in RUN mode.

• Press [STOP] to access the 
desired function.

• Press [YES/ENTER] to return to 
the RUN mode display.

ROUNDING

THE PUMP SOUNDS 
FOUR QUICK BEEPS 
AND DISPLAYS THE 
ROUNDED NUMBER.

The pump has rounded a 
number that was entered 
during programming. 

Press [YES/ENTER] to accept the 
rounded value and continue to the 
next step.

DOSE IN PROGRESS
NEW CONTAINER
NOT ALLOWED

User has attempted to 
access NEW CONTAINER 
function when it is not 
allowed.

1 Press [STOP].
2 Increase the container size to 

complete the dose.
3 Set NEW CONTAINER 

through the Change Menu.

INFUSED XXXX.X mL
NO START DELAY
PRESS START
TO INFUSE

The pump has not delivered 
any doses and there is no 
start delay.

Press [START] to infuse dose.

CANNOT CHANGE
CLOCK WHILE TIME
BASED DELIVERY
IS IN PROGRESS

User has attempted to 
change the clock during a 
time-based delivery.

1 Press [STOP].
2 Clear the program through the 

Change Menu.
3 Change the clock through the 

Options Menu.
4 Reprogram the pump.

PROGRAM EXCEEDS
MAX CONTAINER
SIZE. CHANGE

PROGRAM VALUES.

The VTBI + KVO volume 
resulted in a container size 
greater than the allowed 
value.

1 Press [HELP] to display the 
allowed values.

2 Change the program values.

THIS OPTION NOT
AVAILABLE WHILE 
PROGRAMMING THE

PUMP

User has attempted to 
access a function that is not 
available from the first 
programming display.

1 Press [YES/ENTER] to return 
to the first programming display.

2 Complete programming.
3 Access desired function.
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Chapter 13

Maintenance

Pump Storage
Store the GemStar® Pump in a cool, dry place. Remove the disposable batteries and 
the battery pack before storing the pump.

Program and event history are protected in the software memory for at least one year 
when power is removed from the pump.

Cleaning and Disinfecting
Establish a routine schedule for cleaning the pump to keep the case exterior, cassette 
pocket, and tubing channel free of contamination. 

CAUTION: To avoid mechanical or electronic damage, DO NOT immerse 
pump in any fluids or cleaning solutions.
Some cleaning and sanitizing compounds may slowly degrade 
components made from some plastic materials. DO NOTt use 
compounds containing combinations of isopropyl alcohol and 
dimethyl benzyl ammonium chloride.
DO NOT sterilize by heat, steam, ETO, or radiation. Apply 
disinfectants to the outside surface of the pump only. DO NOT use 
abrasive cleaners or materials on the pump. Using abrasive 
cleaners or cleaning solutions not recommended by Hospira may 
result in product damage.
To avoid pump damage, cleaning solutions should be used only as 
directed in the table on the following page. The disinfecting 
properties of cleaning solutions vary; consult the manufacturer for 
specific information.
NEVER use sharp objects (such as pens, pencils, fingernails, paper 
clips, needles, etc.) to clean the pump.

WARNING: DO NOT touch connector ports. Refer to caution on 
page 16.
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Recommended Cleaning Solutions
The pump is not adversely affected by the recommended cleaning solutions in the 
table below:

Cleaning the Pump Case
1 Power-off the pump.
2 Disconnect the pump from AC mains power.
3 Clean the exposed surfaces of the pump with a soft, lint-free cloth dampened with 

the appropriate cleaning solution.
4 Wipe the solution from the pump surface with a water-moistened, lint-free cloth. 
5 Use a dry, lint-free cloth to dry the pump after cleaning.

Cleaning Solution Manufacturer Preparation

Vesphene II se® Calgon Vestal 
Laboratories

Per manufacturer’s recommendation

Manu-Klenz® Calgon Vestal 
Laboratories

Per manufacturer’s recommendation

Formula C™ Diversey Corp. Per manufacturer’s recommendation

Household bleach

(5.25% sodium 
hypochlorite)

Various Per healthcare facility procedures; 
DO NOT exceed one part bleach in 
ten parts water

Note: NOT all cleaning solutions are disinfectants. Check product labeling.
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Cleaning the Cassette Pocket and Tubing Channel
The area containing the ultrasonic sensors, located in the cassette pocket, should be 
cleaned on a regular basis.

CAUTION: Use care not to damage the silicone seals around the sensor bodies.
1 Remove the cassette, if installed.
2 Use a cotton swab, moistened with an 

approved cleaning solution, to clean the 
sensor faces (A), tubing channel (B), 
plunger tip (C), and sensor pins (D).

3 Dry the sensor faces and tubing channel 
and ensure the sensor faces are free of 
detergent film and/or debris.

Repair
6 The GemStar® Pump has no user-serviceable components, with the exception of 

disposable batteries.
6 If the display clock stops working, contact Hospira Technical Support Operations 

to arrange for internal battery replacement.
6 Homecare Customers: Call your healthcare professional or homecare company 

regarding any required service or repairs. DO NOT attempt to repair the pump for 
any reason.

6 The GemStar® Pump is covered by a manufacturer’s warranty for one year after 
purchase. During this time, opening the pump case for any reason voids this 
warranty. Refer to Chapter 18 Warranty/Technical Assistance, page 199 for 
details.

6 Refer all service to Hospira certified technicians only. A GemStar® Technical 
Field Service Manual is available to Hospira certified technicians.

C

D

A

B
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Chapter 14

Operation Test

This test is designed to ensure the GemStar® Pump is operating properly. Hospira 
recommends performing this test a minimum of once every 12 months. Refer to 
facility requirements to determine additional testing needs.

The test can be performed when the pump is in the STOP mode and requires 
approximately 15 minutes to complete. The pump provides step-by-step instructions 
through each section of the test. 

Equipment Required
6 GemStar® Pump

6 Two GemStar® Microbore Pump Sets without a filter
6 Reservoir with at least 50 mL of water
6 20+ mL or larger graduated cylinder (graduated in 0.1 mL)
6 Two fresh, disposable AA batteries

6 Appropriate GemStar® AC mains adaptor or other Hospira approved external 
power source

Note: This test is available only when the pump is UNLOCKED.

WARNING: Disconnect the pump from the patient BEFORE 
performing the Operation Test.
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Test Setup 

1 Connect the external power source and install two fresh, disposable AA batteries.
2 Power-on the pump.
3 Press [OPTIONS].
4 Select HISTORIES from the Options Menu.
5 Select OPERATION TEST from the Histories Menu. 
6 Follow the instructions on the display.

Performing the Operation Test 

Case Inspection
1 Visually inspect the case and keypad for damage. Check the case for missing 

screws, or labels.
2 Enter the results:

• If the pump is free of damage and all the screws and labels are in place, press 
[YES/ENTER]. 

• If damage is found on the case or keypad, or any screws or labels are missing, 
press [NO].

Note: The pump clears any program and shift totals stored in pump memory before 
starting the Operation Test.

Tip: The checklist at the end of this section may be copied to record test results.
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Cassette Pocket and Latch Inspection
1 Visually inspect the cassette pocket and the sensors (A). Verify that they are free 

of dirt and residue.
2 Verify that the four cassette latches (B) are present. Verify that they open and 

close when the cassette release button is pressed.
3 Verify that the plunger seal (C) and sensor seals (D) are present and intact.
4 Verify that the plunger (E) is not scraped or damaged.
5 Verify that the sensor pins (F) are not damaged.
6 Install the cassette. Verify that the cassette fits smoothly and securely.
7 Enter the results:

• If the cassette pocket area and latches are free of damage, and ALL of the 
above steps are verified, press [YES/ENTER].

• If damage is found, or ANY of the above steps cannot be verified, press [NO].

B

E C

B

F

F

D

A
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Power Check

1 The display indicates that an external power source and batteries are connected. 
Press .

2 Remove battery door and press . The display indicates that only external 
power is connected. Press .

3 Return the battery door to the closed position.
4 Disconnect the external power source and press .
5 The display indicates that only batteries are connected and displays the test 

results. Press .
6 If the pump fails, reconnect the external power source and press  to rerun the 

test, or press [YES/ENTER] to confirm failure.

Keypad Test
1 Press each key, including the Bolus Button. Press [YES/ENTER] last.
2 Enter the results: 

• If each key makes an audible tone, press [YES/ENTER].
• If any key does not make an audible tone, press [NO]. 

Display Test
1 Press [YES/ENTER] when prompted. The display fills with solid boxes for 

approximately 10 seconds. To view the solid boxes for another 10 seconds after 
the display times-out, press .

2 Enter the results:
• If the display fills with solid boxes, press [YES/ENTER].
• If the display does not fill with solid boxes, press [NO].

Tip: Opening the battery compartment door will disconnect the batteries enough for 
the pump to recognize external power. Then the door can be tightened and testing 
can continue. This can save time when performing multiple tests on a group of pumps.
158 Hospira GemStar® System Operating Manual 



Chapter 14. Operation Test

f

430-96527-002.book  Page 159  Wednesday, February 7, 2007  12:35 PM
LED Test
1 Verify that both the Power (green) and Alarm (red) LEDs are lit. Refer to 

GemStar® Pump Layout on page 2 for the location of the LEDs.
2 Enter the results:

• If both LEDs are lit, press [YES/ENTER].
• If either of the LEDs does not light, press [NO].

3 Ensure slide clamp is open prior to inserting cassette.

Volume Accuracy Test
The pump should deliver between 19.0 to 21.0 mL within approximately 3 minutes to 
pass this test.

1 Ensure slide clamp is open prior to inserting cassette.
2 Load a primed pump set into the pump. Press .
3 Place the proximal end in the reservoir of water. Press .
4 Place the distal end in a 20+ mL graduated cylinder. Press .
5 Press [START].
6 Enter the results:

• If the pump delivers between 19.0 to 21.0 mL, press [YES/ENTER].
• If the pump does not deliver between 19.0 to 21.0 mL, press [NO].

Tip: Use two microbore pump sets to save time during the next four tests. The first 
set should be fully primed BEFORE beginning the volume accuracy test. Use a 
second, DRY set for the air-in-line test. 

When the proximal occlusion test is complete, remove the WET set from the pump 
and insert the DRY set. Press [START] to begin the air-in-line test. The WET set can 
then be placed in the next unit ready for testing.
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Distal Occlusion Test
The occlusion should occur within approximately 30 seconds to pass this test.

1 Clamp the pump set 10 to 12 inches (25.4 to 30.5 cm) below the cassette.
2 Press [START].
3 The test result displays. Release the clamp and press .

• If the test is passed, the pump advances to the next test. 
• If the test is failed, clean the sensors and press  to rerun the test or press 

[YES/ENTER] to confirm failure.

Proximal Occlusion Test
The occlusion should occur within approximately 30 seconds to pass this test.

1 Clamp the pump set above the cassette.
2 Press [START].
3 The test result displays. Press .

• If the test is passed, the pump advances to the next test.
• If the test is failed, clean the sensors and press  to rerun the test or press 

[YES/ENTER] to confirm failure.

Note: Clean the sensor pins before repeating the distal occlusion test. Refer to 
Chapter 13 Maintenance for instructions.

Note: Clean the sensor pins before repeating the proximal occlusion test. Refer to 
Chapter 13 Maintenance for instructions.
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Air-in-line Test
The air-in-line alarm should occur within approximately 1 minute to pass this test.

1 Ensure slide clamp or lower CAIR® clamp is open prior to inserting cassette.
2 Release the clamp.
3 Remove the proximal end of the pump set from the reservoir. Press .
4 Press [START].
5 The test result displays. Press .

• If the test is passed, the pump advances to the next test. 
• If the test is failed, clean the sensors and press  to rerun the test or press 

[YES/ENTER] to confirm failure.

Printing Test Results 
When the test is complete, the pump displays an option to print the test results. If 
desired, follow the steps below to print the test results. An example of the printed test 
results is shown.

1 Connect the serial printer cable to the pump. Refer to Connecting to the Seiko 
Printer  in Chapter 10 Options Menu, on page 125.

2 Press [YES/ENTER] to print the test results.
3 The pump displays the Programming Menu when the results have finished 

transmitting or if [NO] is pressed.

Note: Clean the sensor faces before repeating the air-in-line-test. Refer to Chapter 13 
Maintenance for instructions.

WARNING: Refer to the printer documentation or contact the printer 
manufacturer for more information regarding 
Electrostatic Discharge (ESD) susceptibility of printer 
connector ports.

Note: For maximum battery life, operate the pump on AC power when connected to a 
printer or computer.
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GemStar®

Operation Test Checklist

Pass Fail

Case Inspection

Cassette Pocket and Latch Inspection

Power Check

Keypad Check

Display Test

LED Test

Volume Accuracy Test

Distal Occlusion Test

Proximal Occlusion Test

Air-in-line Test

Printed Test Results

Serial Number:

Verified By: Date:
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Chapter 15

Optional System Components

All GemStar® Optional System Components are composed of latex-free components 
only. All GemStar® Optional System Components are sold separately.

Product Description List # Description

GemStar® 
AC Mains Adaptor
(110 Volts - USA)

13026-01 Wall-mount adaptor plugs into a 110 VAC 
mains supply to power the GemStar® Pump. 6 
ft (1.8 m) cord. 

GemStar® 
AC Mains Adaptor
(100 – 240 Volts - 
Universal)

13026-03 Universal, wall-mount adaptor plugs into a 
100 – 240 VAC mains supply to power the 
GemStar® Pump. 6 ft (1.8 m) cord. 

GemStar® 
AC Mains Adaptor 
(100 – 240 Volts - 
Universal)

13072-01 Tabletop adaptor plugs into a 100 – 240 VAC 
mains supply to power the GemStar® Pump.

GemStar® 
Bolus Cord

13027-01 Allows bolus requests to be made up to 6 feet 
(1.8 m) from the pump.

GemStar® 
Pole Clamp

13076-01 Attaches the GemStar® Pump to an I.V. pole. 
The clamp is mounted to the track on the 

back of the pump. Press the release button to 
remove the pump.

GemStar® Locking 
Pole Clamp

20207-01 GemStar® locking pole clamp.

GemStar® Battery 
Pack
(Li-Ion)

13073-03 The rechargeable Li-Ion batteries power the 
GemStar® Pump during periods of transport or 
when use of AC power is not desirable. The 
battery pack is recharged using a GemStar® 
AC mains adaptor.
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GemStar® Universal 
Lockbox 

12499-01 Locks the GemStar® Pump and up to a 250 
mL flexible I.V. container or 30 mL PCA vial in 
a plastic enclosure. The lockbox can be 
attached to an I.V. pole using the GemStar® 
Pole Clamp (available separately). 

GemStar® Lockbox 
with Spring Assist 
Mechanism (SAM)

20706-01 Locks the GemStar® Pump and a 30 mL PCA 
vial in a plastic enclosure. The lockbox can be 
attached to an I.V. pole using the GemStar® 
Pole Clamp (available separately). 

GemStar® 250 mL 
Lockbox 

13024-01
(not 
available 
for sale)

Locks the GemStar® Pump and up to a 250 
mL flexible I.V. container in a plastic 
enclosure. The lockbox can be attached to an 
I.V. pole using the GemStar® Pole Clamp 
(available separately).

GemStar® 30 mL PCA 
VIal Lockbox 

13077-01 
(not 
available 
for sale)

Locks the GemStar® Pump and a 30 mL PCA 
vial in a plastic enclosure. The lockbox can 
be attached to an I.V. pole using the 
GemStar® Pole Clamp (available separately).

Hospira Carrying 
Case - 250 mL

13594-01 Soft-sided carrying case can be worn around 
the waist to hold the GemStar® Pump and up 
to a 250 mL flexible container.

Hospira Carrying 
Case - 500 mL

13079-01 Soft-sided carrying case can be worn around 
the waist or over the shoulder to hold the 
GemStar® Pump and up to a 500 mL flexible 
container.

Hospira Carrying 
Case - 1000 mL

13980-01 Soft-sided carrying case can be worn around 
the waist or over the shoulder to hold the 
GemStar® Pump and up to a 1000 mL flexible 
container. 

Hospira Carrying 
Case - 3 Liter

13593-01 Soft-sided carrying case can be worn around 
the waist or as a backpack to hold a 3 liter or 
smaller flexible container and the GemStar® 

Pump with batteries or battery pack. Includes 
List 13590-01.

Hospira 3 Liter Carrier 13590-01 Interior support for the Hospira Carrying Case 
- 3 Liter.

Product Description List # Description
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GemStar® Docking 
Station (Li-Ion)
(100 – 240 Volts)

13075-03 Plugs into a 100 – 240 VAC Volt mains supply 
to power the GemStar® Pump while mounted 
on an I.V. pole. During periods of transport, an 
internal rechargeable battery pack powers the 
pump for up to 16 hours at a rate of 125 mL/hr 
or less. When the AC mains supply is 
attached, the internal batteries are recharged 
in approximately 
6 hours. 10 ft. (3 m) cord.

GemStar® 
Serial Cable

13078-01 Connects the GemStar® Pump to a 
compatible serial printer or computer to 
download the event history, program, or 
speed protocol information.

GemStar® Connect 
Clinician Kit

13048-01 Allows remote access from a clinician’s 
computer to a GemStar® Pump. The Kit 
includes a modem, phone cable, serial cable, 
and GemStar® Connect software.

GemStar® Connect 
Patient Kit

13049-01 Use with the GemStar® Connect Clinician Kit 
to allow remote access to a GemStar® Pump. 
The Patient Kit includes a modem, phone 
cable, and remote pump cable. 

GemStar® Triple Pole 
Clamp

13022-01 Not for use with a lockbox. Holds up to three 
GemStar® devices.

GemStar® Technical 
Field Service Manual

13000-38 Provides advance instructions for Hospira 
Certified Technicians.

GemStar® 
Configuration Guide

13000-97 Provides advance instructions for Biomed 
technicians.

GemStar® System 
Operating Manual

13981-01 Provides operating instructions for patients 
and caregivers.

Product Description List # Description
Hospira GemStar® System Operating Manual 167



Chapter 15. Optional System Components

d

430-96527-002.book  Page 168  Wednesday, February 7, 2007  12:35 PM
Connecting the Bolus Cord
(List 13027-01)

Connect the bolus cord to the port 
labeled “Bolus” on the bottom of the 
pump.

Using the GemStar® Lockboxes
The GemStar® Lockbox is an enclosure that can be locked with a key to secure the 
pump, and a flexible container or pre-filled vial. When the pump is secured in the 
lockbox, the user has access to the AC mains, data and bolus ports, keypad, and bolus 
button.

WARNING: DO NOT touch connector ports. Refer to caution on 
page 16.

WARNING: When removing the cord from the bottom of the pump, 
firmly grasp the connector and pull straight out. DO NOT 
twist or bend the cord or connector.

Note: For the GemStar® Universal Lockbox (List 12499-01) and GemStar® Lockbox 
with Spring Assist Mechanism (SAM) (List 20706-01) refer to the lockbox for 
instructions.
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30 mL PCA Vial Lockbox (List 13077-01)

1 Open the lockbox (A).
2 Flip the top door up (B).

3 Align the pump with the lockbox 
(C).

4 Slide the pump down into the 
lockbox until fully seated.

5 Flip the top door down.
6 Connect the pump set to the 

pre-filled vial and prime.
7 Place the pre-filled vial inside the 

lockbox (D).

8 Load the cassette (E).

CAUTION: Ensure all four 
cassette latches are clearly 
visible after the cassette is 
installed. Refer to Loading the 
Cassette on page 35.

9 Ensure the tubing will not be 
pinched when closing the lockbox.

10 Close and lock the lockbox.
11 Remove the key.

A

B

C

D

d
Note: Ensure the tubing is in the 
tubing guide (at the distal end).

E
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250 mL Lockbox (List 13024-01)

1 Open the lockbox (A).
2 Flip the top door up (B).

3 Align the pump with the lockbox 
(C).

4 Slide the pump down into the 
lockbox until fully seated.

5 Flip the top door down.
6 Connect the pump set to the bag 

and prime.
7 Place the flexible container inside 

the lockbox with the 
administrative port down (D).

8 Hang the bag on the hook inside 
the lockbox (E).

9 Ensure slide clamp is open prior to 
inserting cassette.

10 Load the cassette (F).

CAUTION: Ensure all four 
cassette latches are clearly 
visible after the cassette is 
installed. Refer to Loading the 
Cassette on page 35.

11 Ensure the tubing will not be 
pinched when closing the lockbox.

A

B

C

E

D

d
Note: Ensure the tubing is in the 
tubing guide (at the distal end).

F
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12 Close and lock the lockbox.
13 Remove the key. 

Removing the Lockbox
1 Remove the lockbox from the pole.
2 Unlock the lockbox.
3 Open the lockbox and flip the top door up.
4 Press the cassette release button to remove the cassette.
5 Lift the pump out of the lockbox.

Using the Hospira Carrying Cases
Ensure the administration set is fully primed and the cassette is properly loaded before 
placing the pump in the carrying case. Refer to Loading the Cassette on page 35 for 
more information.

Carrying Case - 250 mL (List 13594-01)

This soft-sided carrying case can be worn around the waist. It is designed to hold the 
GemStar® Pump and up to a 250 mL flexible fluid bag. 

1 Place the fluid bag in the 
zippered compartment (A) on 
the backside of the case. 
Ensure the bag spike is 
positioned so that the fluid 
flow is not restricted.
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2 Place the pump inside the front 
compartment (B) of the case.

3 Secure the tubing to the inside 
of the pack with the Velcro® 
tabs (C). Ensure the tubing is 
not kinked.

4 Use the large Velcro flap (D) on 
the upper left side of the case to 
secure the tubing on the outside 
of the case.

5 Close the zipper. Ensure the 
tubing exits the side of the case 
near the zipper tab when the 
zipper is closed (E).

6 Place the case around the waist. 
Snap the buckle together to 
secure. 

7 Adjust the belt for a snug, 
comfortable fit.

Carrying Case - 500 mL (List 13079-01) or 1000 mL (List 13980-01)

These soft-sided carrying cases can be worn around the waist or over the shoulder. 
They are designed to hold the GemStar® Pump and up to a 500 mL (List 13079-01) or 
a 1000 mL (List 13980-01) flexible fluid bag.

B
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E
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1 Place the pump on the inside front 
window (A). Ensure the keypad is 
facing the “window.”

2 Secure the pump with the large side 
straps (B) and (C). Then secure the 
top (D) and bottom (E) straps.

3 Place the fluid bag on the backside 
of the compartment (F).

4 Secure the bag with flaps (G) and 
(H).

5 Secure the bag spike with strap (I). 
Ensure the fluid flow is not 
restricted.

6 Use a “figure-8” pattern to wrap the 
tubing. Secure the tubing to the 
inside of the case with tabs (J) and 
(K). Ensure the tubing is not kinked.

7 Zip the case closed. Ensure the 
tubing exits through one of the sides 
near the zipper tab when the case is 
closed.
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8 Place the case around the waist with the front “window” facing away from the 
body. Snap the buckle together to secure. Adjust the belt for a snug, comfortable 
fit. 

Carrying Case - 3 Liter (List 13593-01)

This soft-sided carrying case can be worn around the waist or as a backpack. It is 
designed to hold the GemStar® Pump with batteries or a battery pack, and up to a 3 
liter flexible fluid bag.

Note: This carrying case includes an interior support (Hospira 3 Liter Carrier List 
13590-01) that may be removed from the case and used separately.
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1 Unzip the carrying case and release all Velcro straps and flaps.
2 Place the fluid bag on the carrying case as shown (A).
3 Hook top strap (B) through the hole in the top of the fluid bag and secure.
4 Fold small flaps (C) and (D) over the bag as shown and secure.
5 Secure straps (E) and (F) across the length of the fluid bag and over the small 

flaps.
6 Secure the spike connection with strap (G).
7 Fold large flaps (H) and (I) over as shown and secure.
8 Place the pump, with the keypad facing upward, inside the pocket (J) on the flap. 

The pump’s display should be visible through the opening on the front of the 
pocket.

9 Secure the pump with straps (K) and (L).
10 Secure the tubing with strap (M).
11 Place the secured pump (N) inside the large zipper case or other carrying case.
12 Zip the large case closed.
13 If desired, route the tubing through the loops on the bottom of the carrying case. 

Ensure the tubing is not kinked.
14 Adjust the shoulder straps and waist belt for a snug, comfortable fit. 

Tip: When not using the waist belt, secure it under the large flap on the back of 
the case.
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Using the GemStar® Docking Station
(List 13075 all codes)

CAUTION: Ensure two fresh, disposable AA batteries are installed for backup 
power when using other power sources (e.g., AC mains adaptor, 
docking station, battery pack). The pump will continue to operate on 
backup power if the external power source fails. Refer to caution 
regarding Power Loss on page 14.

To connect the pump:
1 Mount the docking station to the I.V. pole and tighten the knob. Install fresh 

batteries.
2 Align the connectors on the bottom of the pump with the connectors on the 

docking station. 
3 Slide the pump into the docking station until it snaps into place.
4 Connect the docking station to AC mains power.

To charge docking station:
1 Connect the docking station to the AC mains power.
2 Leave the Li-Ion Docking Station connected to AC mains power for at least 6 

hours when not in use or to recharge the docking station.

WARNING: DO NOT touch connectors. Refer to caution on page 16.

Note: The Li-Ion docking station light is yellow while the docking station is charging. 
When the docking station is charged or not charging, the light is green.
The Li-Ion docking station cannot be charged when the room temperature is greater 
than 104°F (40°C) or less than 41°F (5°C).
Hospira GemStar® System Operating Manual 177



Chapter 15. Optional System Components

430-96527-002.book  Page 178  Wednesday, February 7, 2007  12:35 PM
To connect the bolus cord and printer cable:

1 Plug the bolus cord into the bolus 
port on the rear, right side of the 
docking station.

2 Plug the printer cable into the 
printer port on the rear, right side 
of the docking station.

To remove the pump:
1 Press the release button on the top

of the docking station.

2 Slide the pump out.

WARNING: Ensure a cassette is installed in the pump before 
connecting to a printer or computer.

If the pump is connected to a patient: BEFORE 
connecting the pump to a computer or printer, press 
[STOP], close the slide clamp, and eject the cassette. 
Leave the pump set connected to the patient. Install 
another cassette in the pump before connecting to a 
printer or computer. 

DO NOT touch connector ports. Refer to caution on 
page 16.
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Chapter 16

Pump Sets

CAUTION: USE ONLY GemStar® Pump Sets with the GemStar® Pump. Use of 
unauthorized sets may result in injury to the patient or damage to 
the pump.

Contact a Hospira Representative for appropriate pump set configurations.

Fluid path and areas beneath undisturbed protective set covers are 
sterile and nonpyrogenic in the intact unit package.

The GemStar® Pump Sets, listed in the table on the following 
page are available for use with the GemStar® Pump.

Some microbore tubing delivery accuracy may be affected when used at extreme 
operating temperatures (<10°C, >35°C), relative humidity (<20%) and delivery rates 
(<4.9 mL/hr, >350 mL/hr). Refer to individual set labels for specific instructions and 
operating conditions.

The system may underdeliver, and the system delivery accuracy may be reduced by as 
much as 5% when using the following:

6 viscous fluids
6 nonvented syringes
6 PCA vials (except in a lockbox with a spring assist mechanism)
Delivery accuracy may be impacted when there is air present in the cassette. Follow 
the instructions in the individual set labels to remove any visible air from the cassette.

Note:  The disposable pump sets should be changed per the Centers for Disease 
Control (CDC) guidelines or health care provider policy. Discard after use.
All GemStar® Pump Sets are composed of latex-free components only.

GemStar® Pump Sets contain a pressure-activated anti-siphon valve to reduce the 
potential for gravity flow at a typical 36-inch head height.

S T E R I L E 2
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The following sets are a representation of the GemStar® Pump Sets currently 
available: 

List No. Description

Ambulatory Sets

13263 Latex-Free GemStar® Pump Set and Extension Set with Integral 
Pressure-Activated Anti-Siphon Valve, Secure Lock, Nonvented, Microbore 
Tubing, 96 in (244 cm)

13264 Latex-Free, LifeShield®, GemStar® Pump Set with 0.2 Micron Filter, Secure 
Lock, Prepierced reseal injection site, Nonvented, Pre-Attached 
Pressure-Activated Anti-Siphon Valve, Microbore Tubing, 96 in (244 cm)

13265 Latex-Free, LifeShield®, GemStar® Pump Set with 1.2 Micron filter, Secure 
Lock, Prepierced reseal injection site, Nonvented, Pre-Attached 
Pressure-Activated Anti-Siphon Valve, NonPhthalate (Non-DEHP) Microbore 
Tubing, 96 in (244 cm)

13273 Latex-Free GemStar® Pump Set, Secure Lock, Nonvented, Pre-Attached 
Pressure-Activated Anti-Siphon Valve, Microbore Tubing, 96 in (244 cm)

13612 Latex-Free, Lifeshield® GemStar® Primary Set with orange polyethylene-lined 
light resistant tubing, 3 inch segment clear PVC tubing, Pre-Attached 
Pressure-Activated Anti-Siphon Valve, Secure Lock, Nonvented, Microbore 
tubing, 96 inch (244 cm).

20634 GemStar® Pump Set with orange polyethylene-Lined Light Resistant Tubing, 3 
inch Segment of Clear PVC Tubing, 0.2 micron filter, CLAVE Port-SL, Attached 
Pressure-Activated Anti-Siphon Valve, Nonvented, 96 inch

Pain Management Sets

12640 Latex-Free, GemStar® Pump Set, Secure Lock, Nonvented Piercing Pin; And 
Extension Set with In-Line Pressure-Activated Anti-Siphon Valve, Y-Extension, 
Check Valve, Secure Lock, Microbore and Macrobore Tubing, 110 Inch (280cm)

13045 Latex–Free, GemStar® Pump Set, Integral Pressure-Activated Anti-Siphon 
Valve, Secure Lock, Nonvented with PCA injector and female Luer LockTM 

Adapter, Microbore tubing, 96 in (244 cm)
13047 Latex–Free, GemStar® Pump Set with PCA Extension, Integral 

Pressure-Activated Anti-Siphon Valve, Secure Lock, Nonvented with PCA 
Injector and Female Luer LockTM Adapter, Microbore Tubing, 96 in (244 cm)

13261 Latex-Free, GemStar® Pump Set and Extension Set with Integral 
Pressure-Activated Anti-Siphon Valve, Secure Lock, Nonvented, Microbore 
Tubing, Yellow Striped Tubing, 110 in (279 cm)
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20635 Latex-Free, GemStar® Pump Set, Yellow Striped Tubing, Secure Lock, Vented 
piercing Pin, 0.2 Micron filter, Microbore tubing,110 in Friction fit anti-siphon 
valve 

20704 Latex Free, GemStar® Pump Set with Injector, 2 Integral Pressure-Activated 
Anti-Siphon Valves, Secure Lock, Microbore Tubing, 99 inch (251 cm)

20705 Latex Free, GemStar® Pump Set with Injector, 2 Integral Pressure-Activated 
Anti-Siphon Valves and Y-Extension with Backcheck Valve, Secure Lock, 
Microbore Tubing, 97 inch (246 cm)

General Infusion Sets

13244 Latex-Free, GemStar® HEMA® II, Y-Type Blood Set, 210 Micron Filter, Lower 
CLAVE® Connector, Macrobore Tubing, 110 in (279 cm)

13267 Latex-Free, LifeShield®, GemStar® Primary Piggyback Pump Set, Secure Lock, 
Convertible, Macrobore Tubing Piercing Pin, 2 CLAVE® Connectors, 
Pre-Attached Pressure-Activated Anti-Siphon Valve, Macrobore Tubing, 110 in 
(279 cm) 

13272 Latex-Free, LifeShield®, GemStar® 150 x 60 Micro Drip SoluSet®, Option Lock, 
Convertible Piercing Pin, 2 CLAVE® Connectors, Macrobore Tubing, 110 in 
(279 cm)

13274 Latex-Free, LifeShield®, GemStar® Piggyback Pump Set, with 0.2 Micron Filter, 
Secure Lock, Convertible Piercing Pin, 3 CLAVE® Connectors, Pre-Attached 
Pre-Activated Anti-Siphon Valve, Macrobore Tubing, 110 in (279 cm)

List No. Description
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Chapter 17

GemStar® Pump Specifications

Physical The GemStar® Pump is composed of latex-free components 
only.

Dimensions: Height: 5.7 in. (14.5 cm)

Width: 3.8 in. (9.7 cm)

Depth: 2.0 in. (5.1 cm) 
Weight: Approximately 18 oz. (526 grams) excluding batteries 

Transport and Storage 
Environment

Store in cool and dry environment.

Ambient Temperatures: -4° F to +140° F (-20° C to +60° C)
Relative Humidity: 10% to 90%

Atmospheric Pressure: 0–10,000 ft. (0–3,000 m) equivalent pressure

Operating Environment
Ambient Temperatures: +41° F to +104° F (+5° C to +40° C)

Power Sources
AC Mains:

List 13026-01
(USA) complies with UL544

Wall-mount AC mains adaptor; 6 ft. (1.8 m) cord molded plug
Input: 110 VAC
Output: 3.0 VDC

List 13026-03
(Universal) complies with CSA 22.2

N0 601.1 and IEC/UL 60601-1

Wall-mount AC mains adaptor; 6 ft. (1.8 m) cord molded plug
Input: 100-240 VAC
Output: 3.0 VDC

List 13072-01
(Universal) complies with CSA 22.2

N0 601.1 and IEC/UL 60601-1

Tabletop AC mains adaptor; molded plug
Input: 100–240 VAC
Output: 3.0 VDC

Battery:

Battery Pack:
List 13073

Two disposable AA alkaline batteries

Rechargeable (using GemStar® AC mains adaptor) 
Lithium-ion rechargeable battery
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Docking Station:
List 13075-03:

Mounts on an I.V. pole; 10 ft. (3 m) cord
Input: 100–240 VAC
Output: 3.0 VDC
Internal lithium ion rechargeable battery

Power Capacity Using two fresh, disposable AA batteries or a charged battery 
pack, at temperatures between 59° F and 95° F (15° C and 
35° C), the pump is capable of delivering approximately:

96 hours at rates below 5 mL/hr
48 hours at rates at or above 5 mL/hr but below 25 mL/hr
24 hours at rates at or above 25 mL/hr but below 125 mL/hr
3000 mL at a rate of 125 mL/hr or higher

Pump Mechanism Volumetric, Piston Driven

Memory Protection Current program and 400-event (history) log protected by 
internal battery-backed memory for at least one year after 
power is removed

Operating Controls One 23-key keypad; bolus, data port, and AC mains jacks; 
bolus button

External Power LED Green LED marked with plug icon lights continuously when 
pump is connected to AC mains power
Green LED flashes when pump is connected to external 
batteries

Alarm LED Red LED marked with alarm icon lights during alarm 
conditions

Audible Alarm The audible alarm is user-adjustable from the maximum 
volume down to silent

The alarm cannot be turned off completely. The alarm 
automatically reverts to the maximum volume if the user does 
not respond within one minute

Display Backlit, four-line-by-sixteen-character alphanumeric graphics 
display

Backlight on AC: Continuous
Backlight on Batteries: Continuous during programming, program review, and history 

display; otherwise activated by keypress or alarm; not 
activated by bolus request

Real Time Clock Accuracy of ±5 minutes per month or better at temperatures 
between 59° F and 95° F (15° C and 35° C)
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Print Function 
Port & Interface: RS-232 serial interface port (data port), minimum baud rate of 

2400, isolated circuit
Printers: Seiko DPU 414 or compatible serial printer

System Accuracy
Continuous: ± 10% for rates of 0.1 mL to less than 5 mL/hr

± 5% for rates of 5 mL to 1000 mL/hr

Air Sensitivity
ON: Pump alarms at approximately 0.5 mL of air

Alarms for any bubble greater than 500 microliters with 
a tolerance of 200 microliters

2 mL: Pump alarms at approximately 2 mL of air

Alarms when pump detects 2.0 +1.0/-0.2 mL of air in 6 
mL of total volume delivered

OFF: Alarm is not activated

Recommend using air-eliminating filter when Air 
Sensitivity is set to OFF

Occlusion Sensitivity
Distal Occlusion: Alarms when pump detects distal pressure within a selectable 

range:
Low: 7 psi (48 kPa) ± 5 psi (±34 kPa)
Medium: 12 psi (83 kPa) ±8 psi (±55 kPa)
High: 26 psi (179 kPa) ±14 psi (±96 kPa)

Proximal Occlusion: Alarms when pump detects proximal pressure less than or 
equal to -4 psi (-28 kPa) 

Pump Self-Tests and Safety 
Features

Self-test performed when the power switch is activated

Diagnostic routine, including motor speed and air-detection 
monitoring, is repeated continuously while the pump is 
powered on

Error and alarm conditions are indicated by both audible and 
visual alarms; delivery in progress is stopped, if appropriate 
(refer to Chapter 12 Troubleshooting)
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Occlusion Information

Avoiding Bolus Infusion After Occlusion 
1 Press [STOP].
2 Close the distal slide clamp or lower CAIR® 

(roller) clamp.

3 Press the cassette release button to eject the 
cassette from the pump.

4 Press down on  to open the flow stop.
5 Wait 10 seconds. 

6 Press down on  to close the flow stop.

7 Ensure slide clamp or lower CAIR® clamp is 
open prior to inserting cassette.
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8 Load the cassette.

CAUTION:Ensure all four cassette latches 
are clearly visible after the cassette is 
installed. Refer to Loading the Cassette on 
page 35.

 

9 Review the program. Press  to begin review.
10 Press [START] to start the pump.

Note: Ensure the tubing is behind the 
tubing guide (at the distal end).
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Stored Occlusion Volume

Delivery Rate Accuracy
The following trumpet curves represent the typical flow rate deviations, both positive 
and negative, from the programmed flow rate under test conditions defined by 
International Electrotechnical Commission (IEC) Standards for infusion pumps. 
Using these curves, the medical professional may determine if the device can be 
expected to perform in a manner suitable for the drug or fluid to be infused. The pump 
sets used in this test are comparable to GemStar® Pump Set List 13273.
The typical accuracy for this device is ± 5% of the programmed rate for most 
conditions, after a period of normalization. It is recommended that the medical 
professional refer to the following curves when making decisions regarding drug and 
fluid administration.
A single fault condition occurs when a single means for protection against a safety 
hazard in equipment is defective or a single external abnormal condition is present.
The maximum over-infusion volume from a single fault condition is based upon the 
calculation of the maximum time to generate an alarm times the maximum rate 
possible (1000 mL/hr) as a consequence of the fault. This has been determined not to 
exceed 2.78 mL.

Delivery Rate of 25 
mL/hr at 

Pressure Limit Stored Volume
in mL

Time to 
Occlude

in seconds

Pressure Setting: Macro Micro Macro Micro Macro Micro

Low 7 psig 
(48.3 kPa)

7 psig
(48.3 kPa)

0.26 0.09 50 15

Medium 14 psig 
(96.5 kPa)

13 psig
(89.6 kPa)

0.54 0.14 96 23

High 32 psig
(220.6 
kPa)

30 psig
(206.8 
kPa)

1.24 0.40 254 83
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CAUTION: The system may underdeliver, and system delivery accuracy may 
be reduced by as much as 5% when using the following:
• viscous fluids
• nonvented syringes
• PCA vials (except in a lockbox with a spring assist mechanism)
Some microbore tubing delivery accuracy may be affected when 
used at extreme operating temperatures (<10°C, >35°C), relative 
humidity (<20%) and delivery rates (<4.9 mL/hr, >350 mL/hr). 
Refer to individual set labels for specific instructions and operating 
conditions.

Trumpet Curves
The Trumpet Curve Graphs following the Example show representative maximum 
and minimum percent flow rate deviation from the programmed rate over time. This 
information was developed in accordance with IEC 60601-2-24: 1998, Sub-Clause 
50.102. Refer to this standard for detailed information.
How to read a Trumpet Curve Graph (Refer to example on the following page): 
The graphs following the Example plot flow rates at 30 second intervals for the first 2 
hours and for the 96th hour of delivery. The graph plots mean delivery rate error 
(Average of 3 pumps) for the 2nd hour and the 96th hour as a straight line. The graph 
also presents maximum and minimum average delivery rate error for this interval 
plotted by averaging delivery errors over intervals of 2, 5, 11, 19 and 31 minutes 
(“Trumpet Curve”).

Example
From the Trumpet Curve Graph sample that follows, find the 5 minute interval (A) at 
the horizontal axis and read the corresponding points (B) and (C) on the vertical axis. 
The values are approximately +2.8% and -0.5%.
This means that at the rate of 25 mL/hr the average maximum flow rate fluctuation for 
any 5 minute time interval during the 2nd hour of operation was within the limits of 
+2.8% and -0.5% from the nominal rate. The average delivery rate error over the 
entire 2nd hour was +1.6% (D).
For other time intervals look at other points at the horizontal axis and determine 
corresponding limits as above.

Note: False occlusion alarms and fluid delivery inconsistencies may occur when 
pumping viscous fluids in microbore tubing at rates greater than 500 mL/hr.
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A trained professional can use the resulting graphs to select a pump with the 
appropriate startup and flow characteristics to suit the clinical application.

Note: As an example of how the trumpet curves can be used, consider the maximum 
and minimum deviations at the 5 minute average interval. The upper curve provides 
the maximum expected delivery rate error over a 5 minute interval, the lower curve 
provides the minimum expected delivery rate error over a 5 minute interval. An 
example would be Dopamine administered at 5 mcg/kg/min. At 5 minutes, the average 
drug delivery error would be within the range of +2.8% and -0.5% of the expected 
nominal rate.
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FLOW RATE
25 mL, 0mm Hg Delivery Head, 96 Hour
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15.0%15.0%
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FLOW RATE
25 mL, -100mm Hg Delivery Head, Start Up
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FLOW RATE
25 mL, +100mm Hg Delivery Head, Start Up
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FLOW RATE
25 mL, 0mm Hg Delivery Head, -20 in H20 Filling Head, Start Up

Time (minutes)
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-10.0-10.0

PERCENT ERROR
25 mL, 0 mm Hg Delivery Head, -20 in H20 Filling Head, Start Up
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Fl
ow

 R
at

e 
Va

ria
bi

lit
y 

(%
)

0 50 5 1010 1515 2020 2525 3030
-15.0%-15.0%
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15.0%15.0%
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Chapter 18

Warranty/Technical Assistance

The GemStar® Pump has been carefully manufactured using high-quality 
components. It is warranted to be free from defects in material and workmanship for a 
period of one year from the date of purchase under normal use and service. The 
warranty on the optional battery pack and other accessories is limited to 90 days.

On return to Hospira, the pump will be repaired or replaced within the terms of this 
warranty. Material returned to Hospira must be properly packaged and sent freight 
prepaid.

This warranty shall not apply if the pump has been repaired by anyone other than 
Hospira qualified service personnel; or altered in any way which, in Hospira’s 
judgment, affects its stability or reliability; or if the serial number has been altered, 
effaced, or removed.

THIS WARRANTY IS IN LIEU OF ALL OTHER WARRANTIES, EXPRESS OR 
IMPLIED.
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For customer service within the United States, contact:

1-877-9HOSPIRA (1-877-946-7747)

For technical assistance and product return authorization within the United States, 
contact:

1-800-241-4002

For additional technical assistance, including Technical Service Bulletins, technical 
training, and product information, visit the web site at:

www.hospiraparts.com

After authorization, ship prepaid product returns to the following address:

Hospira, Inc.
Technical Support Operations

755 Jarvis Drive
Morgan Hill, CA 95037

Note: Outside the U.S, contact your local Hospira sales office.
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Appendix A:

Electrical Potentials

There is a shared responsibility between manufacturers, customers, and users to ensure that 
Medical Equipment and Systems are designed and operated as intended. Medical electrical 
equipment needs special precautions regarding electromagnetic compatibility and needs to be 
installed and used according to the electromagnetic compatibility information provided in this 
manual.

Guidance on EMC Compatibility
This device uses RF energy only for its internal functions. Its RF emissions are very low and 
are not likely to cause any interference in nearby electronic equipment.

The device is suitable for use in all establishments, including domestic establishments. If 
extended operation during power mains interruption is needed, use the battery pack or the 
docking station’s internal battery.

Always manage the electromagnetic environment. The guidance included in this manual 
provides information needed to:

6 Determine the device’s suitability for use in the intended environment.
6 Manage the electromagnetic environment to permit the device to perform as intended 

without disturbing other equipment.
Separate the device from all other electronic equipment. If the device must be used near other 
electrical equipment, monitor the equipment to ensure there is no electromagnetic interference.

Devices should not be used adjacent to or stacked with other equipment. If the device must be 
used adjacent to or stacked with other equipment, monitor the devices to verify normal 
operation.

USE ONLY components specifically labeled for use with the GemStar® Infusion System to 
help ensure the device operates as intended.

If you suspect external RF sources or other equipment are influencing device operation, 
contact the biomedical engineering department for additional guidelines concerning 
electromagnetic immunity.

Portable, mobile RF communications equipment (including cellular phones), and stationery RF 
devices (i.e., microwave ovens) can affect the operation of medical electrical equipment. 
Cellular phones should be turned off within 10 feet of all electronic medical devices. Other RF 
equipment should be used no closer to any part of the device, including all cables, than 
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required. Monitor the devices to verify normal operation.

Contact the biomedical engineering department for additional information in the technical 
service manual concerning operating devices near RF sources. 

Information Regarding Electrostatic Discharge (ESD)
Electrostatic discharge is a transfer of electric charge between bodies of different electrostatic 
potential in proximity or through direct contact. For example, an electrostatic discharge might be 
observed when exiting a car on a very dry day. After exiting the car and then touching the car 
door, electrostatic discharge can often be felt and seen. Discharging one's body by touching the 
door with the car key will effectively eliminate these effects.

Electrostatic discharge can damage electronic equipment. At a minimum, all staff using the 
device, including clinical/biomedical engineering and healthcare staff, should read and adhere 
to the precautionary procedures below.

Precautionary Procedures
One of the most common causes of electrostatic damage to electronic devices is the direct 
transfer of electrostatic energy from the human body to the electrostatic discharge sensitive 
electronic equipment. 

6 DO NOT touch any connectors with fingers or any hand-held metal object unless proper 
precautionary procedures have been followed.

6 Methods to prevent build-up of electrostatic charge should be employed. The use of air 
conditioning and/or humidification, conductive floor coverings, and non-synthetic 
clothing is recommended during use or servicing of the device. 

6 It is recommended that the device be used in areas that have wood, concrete, or ceramic 
tile flooring. If floors are covered with synthetic material, the relative humidity should be 
at least 30%.

6 To reduce the potential of damage from ESD:
6 Touch the frame of the device, earth, or a large metal object to discharge one's body.
6 Use a grounding wrist strap prior to touching connectors.
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Index

Numerics
1-hour dose limit, 61
4-hour dose limit, 61

A
AC mains

power connector, 4
power indicator, 3
Pump Specifications, 183
regarding handling and maintenance, 14
regarding pump operation, 14
warnings and cautions, 15

AC mains adaptor
connecting to, 22
warnings and cautions, 15

administration set. See pump set
air sensitivity, 85, 93, 117

regarding air-in-line infusion, 13
specifications, 185

air-in-line alarm, 11
air-in-line, alarm, 13

test of, 161
alarm messages, 136–144
alert messages, 145–148
anti-siphon valve, 13, 33, 34
Auto KVO, 5

in mL/hr Only therapy, 95
in Weight Dosed therapy, 87

Auto Taper Down
in TPN therapy, 56
See also taper down; taper up

auto tapering. See Auto Taper Down; taper 
down; taper up

B
backcheck valve, 79, 80, 96, 97
BACK-UP key, 3, 31, 112
base rate, 102, 103, 104
Basic Operation, 19
batteries, 125

alarm messages, 137–144
battery compartment, 4
battery pack connector, 4
installing disposable batteries, 21
maintenance, 151
power check, 158
specifications, 183
using the rechargeable battery pack, 23
warnings and cautions, 14, 17

battery pack
charge, 24
connect, 24
release, 24

baud rate, 185
configuration settings for the Data 

Port, 123, 127
switch settings for Seiko printer, 124

bolus, 5, 10, 64
bolus button, 4
bolus delivery, 62–63
bolus dose interruptions, 63
clinician instructions, 130, 131
connecting the bolus cord, 168
history, 108
occlusion information, 186
optional system components, 165
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in Pain Management therapy, 59–63
print, 108, 119
in Variable Time therapy, 101, 104
1-hour or 4-hour dose limit, 61

C
call back alarm, 69
carrying cases

using the Hospira carrying 
cases, 171–176

cassette, 33
cassette pocket, 4
cassette release button, 4
cleaning of, 151–153
error message, 138
inspection of, 157
loading, 35
loading the cassette, 35
releasing the cassette, 36
warnings and cautions, 13

Change History, ii
CHANGE key, 3, 31
Change Menu, 8
charging battery pack, 24
clinician instructions, 129–133

adding a second lock level, 131
locking the pump, 130
program and deliver a clinician activated 

loading dose, 132–133
unlocking the pump, 132

configuration settings, data port, 123
connect battery pack, 24
connect pump, 25
connecting the bolus cord, 168
connecting the GemStar® AC mains 

adaptor, 22
connecting to a computer, 126

See also Data Port
connecting to the Seiko printer, 125

See also Data Port

continuous delivery
in Pain Management therapy, 59–65
in TPN therapy, 53, 56

Continuous therapy, 5, 77–83
changing a Continuous Program, 82
Clinician instructions, 130, 131
features and specifications, 77
piggybacking in Continuous 

therapy, 79–82
programmable ranges, 83
programming of, 77
Programming Worksheet, 83
rate titration, 79

continuous therapy
programming, 78

contraindications for use, 11

D
Data Port, connecting to, 122–126

configuration settings, 123
connecting to a computer, 126
connecting to the Seiko printer, 125
connector, 4

distal end, 33, 38, 159
distal occlusion, 6, 116

alarm message, 139
occlusion sensitivity, 185
occlusion sensor setting, 117
test of, 160
troubleshooting, 139

docking station, 167
charge, 26
connecting the pump, 177
to charge, 177
using, 177

dose limit, 61
drip chamber

priming pump sets with a drip 
chamber, 41
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priming pump sets with a drip chamber 
using the PURGE Key, 44

E
electrical potentials, 201
EMC compatibility, 201
ESD, 202

precautionary procedures, 202
event log, 6

history, display, 110
print, 108

F
flow stop, 33, 36, 37, 39, 41, 44, 47, 49, 186
Full Lock, 114

lock level functions, 115
locking the pump, 130
unlocking the pump, 132

G
GemStar® Docking Station, 25

connect pump, 25
GemStar® pump components, 4
GemStar® pump features, 6
GemStar™ infusion system layout, ??–3

H
handling

warnings and cautions, 16
HELP key, 3, 9, 31, 111, 133, 135
HELP mode, 9
history, 6, 62, 64, 108, 110, 151

display bolus history, 113
display, clear history, 112
print, bolus history, 108, 119

I
infusion system layout, ??–3
Intermittent therapy, 5, 69–75

changing an Intermittent therapy, 74

changing the start time, 108
delivery interruptions, 72–73
features and specifications, 69
Next Dose function, 121
programmable ranges, 75
programming of, 70–71
Programming Worksheet, 75

K
Keep Vein Open. See KVO; Auto KVO
KVO, 5

in Continuous therapy, 77
in Intermittent therapy, 69, 75
in mL/hr Only therapy, 95
in TPN therapy, 53
in Variable Time therapy, 101
in Weight Dosed therapy, 85, 87
troubleshooting, 149

L
Li-Ion Battery Pack, 165
Li-Ion Docking Station, 167
loading dose, 5, 61

clinician activated loading dose, 132–133
delivery, 64, 64–65
in Pain Management therapy, 59

loading the cassette, 35
lock, 3

adding a second lock level, 131
Full Lock, 114, 115
keypad lock, 6, 108, 114
keypad lock level functions, 115
locking the pump, 130
Luer Lock, 12
Rate Change Lock, 65, 114, 115, 130, 131
unlocking the pump, 132

lockboxes
using the GemStar® lockboxes, 168–171

locking the pump, 130
adding a second lock level, 131
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Luer Lock, 12

M
maintenance, 151–153

cleaning and disinfecting, 151
cleaning the cassette pocket and tubing 

channel, 153
cleaning the pump case, 152
recommended cleaning solutions, 152
repair, 153
warnings and cautions, 16

Menu
Programming‚ Change‚ Options, 7

mL/Hr Only therapy
VTBI Titration, 96

mL/hr Only therapy, 5, 93–100
Auto KVO, 95
changing a mL/hr Only program, 99
features and specifications, 93
piggybacking, 96–99
programmable ranges, 100
programming of, 93, 94
Programming Worksheet, 100
rate titration, 95

N
new container, 6

starting a new container, 32
troubleshooting, 146, 149

New Container Lock
locking the pump, 130
unlocking the pump, 132

next dose, 108, 121

O
occlusion, 116

changing the occlusion sensor 
settings, 117

occlusion information, 186–188

occlusion sensitivity, 185
See also distal occlusion; proximal 

occlusion
occlusion sensor

changing the occlusion sensor 
settings, 117

See also occlusion; distal occlusion; 
proximal occlusion

Operating Modes
Help, Programming, Run, Stop, 9

operation test, 155–163
air-in-line test, 161
cassette pocket and latch inspection, 157
display test, 158
distal occlusion test, 160
equipment required, 155
keypad test, 158
LED test, 159
Operation Test Checklist, 163
power check, 158
printing the results, 161
proximal occlusion test, 160
test setup, 156
volume accuracy test, 159

optional system components, 165–178
OPTIONS key, 3

display shift totals, 111, 133
Options Menu, 8, 107–126

change Pump Settings, 116
connecting to the data port, 122–126
Histories, 109
Keypad Lock, 114
Next Dose, 121
Operation Test, 113
Print, 119
Review Program, 109
Set Clock, 118
Speed Protocol, 120
tips for using the options menu, 107
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other display messages, 149

P
Pain Management therapy, 5, 59–67

1-Hour or 4-Hour Dose Limit, 61
alert messages, 145
bolus delivery, 62
changing a Pain Management therapy, 65
features and specifications, 59
loading dose delivery, 64
programmable ranges, 66
programming of, 61–62
Programming Worksheet, 66

piggybacking, 5, 6
canceling a piggyback delivery, 82, 99
changing a piggyback delivery, 81, 98
in Continuous therapy, 79–82
in mL/hr Only therapy, 96–99
preparing for secondary delivery, 80, 97
programming a secondary delivery, 81, 

98
power indicator, 3
power loss warning, 14
power sources

power check, 158
selecting, 20

powering on the pump, 27
Precedex®

programming, 90
Precedex® Programming Worksheet

Weight Dosed, 91
prime, 3, 34
priming, 12

priming extension sets, 49
priming pump sets using pre-filled 

vials, 46
priming pump sets with a drip 

chamber, 41
priming pump sets with a drip chamber 

using the PURGE Key, 44

priming pump sets without a drip 
chamber using the PURGE Key, 39

pump sets without a drip chamber, 37
See also prime; purge

Print, 119
programmable ranges

in Continuous therapy, 83
in Intermittent therapy, 75
in mL/hr Only therapy, 100
in Pain Management therapy, 66
in TPN therapy, 57
in Variable Time therapy, 105
in Weight Dosed therapy, 89, 91

Programming Menu, 8
accessing, 29

programming tips for pump, 31
Programming Worksheet

Continuous, 83
Intermittent, 75
mL/hr Only, 100
Pain Management, 66
Precedex®, 90
TPN, 57
Variable Time, 105
Weight Dosed, 89

proximal end, 33, 159
proximal occlusion

alarm messages, 142
occlusion sensitivity, 185
test of, 160

pump
powering on, 27
programming, 30
programming tips, 31
remove, 26

pump components, 4
pump features, 6
pump operation

warnings and cautions, 13
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pump set, 13, 17, 32, 179–180
GemStar® Piggyback Pump Set, 77
opening, 34
pump components, 4
See also pump settings

pump settings, 3, 108
air sensitivity, 117
change pump settings, 116
occlusion sensor, 117
sound level, 118

pump specifications, 183
PURGE key, 3

priming pump sets with a drip chamber 
using the PURGE Key, 44

priming pump sets without a drip 
chamber using the PURGE Key, 39

R
Rate Change Lock, 65, 114, 130, 131

lock level functions, 115
locking the pump, 130
unlocking the pump, 132

rate titration
in Continuous therapy, 79
in mL/hr Only therapy, 95
in Weight Dosed therapy, 64, 87

release battery pack, 24
releasing the cassette, 36
remove pump, 26
RUN mode, 9

S
shift totals and history, 133
SILENCE key, 3
specifications

pump, 183
Speed Protocols, 6, 108, 119

assign, review/recall, delete, 120–121

START key, 3
starting a new container, 32
STOP key, 3
STOP mode, 9

T
taper down, 53, 54, 56
taper up, 53
technical assistance, 200
Therapies, 5

Continuous, 77–83
Intermittent, 69–75
mL/hr Only, 93–100
Pain Management, 59–66
Precedex®, 90
Total Parenteral Nutrition (TPN), 53–57
Variable Time, 101–106
Weight Dosed, 85

Therapy Lock, 114
lock level functions, 115
Locking Sequence Instructions, 130
unlocking the pump, 132

Titrate Rates, 5
Titrate VTBI, 5
Total Parenteral Nutrition. See TPN 

therapy
TPN therapy, 5, 53–57

Auto Taper Down, 56
changing a TPN program, 55
features and specifications, 53
programmable ranges, 57
programming of, 54
Programming Worksheet, 57

troubleshooting, 135–149
alarm messages, 136–144
alert messages, 145
other display messages, 149
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U
unlocking the pump, 132

V
Variable Time therapy, 5, 101–106

changing a Variable Time program, 104
delivery interruptions, 103
features and specifications, 101
programmable ranges, 105
programming of, 101
Programming Worksheet, 105

Volume To Be Infused. See VTBI
VTBI, 78, 86, 94

piggyback VTBI, 79–81, 96–98
VTBI Titration, 88, 96

W
warnings and cautions, 11

air-in-line, 13
handling and maintenance, 16
pump operation, 13

Weight Dosed therapy, 5, 85
Auto KVO, 87
changing a Weight Dosed program, 88
features and specifications, 85
Precedex® programming worksheet, 91
programmable ranges, 89, 91
programming of, 86
programming worksheet, 89
rate titration, 64, 87
VTBI Titration, 88

worksheet
Continuous Programming, 83
Intermittent Programming, 75
mL/hr Only Programming, 100
Pain Management Programming, 66
Precedex® Programming, 91
TPN Programming, 57
Variable Time Programming, 105
Weight Dosed Programming, 89

Y
YES/ENTER key, 3, 31
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CAUTION: Federal (USA) law restricts this device to sale by or on the order of 
a physician or other licensed practitioner.

 IEC Symbols

GemStar, LifeShield, HEMA, and CAIR are registered trademarks of Hospira, Inc. Luer Lock is trademark of Hospira, Inc. 
Seiko, Vesphene II se, Manu-Klenz, Formula C, Teflon, Velcro, CLAVE, and Microsoft, Windows, and Windows NT are 
not trademarks of Hospira.
This document and the subject matter disclosed herein are proprietary information. Hospira retains all the exclusive rights 
of dissemination, reproduction, manufacture and sale. Any party using this documentation accepts it in confidence, and 
agrees not to duplicate it, in whole or in part, nor disclose it to others without the written consent of Hospira.

Hospira, Inc.
Lake Forest, Illinois 60045, USA

Printed in USA

DANGER: Possible explosion hazard exists if used in the presence of 
flammable anesthetics.

Authorized Representative:
Hospira
Finisklin Business Park
Sligo, Republic of Ireland

The ‘C’ and ‘US’ indicators adjacent to the CSA Mark signify that the product has 
been evaluated to the applicable CSA and ANSI/UL Standards, for use in Canada 
and the U.S., respectively. This ‘US’ indicator includes products eligible to bear the 
‘NRTL’ indicator. NRTL, i.e. National Recognized Testing Laboratory, is a 
designation granted by the U.S. Occupational Safety and Health Administration 
(OSHA) to laboratories which have been recognized to perform certification to U.S. 
Standards.

Type CF

Equipment providing an adequate degree of protection against electrical shock and 
suitable for application to patient.

IPX1 Protected against dripping water.

Attention: Consult accompanying documents.

The GemStar® Pump has been assessed and complies with the following standard: 
IEC/EN 60601-1-2 (2001).
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